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Chapter 1 Introduction 
This manual is for the EDMI Mk6 Genius Energy Meter and the EDMI Mk6E Energy 
Meter.  It covers all aspects of using the meter, from basic operations such as 
installation, through to advanced configuration and usage.  Examples are provided 
where possible to demonstrate application of the meter features. 

The meter is fundamentally an energy meter, measuring the basic quantities of Wh, varh 
and VAh.  Consumption data may be recorded in a load survey, and as time of use data.  
The meter can also measure a wide variety of instantaneous quantities.  The 
configuration is extremely flexible. 

If you want to get started straight away, Chapter 2 covers the installation of the meter, 
and Chapter 3 covers the basic use of EziView and a tutorial.  These chapters should be 
read as a minimum. 

What’s in this manual?   
There are four parts to this manual, as follows: 

• Part I, “Fundamentals”, describes the basics of getting the meter up and running.  
This includes installing the EziView PC software and the basic use of this software 
for communicating with the meter.  This part should be read completely. 

• Part II, “Configuration”, describes how to use the EziView software to configure the 
meter to your application.  This covers all of the basic uses of the meter.  The first 
chapter of this part should be read, then the other chapters may be read as required. 

• Part III, “EziScript Extensions”, describes the use of EziScripts.  These add-ons to 
the meter enable functionality such as modems, load surveys, event logs, and time 
of use history. 

• Part IV, “Advanced Topics”, describes the more advanced uses of the meter.  This 
includes reporting functions, and methods of testing the accuracy of the meter. 



  

   

 

Conventions used in this manual 
All dates are in DD/MM/YY format. 

References to settings or controls are printed in Italics. 

The path to a specific menu option is written as: 

 Menu Level 1 →  Menu Level 2 →  Menu Level 3 

Information with special note (such as safety information) is marked with a . 

Additional noteworthy information is marked with a . 

 “Clicking” on a button or field means using the left mouse button. 

Note that due to variations between computers and improvements in software, the 
screenshots shown in this manual may vary slightly from the appearance of the software 
on your system. 

This manual covers both Genius and Mk6E meters. Where the two are sometimes 
slightly different, the differences are marked as: 

 for Mk6 Genius specific documentation. 

  for Mk6E specific documentation. 

For more information 
The best source of information should generally be this manual.  The table of contents 
has been organised to make finding information as easy as possible.  If you are still 
having problems though, EDMI support may be contacted via email at 
support@edmi.com.au.  The EDMI web site is located at www.edmi.com.au. 

When contacting EDMI for support you may be asked for the meter serial number, 
firmware version and EziView version.  The serial number is printed on the label, and is 
the serial number used in EziView to identify the meter.  The firmware version is 
displayed on the LCD at start up or by holding Select down for 10 seconds (See 
LCD/Select Button, page 2-17).  It can also be displayed using EziView (See Online 
Variables, page 4-13).  The EziView version is available under Help → About in 
EziView.   

All this information will help us help you.
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Part I Fundamentals 
 

his section of the manual covers the information and procedures required for 
the initial installation and setup of the meter.  It also covers some basic 
concepts of the meter, and its basic use. 

 

T 
• Chapter 2: “The Meter” 

• Chapter 3: “EziView Basics” 

• Chapter 4: “Viewing Data” 

• Chapter 5: “Registers” 
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Chapter 2 The Meter 
This chapter covers the basic installation and physical features of the meter.   

Dimensions and Mounting 
Figure 2-1 shows the overall dimensions of the meter.  The height excludes the buttons 
and the ANSI fitting if present. 

 
• Figure 2-1 Overall dimensions of the meter. 



  

   

The mounting screw positions are shown in Figure 2-2.  This is a view from the back of 
the meter. 

79.25mm79.25mm
For mounting use 3 screws with a threaded section
not larger than 5mmØ with a screwhead not smaller
than 8mmØ.

 
• Figure 2-2 Mounting points. 

The meter is mounted using three screws.  In general: 

1. Screw the first (top) screw into the wall.  Leave enough space between the head and 
the wall for the plastic around the keyhole. 

2. Hang the meter on the screw using the keyhole in the back of the meter. 

3. Insert the remaining two screws (meter base, under the terminal cover) to hold the 
meter securely. 
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  External Features 

External Features 
Figure 2-3 shows a view of the front of the meter (the specifics of your label will vary). 

 
• Figure 2-3 The meter with terminal cover fitted. 

The major parts visible in Figure 2-3 include: 

• A 16x2 character backlit LCD display (displaying a “Maximum Demand” reading). 

• A select button for cycling the display (bottom push button). 

• A sealable billing reset button (optional) to initiate a manual billing reset (top push 
button). 

• Two pulsing LEDs for energy indication (two left hand LEDs, labelled pulse 1 and 
pulse 2) 
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• A FLAG or ANSI port for local connection. 

• EziPort socket with activity indicator LED (optional).  Note that this is a Mk6 
ONLY feature.  The Mk6E does not have an EziPort. 

Beneath the terminal cover (accessible by removing the two sealable screws on the 
terminal cover) is the terminal block for voltage and current measurement, as well as 
connectors for the pulsing inputs and outputs (optional), and for the optional RS-232 or 
RS-485 interface. 

The sealable screws have 2.7mm diameter holes to accommodate standard sealing wire. 

Under the Terminal Cover 

EDMI Mk6 Genius Meter 

Most of the connections to the meter occur under the terminal cover.  Figure 2-4 shows 
the terminals available on a 1 input / 3 output / RS-232 / CT connected Mk6 Genius  

 

• Figure 2-4 Under the terminal cover of a Mk6 Genius Meter. 

The two screws into the grey plastic of the base are not to be removed as they hold the 
terminal block in place.  The other two screws visible are two of the four sealable 
screws that secure the meter lid.  The other two screws are located on either side of the 
LCD.  All sealing screws have 2.7mm diameter holes, for accepting standard sealing 
wire or plastic seals. 

2-4  EDMI Genius/Mk6E User Manual 



 

  Under the Terminal Cover 

 

Diagrammatically, this is shown in Figure 2-5 with the terminal block numbering. 

 
• Figure 2-5 Mk6 Terminal block diagram. 

Table 2-1 lists the terminal block connections. 

Terminal Description 
TB1 Voltage and current inputs, and auxiliary 

supply where fitted. 

TB2 Input #1. 

TB3 Input #2 or Output #1. 

TB4 Output #2. 

TB5 Output #3. 

TB6 Input #3 or Output #4. 

TB7 Input #4 or Output #5. 

TB8 Input #5 or Output #6. 

TB9 Input #6 or Output #7. 

TB10 RS-232 or RS-485 port. 

TB11 Future expansion. 

TB12 Battery connector. 

TB13 Future expansion. 

• Table 2-1 Mk6 Terminal block connections. 
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EDMI Mk6E Meter 

The terminal block for the Mk6E is a slight revision of the Mk6.  Figure 2-6 shows 
under the terminal cover of an RS-232 Mk6E.   

 

• Figure 2-6 Mk6E under the terminal cover. 

The two screws into the grey plastic of the base are not to be removed as they hold the 
terminal block in place.  The other two screws visible are two of the four sealable 
screws that secure the meter lid.  The other two screws are located on either side of the 
LCD.  All sealing screws have 2.7mm diameter holes, for accepting standard sealing 
wire or plastic seals. 

Figure 2-7 shows the a diagramatical version showing all possible options.  The top 
diagram shows the terminals of an RS-232 or RS-485 meter with RJ45 connectors.  The 
second diagram shows an RS-485 Mk6E with the screw terminals option. 
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  Under the Terminal Cover 
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• Figure 2-7 Mk6E Terminal Block Diagram. 

 

Table 2-2 lists the terminal block connections.  Note that on all input and output groups 
where there is a common ground, the left most terminal of the block is the ground 
terminal.  
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Terminal Description 
TB1 Voltage and current inputs, and auxiliary supply 

where fitted. 

TB2 Input #1 and #2 (with Common). 

TB3 Output #1 and Output #2 (with Common). 

TB4 Output #3 and #4 (with Common). 

TB5 Output #5 and #6 (uses Common on TB4). 

TB6 Output #7 and #8 (uses Common on TB4). 

TB7 RS-485 Port (RJ45) 

TB8 RS-232 Port (RJ45) or RS-485 Port (RJ45) 

TB9 RS-485 (Terminals) 

TB10 Future Expansion Space. 

TB11 Future Expansion Space. 

TB12 Battery connector. 

• Table 2-2 Mk6E Terminal block connections. 

•  

Figure 2-8 gives the terminal spacings of TB1.  Note that these are the same for both the 
Mk6 Genius and Mk6E. 

 
• Figure 2-8 TB1 terminal spacing. 

Under the Meter Lid 
Removing the four sealable screws allows the meter lid to be removed.  Generally 
connections to the I/O connectors need to be detached to allow the cover to be removed.  
Removal of the meter lid is required to access the Config Jumper, and to add or remove 
the CT to VT links on whole current meters. 

Care must be taken as dangerous voltages are present in the circuity under the meter lid 
while the meter is active.  Most of the circuity is at neutral potential. 
Even when the meter is not powered, care should be taken to prevent electrostatic 
damage to the circuity of the meter. 

2-8  EDMI Genius/Mk6E User Manual 



 

  Under the Meter Lid 

 

The Config Jumper 

The Config Jumper is part of the data access security.  See Chapter 16 for more 
information.  Figure 2-9 shows the location of the jumper for the Mk6 Genius Meter. 

 
• Figure 2-9 The Config Jumper on the Mk6 Genius. 

The jumper is located just under the EziPort indicator LED.  It has two positions, Config 
and Secure.  To change the setting, remove the plastic jumper and move it to the other 
set of pins.  Shorting the top and centre pins is the Config position, while shorting the 
bottom and centre pins is the Secure position. 
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Figure 2-10 shows the location of the jumper on the Mk6E Meter.  The jumper is 
located near the right hand edge of the meter near the Select Button.  It has two 
positions, Config and Secure.  To change the setting, remove the plastic jumper and 
move it to the other set of pins.  Shorting the top and centre pins is the Secure position, 
while shorting the bottom and centre pins is the Config position. 

 
• Figure 2-10 The Config Jumper on the Mk6E. 

CT to VT Links 

Whole current meters have CT to VT links between TB1 terminals 1 and 2, 4 and 5, 8 
and 9, 12 and 13.  There is also a fixed link between 12 and 14.  These links may need 
to be removed to allow testing on some types of test bench.   Figure 2-11 shows the 
location of the links, just above the terminal block. 

 
• Figure 2-11 Location of the CT to VT links. 
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  Under the Meter Lid 

To remove the link connections, remove the four screws and washers from the deeper 
set of holes.  This disconnects the links.  Figure 2-12 shows the meter with the screws 
removed. 

 
• Figure 2-12 Meter with the CT to VT links disconnected by removing screws. 

It is important to leave the other screws in place, as they are part of the connection of the 
voltage terminals to the meter. 
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Connections in Detail 

Current and Voltage 

 
• Figure 2-13 TB1 CT and VT connections for 3 element (top) and 2 element 

(bottom). 

Figure 2-13 shows the two possible connection methods in either 2 (3 wire) or 3 (4 wire) 
element mode.  No internal modification to the meter is required to make it measure in 2 
element (3 wire) or 3 element (4 wire) mode.  For proper accuracy (especially when 
measuring VA in 2 element mode) the measurement method must be set to 2 element 
using EziView (Chapter 8).  The connection to terminal 5 is not required in two element 
mode.  Terminal 14 is not fitted in CT connected meters. 

The nominal voltage input range dependant on the model number of the meter.  The 
current range depends on the current range of the meter, and should be limited to Imax. 

In 3 element mode (4 wire) the maximum line to neutral voltage is 290V and the 
maximum line to line voltage is 500V.  When in 2 element (3 wire) configuration the 
maximum line to line voltage is 290V. At any higher voltage the meter will not operate 
correctly and damage may occur.   
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• Figure 2-14 Connections for 3 element whole current, TB1. 

Figure 2-14 shows the connections for a whole current meter.  The neutral connection 
must be made, even if it is not connected to both 12 and 14.  Whole current meters have 
links connecting TB1 terminals 1 to 2, 4 to 5, 8 to 9, and 12 to 13 to 14.  The links are 
fitted under the main meter cover, discussed earlier in this chapter.  The same maximum 
voltage restrictions apply as for CT meters.  

Auxiliary Supply 

The meter has optional support for an auxiliary supply for powering the meter.  There 
are four different options, depending on the required operation when different power 
sources are present. 

The auxiliary supply inputs are TB1-7 and TB1-11.  TB1-11 should be used as the 
negative input in DC systems, and as the neutral in AC systems. 

The auxiliary voltage input is rated at 110 VAC/VDC ± 20%. 

Type 0 – VT supply 

Used for most typical metering applications, particularly low voltage sites.  Once all 
VTs fail the meter will power down. 

Type 1 – Aux 24V LCD and local port supply 

Used for applications where meter readings may need to be performed in the absence of 
power.  A 24V battery supply may be applied to allow the meter to be read. 

Type 3 - Auxiliary only 

Used for switchyard applications where the meter must be on at all times and there is 
spare capacity in the auxiliary supply system.  If the auxiliary system fails for any 
reason the meter will power down. 

Type 4 – VT priority – High Voltage 200-240V Aux 

The meter will normally draw power from the VT circuits.  Once all the VTs have 
failed, the changeover board will operate the internal relay and draw power from the 
auxiliary terminals.   
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Type 6 – VT priority – Low Voltage 57-120V Aux 

The meter will normally draw power from the VT circuits.  Once all the VTs have 
failed, the changeover board will operate the internal relay and draw power from the 
auxiliary terminals.   

This is most useful when VT burden is not an issue, but power must be guaranteed to 
the protection systems 

RS-232 

The RS-232 port on the Mk6 Genius meter is a 9 pin D-type connector designed to 
connect directly to a modem using a standard modem to PC cable.  Full hardware 
handshaking is supported.  See Table 2-3 for connection details. 

Terminal Description Full Name 
TB10-1 CD Carrier Detect 

TB10-2 RX Receive Data 

TB10-3 TX Transmit Data 

TB10-4 DTR Data Terminal Ready 

TB10-5 GND Ground 

TB10-6 NC Not Connected 

TB10-7 RTS Ready to Send 

TB10-8 CTS Clear to Send 

TB10-9 NC Not Connected 

• Table 2-3 Mk6 Genius RS-232 connections  

When connected directly to a PC a null modem cable must be used.  Only pins 2, 3, and 
5 need be connected.  For modem connections it is strongly recommended that all signal 
lines be connected.  See Figure 2-4 and Figure 2-5 for the location of the connector.  Pin 
1 is at the top left of the connector.  There will be numbers in the plastic at the base of 
each pin indicating the number. Care must be taken that the connector used will not 
interfere with the terminal cover of the meter when fitted. 

The Mk6E meter’s RS-232 port is provided by an 8-pin RJ45 connector.  Connection 
details are described below in Table 2-4. 

 

Terminal Description Full Name 
TB10-1 +5V +5V, 140mA 

TB10-2 CD Carrier Detect 

TB10-3 DTR Data Terminal Ready 

TB10-4 GND Ground 

TB10-5 RX Receive Data 

TB10-6 TX Transmit Data 

TB10-7 CTS Clear to Send 

TB10-8 RTS Ready to Send 

• Table 2-4 Mk6E RS-232 connections  
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RS-485 

The RS-485 port on the EDMI Mk6 Genius meter is a 5-connection screw terminal 
block that replaces the DB9 as TB10.  Table 2-5 lists the connections. 

Terminal Description 
TB10-1 GND 

TB10-2 RX- 

TB10-3 TX+ 

TB10-4 RX+ 

TB10-5 TX- 

• Table 2-5 Mk6 Genius RS-485 connections  

The terminals are numbered left to right. See Figure 2-4 and Figure 2-5 for the location 
of the connector.  The terminals replace the DB9 port shown in the diagram. 

The Mk6E also supports an RS-485 port via either a 5-connection screw terminal or two 
RJ-45 connectors.  The 5-connection screw terminal is labelled TB9 in Figure 2-7 and 
the connector has the following pin out: 

Terminal Description 
TB9-1 GND 

TB9-2 RX- 

TB9-3 RX+ 

TB9-4 TX- 

TB9-5 TX+ 

• Table 2-6 Mk6E RS-485 screw terminal connections  

The pin out for RS-485 via the two RJ45 connectors (TB7 and TB8) on the Mk6E is 
shown in Table 2-7.  Note that the pin out for TB7 and TB8’s are the same, thus only 
TB7’s connections are shown. 

 

Terminal Description 
TB7-1 Not Connected 

TB7-2 Not Connected 

TB7-3 TX+ 

TB7-4 GND 

TB7-5 +5V (Optional) 

TB7-6 TX- 

TB7-7 RX- 

TB7-8 RX+ 

• Table 2-7 Mk6E RS-485 RJ45 connections  
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FLAG Port 

Simply use a standard FLAG (IEC1107 physical standard) read head to connect the 
meter to a PC. 

Note that we have occasionally found that some FLAG heads need to be rotated 180 
degrees for them to work.  If you have problems try this. 

ANSI Port 

Simply use a standard ANSI read head to connect the meter to a PC. 

EziPort  

This is an infrared transmit-only port on the Mk6 Genius Meter designed to work with 
an EDMI EziPort read head.  The LED flashes when data is being transmitted. 

This port is also used by EDMI as an optical gate input for gated energy tests. 

The EziPort is over-ridden when a SCADA card is fitted. 

Inputs 

On the Mk6 Genius Meter the inputs are passive and are isolated from all other circuits, 
including the other inputs.  The Mk6E Meter has groups of inputs that have a common 
terminal (e.g. Input #1 and Input #2 share a common terminal) but are still isolated from 
other circuits.  There are a variety of input voltage ratings for the inputs – specified at 
time of order.  Under voltage will cause the input to trigger erratically or not at all, while 
over voltage will cause excessive heat dissipation and possible damage to the meter. 

The rated voltage is the voltage that must be applied between the two terminals of the 
input.  The inputs work with any polarity, and with AC or DC signals.   

Outputs 

The outputs on a Mk6 Genius Meter are passive and are isolated from all other circuits, 
including the other outputs.  The Mk6E Meter has passive outputs that are isolated from 
all other circuits expected those outputs that it shares a common terminal with.  All 
Outputs are BOSFETs rated up to 240V, 100mA.   

Battery 

The battery is used to run the clock during loss of power.  It also preserves the memory 
of the meter, most notably the EziScript memory that is not backed up to permanent 
FLASH memory. 

The battery is a 3.6V, 750mAh Lithium battery.  It clips into the compartment above 
and to the left of the main terminal block, and plugs into TB12 (polarised).  
Replacement batteries may be ordered from EDMI as 2000-0600-BATTERY.  A low 
battery indicator is displayed on the LCD when the meter powers up if the battery is not 
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present or is depleted.  The battery usage life is at least 2 years.  The Meter Off time 
display (Time Statistics, page 12-7) may be used to help estimate the battery usage. 

To eliminate the possibility of data loss it is best to change the battery while the meter is 
running.  Care must be taken as the battery is at the potential of the neutral terminal.  
The meter will only retain data for several seconds with the power off and no battery. 

The battery is at the potential of the neutral terminal.  If conditions (such as wiring 
configuration) make this a dangerous operation then steps should be taken to ensure that 
it is safe to do so.  While the risk of coming into contact with the conductors during a 
battery change is minimal, care must be exercised. 
If the meter does have to be turned off while a battery change is made the data 
(especially load surveys) should be backed up from the meter.  The battery should be 
changed as quickly as possible under these circumstances. 
 

Super Cap 
The Mk6E meter can be fitted with up to two Super Cap.  These Super Caps perform 
the same job as the battery described above.  In the event of a power loss the Super Caps 
keep the meter’s clock running and preserves the memory contents. 

Each Super Cap fitted will keep the meter running in the event of a power loss for a 
minimum of 3 days.  This is particularly useful in conserving battery life on a meter 
fitted at a site where there are frequent, short duration outages.  While the Super Caps 
recharge in a short period once power is restored, they should be charged (by connecting 
power to the meter) for a minimum of 12 hours to obtain the 3 day keep alive time. 

LCD/Select Button 
The LCD is primarily for displaying information from the meter’s registers for meter 
readers.  It is also useful during installation, configuration, and diagnosing problems.   
The LCD is a backlit two line by 16-character display.  The backlight may be set to only 
activate while the LCD is in use. 

The data is displayed on the LCD as a series of pages.  There is one default page that is 
always present, and then a series of pages that follow it (up to 64).  Each page displays a 
single quantity from the meter.  The top line shows a description (16 characters), and the 
bottom line shows the value, with an optional unit.  The LCD is fully alphanumeric, so 
any text or numbers may be displayed.  

If the bottom line of the display is too long to fit into 16 characters, the display will 
scroll a character every second to show the entire line (up to 59 characters).  A right 
facing arrow “→” shows the start of the line. 
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To progress to the next page, press the Select button.  Each time the button is pressed 
the display moves to the next page.  The display may also be set up to automatically 
cycle the display through the pages, pausing if the Select button is pressed. 

In order to make it easier to find a certain page and to allow for different users of the 
LCD, each page belongs to a display set.  Only pages from the current display set are 
shown.  There are four display sets, called A, B, C and D.  To change display sets press 
and hold the Select button for a second.  The LCD will give a message like “Changed to 
set B” to indicate the new display set.  The LCD will then change to display the new 
display set, starting at the default page that is present in all sets.  The first three display 
sets can be reached in this way.  The fourth can be reached using EziView.  

There is a special display mode to assist in cases where information is needed from the 
meter that has not been configured on displays.  This is generally where information is 
needed in order to establish a link with the meter (e.g. unknown baud rate settings).  To 
enter this mode hold the select button down for 10 seconds.  The display will change to 
a cycling display that shows the following information (Table 2-8).  Pressing the button 
again will revert to the normal display. 

LCD Screens 
Model ID No 

Serial Number 

Processor Idle Time 

Firmware Version 

Modem Port Configuration 

Optical Port Configuration 

SCADA/Eziport Configuration 

Flash Used 

HW type code 

• Table 2-8 Special Display contents  

Processor idle time and Flash Used are for EDMI internal use. 

Default Display 

The default display (Figure 2-15) shows a summary of many of the systems within the 
meter. 

 
• Figure 2-15 Default LCD display. 

The organisation of the display from the top left is as follows: 

The first two characters of the top row display the direction of watts and vars 
respectively.  A plus sign indicates positive/export/delivered energy, while a minus sign 
indicates negative/import/received energy. A blank indicates zero energy. 
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The third character shows a little pulsing heart symbol as an indication that the meter is 
running and updating the display. 

The fourth, fifth and sixth characters indicate the active rate for W, var and VA rate 
groups respectively as a number from 1 to 8.  These values are fully explained in 
Chapter 13. 

The seventh character shows a battery symbol if the battery was depleted or missing at 
power up.  See the “Battery” section earlier in this chapter. 

The eighth character shows a ‘D’ if daylight saving is currently active. 

The right hand side of the display shows the current time (with daylight savings if 
active). 

The first three characters of the bottom row display the alarm status.  See Chapter 15 for 
more information. 

Characters five, six and seven on the bottom row show the login status.  An ‘L’ 
indicates a login on the optical port (local), an ‘M’ indicates a login on the modem port 
and an ‘S’ indicates a login on the SCADA port. 

Finally, the right hand side shows the current date (with daylight savings if active). 

Billing Reset Button 
The billing reset button is the top of the two push buttons beside the display.  The button 
is an option, and where not fitted the hole will be filled by a plastic plug.  The push 
button has a 2.7mm diameter hole through it, allowing it to be sealed using standard  
sealing wire.  

For more information, see “Manually using the Billing Reset Button”, page 13-25. 
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Measurement Conventions 
The convention for energy directions is as shown in Figure 2-16 below. 

0°

Quadrant 2
Capacitive load

Current lags voltage
Lead power factor

Quadrant 3
Inductive load

Current leads voltage
Lag power factor

Quadrant 4
Capacitive load
Current leads voltage
Lead power factor

Quadrant 1
Inductive load
Current lags voltage
Lag power factor+θ 

−φ

−θ
+φ

+ve Watts & VA
(pos. active power)

-ve Watts & VA
(neg. active power)

+ve VArs
(pos. reactive power)

-ve VArs
(neg. reactive power)

 
• Figure 2-16 Energy Directions.  

θ is the impedance angle of Voltage with respect to Current. φ is the admittance angle of 
Current with respect to Voltage.  The meter measures the angle in terms of Current with 
respect to Voltage (φ, admittance).  All energy calculations are completed using the sign 
convention described above.  To support different naming conventions, EziView can be 
configured via EziView’s Tools → Options → General → Naming Convention dialog 
(Figure 2-17).   

 
• Figure 2-17 Changing Naming Conventions dialog.  
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The following diagram describes the different naming conventions that EziView 
supports and how they relate to the flow of energy. 

CUSTOMERUTILITY

Convention Direction
ANSI Export
IEC Import
+/- +
Rec/Del Delivered
Rev/Fwd Forward

Convention Direction
ANSI Import
IEC Export
+/- -
Rec/Del Received
Rev/Fwd Reverse

POSITIVE ENERGY

NEGATIVE ENERGY

 
• Figure 2-18 Direction of Energy Flow Diagram. 

 

Servicing 
The meter is not designed for field servicing and has no user serviceable parts.  The 

ur 

 

 

meter has no internal  fuses.  In the event of failure of the meter, contact EDMI or yo
local agent for servicing. 
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Chapter 3 EziView Basics 
EziView is a 32 bit Windows application written by EDMI.  EziView is used to 
configure and retrieve data in a user-friendly manner from EDMI energy meters. It can 
keep track of multiple meters spread across multiple sites.  

This chapter covers the installation of EziView and configuring EziView to connect to 
your meters. 

Installation 
EziView version 2.0 or later is required to access the meter. 

System Requirements 

• 486, Pentium, or above based personal computer 

• Microsoft Windows™ 95/98 or Windows™ NT4.  (Win3.1 is not supported). 

• 16 MB of RAM 

• At least 15 MB of HDD space, plus space for retrieved meter data. 

To install EziView 

1. Close all active applications. 

2. Insert the EziView software CD in the CD ROM drive, or download EziView from the 
EDMI web site. 

3. Run the setup.exe program from the install package.  

4. The EziView Installer dialogue box appears. Follow the instructions on the screen to 
progress through the installation. 



  

   

EziView Tutorial 
This section is a tutorial on using EziView.  Along the way it covers all of the 
information you need to know about the basic use of EziView.  You should have a 
meter connected directly to the computer using an Optical head or an RS-232 link to 
complete this tutorial.  These types of connections are described in Chapter 2.  Modem 
use is covered in Chapter 21. 

CD Keys 

EziView uses a system of CD keys to control use of the software. When EziView is first 
run the following screen will be displayed (Figure 3-1). 

 
• Figure 3-1 EziView welcome screen.  

Clicking OK will display the CD Key entry dialog (Figure 3-2). 

 
• Figure 3-2 EziView CD Key entry dialog.  

CD keys may be provided with the CD packaging, or on a separate disk, or via email.  
CD keys may either be typed into the Enter CD Key field, or if they are in a file the 
Load CD Keys From File button may be used. 

Depending on your area you should have one or more CD keys.  Each key is a series of 
26 letters or numbers, followed by a customer name.  The customer name must be the 
same for all keys in use.  New keys may be added after the first run of EziView by using 
the Tools → CD Key option. 
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To see what CD keys are in use change to the View Keys tab (Figure 3-3).  The keys that 
have been entered will be listed in the Keys section.  The Status indicator shows whether 
the currently selected key is valid and active or not.  The Save CD Keys to File button 
may be used to save all the installed CD keys to a file. 

 
• Figure 3-3 EziView CD Key information.  

The Meters pane displays any restrictions on what meters the CD keys may be used on.  
The Features pane displays what EziView features are enabled (shown in Bold) by the 
CD keys. 

 
• Figure 3-4 EziView System Code confirmation.  
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With some CD keys EziView will ask for a system code confirmation.  In this case the 
dialog of Figure 3-4 will be displayed.  The indicated code needs to be sent to EDMI or 
your local agent, who will send you the corresponding unlock key.  Email is the easiest 
way to do this, but fax or phone may also be used.  This locks EziView such that it will 
run only on your system. 

Running EziView 

Upon running EziView the main EziView screen is shown, along with a login prompt 
(Figure 3-5).  Use the name “EDMI” and the password “IMDEIMDE” to log into 
EziView.  Stars will be displayed instead of the password for security.  Ignore the Link 
Security field.  Click OK after the username and password has been entered. 

 
• Figure 3-5 EziView login.  

This brings you to EziView’s main screen (Figure 3-6). 

 

 
• Figure 3-6 EziView main screen. 

The screen consists of several parts.  The left hand pane shows a diagram of meter sites, 
the right hand pane shows the meters at the selected site (discussed later).  Above each 
pane is a toolbar of actions for the pane.   
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Sites 

A meter site represents a connection point to a meter (or meters).  It defines such things 
as the phone number and baud rates.   

Each site contains meters.  The meters in the selected site are listed in the right hand 
pane.  Most connections will have only one meter, but an RS-485 multidropped site may 
have many more, all on the same connection defined by the site. 

Clicking on MySite selects it, showing in the Meters pane that it has a single meter (as 
shown in Figure 3-6).  This is a default site installed with EziView as an example, with a 
serial number of 10000000 to indicate that it is not a real meter.  The meter’s name 
defaults to its serial number, which is shown in the second column.  The Address 
column is not used with the Genius meter. 

Sites may be nested, like the directory structure on a computer’s disk.  New sites may be 
created within any other site.  Which site a site resides in has no effect, and is purely to 
enable sites to be organised easily.  To this end sites do not need meters, they can simply 
be used for organisation.  For example, a “substations” site might contain a series of 
sites like “substation 543” etc. (See Figure 3-7).  The plus and minus icons on the tree 
diagram may be used to expand and collapse the tree. The Tree menu also contains 
options to expand and collapse the whole tree or parts of it. 

 
• Figure 3-7 EziView main screen with complex site setup. 

To create a new site select the site to place the new site under.  Then either right-click 
and select New from the popup menu (Figure 3-8), or click on the New Site button on 
the Sites toolbar (3rd button from the left), or use the File→ New → New Site menu 
option (Figure 3-9).  For this tutorial create a site off the Local site, the root of all sites. 
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• Figure 3-8 EziView new site menu option. 

 
• Figure 3-9 EziView File menu new site menu option. 

This will create a site called SIT0.  To change the name either right-click on it and select 
Rename, or click on the name while it is highlighted.  A new name can then be entered.  
All site names must be unique.  If a site of the same name already exists, a number is 
added to the end to differentiate it.  Site names may contain spaces, and may be any 
length.  Rename the site to “Tutorial Test” (Figure 3-10). 
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• Figure 3-10 Renaming a site. 

Sites may be deleted by choosing delete from the right-click menu, or by pressing the 
delete key, or by selecting File→Delete→Delete Site, or by using the delete toolbar 
button (4th button on the Sites toolbar).  A site may not be deleted if it contains any other 
sites.  Those sites must be deleted first.  A site may also not be deleted if EziView is 
connected to a meter within the site. 

The properties of the site can now be configured.  Select the site then select properties 
from the right-click menu, or the File menu, or the Site toolbar (2nd button from the left).  
This will display the Site Properties dialog box. 

Site Properties 

 
• Figure 3-11 EziView Site Properties, Name page. 

There are four pages to the Site Properties dialog.  The first page, Name (Figure 3-11), 
shows the site name.  This is yet another way to change the site name.  
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• Figure 3-12 EziView Site Properties, Connection page. 

The Connection page (Figure 3-12) allows the method of connection to the meter to be 
configured.  The Connect Using box allows the type of connection to be picked. 

The _Direct option shown in Figure 3-12 uses a serial port on the computer to connect 
directly.  This includes use with optical reader heads, or null modem cables, connected 
to the RS-232 port.  With this option the Port and Baud Rate fields are used to select the 
details of the serial port.  The Baud Rate must be set to the same rate as the meter, which 
defaults to 9600 baud.  The Configure button allows the number of data bits, stop bits, 
parity and flow control to be set.  Unless the meter settings have been changed, these 
may generally be left as their default values of 8 data bits, 1 stop bit, no parity, and no 
flow control.  8 data bits must be used for correct operation with the meter at all times. 

If any modems are installed in Windows these will appear as options in the Connect 
Using field.  Selecting a modem to use allows properties such as phone number to be 
set.  These settings are covered in Chapter 20. 

The _Socket protocol option is for connection to a port redirector using a network.  Use 
of this option is not covered here. 

 
• Figure 3-13 EziView Site Properties, Advanced page. 
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The Advanced page (Figure 13-3) allows a number of specialised settings to be changed 
that may be used to tweak a connection.  Table 3-1 below lists the options. 

Setting Description 
Protocol There are several options listed, but only two are relevant for this meter.

The “General Protocol” protocol is a generic protocol to all EDMI 
meters.  This is the protocol to be used for mapping a site (discussed 
later).  Not all features can be used with this mode, but it does not 
require the serial number to be correct. 
The “Multi Drop Register32” protocol is the normal operating protocol 
for this meter for any mode of operation.  This is the protocol changed 
to when a site is successfully mapped.  It requires the serial number to 
be correct. 

Error Count This is the total number of errors counted while communicating with any 
meter on this site. By checking this value, problems such as cable faults 
and bad modem connections will become obvious. 

Timeout EziView waits for a response to a message.  If no response occurs it 
sends the message again. This wait time is called the timeout period 
and is calculated by adding the timeout for the site and the timeout for 
the meter. 
By changing the timeout for the site, the timeout is changed for all 
meters. This is most useful if a site has special characteristics e.g., 
using a low speed mobile modem. 

Retry Count 
Retry Delay 

These options fine-tune the connection to a site. 
Connecting to a site involves dialling a modem or opening a serial port. 
If the serial port is in use by another application, or if the modem does 
not answer, EziView will retry Retry Count number of times.  The delay 
between retries is Retry Delay milliseconds. 

Dialback Wait This is the time to wait in milliseconds for a dialback from a meter.  
Failed Logon Delay This is the time to wait after a logon has failed to try the alternate logon. 

• Table 3-1 Site Properties, Advanced page settings.  

These settings can generally be left at their default values. 

 
• Figure 3-14 EziView Site Properties, Script page. 

Finally, the Script page (Figure 3-14) allows a login script to be specified, along with 
parameters for the script.  Login scripts allow EziView to navigate past devices such as 
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Datagates that allow a single modem connection to be shared.  Details of their usage are 
covered in Chapter 24. 

Mapping a Site 

Mapping a site is an easy way of setting up an existing meter in EziView.  It connects to 
the meter, determines its type and the required protocol settings, and optionally 
downloads the setup of the meter to EziView. 

Make sure the meter is physically connected to the serial port specified in the selected 
site, then select Map Site from the right-click menu or the File menu.  There should be 
no meters in the site before doing this. 

 
• Figure 3-15 EziView Mapping a site. 

The screen shown in Figure 3-15 should now be displayed.    The window shows the 
progress of mapping the site.  EziView has found the meter, and has identified it as a 
2000-06XX series meter.  This process should only take a couple of seconds.  If it takes 
much longer there may be a problem with the connection, or the setup of the serial port 
– recheck these settings and connections. Figure 3-16 illustrates what is shown when the 
connection fails. 
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• Figure 3-16 EziView Mapping a non-responding site. 

At this point EziView has created a blank meter in the site, but has not configured it to 
match the physical meter.  Clicking the Map button causes the meter’s serial number to 
be read, and the appropriate protocol set.   

 
• Figure 3-17 EziView Mapping of a site completed. 

Figure 3-17 illustrates successful completion.  The serial number displayed will be the 
serial number of the unit being mapped (204123456 here).  Click on the Close button to 
return to the EziView main screen. 
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Meters in EziView 

 
• Figure 3-18 A newly mapped meter in EziView. 

A site’s meters appear in the Meters pane when the site is selected.  The meter may be 
renamed or deleted in a similar way to sites.  The right hand four icons on the tool bar 
control how the pane is displayed, with the Details view being the preferred method. 

Each meter in the Meters pane represents what is called an MTR file.  This is kept by 
EziView, and primarily consists of the configuration for the meter.  EziView allows the 
configuration in this file to be edited, and offers a set of tools to send the configuration 
to the meter. 

The cut, paste and copy tools can be used to move meters between sites.  This is useful 
if the physical location of a meter changes.  It is also a useful way to create a new meter 
without going through the mapping process.  Simply copy an existing meter, paste it 
into a new site, and then set the serial number of the meter and the protocol of the site 
appropriately. 

Another way to create a new meter is to use the File→New→New Meter option (or 
toolbar icon or right-click menu in the Meters pane or the Ins key).  This creates a new 
meter in the selected site with the default properties.  To change the default properties 
simply select an existing meter and select the Default Meter option from the right-click 
menu, or the File menu.  New meters will be created with the same settings as the 
default meter. 

The use of Setup is covered in Chapter 6. 

Connecting to a meter 

To connect to a meter, double click on the meter or its site.  Alternatively the right-click 
menus have a Connect option, as does the File menu and the tool bars (icon furthest to 
the left). 
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• Figure 3-19 EziView connecting to a meter. 

A screen similar to Figure 3-19 is shown while EziView is attempting to connect.  The 
Hide button hides this screen, but has no effect on operation.  

 
• Figure 3-20 EziView connection Status page. 

If the meter does not connect immediately the Status page can give useful information 
as to what is failing.  The screen of Figure 3-20 was generated by disconnecting the 
serial connection to the meter.  Clicking the Close button will abort the process. 
EziView tries to make sure that the meter is logged off before disconnecting, so the 
disconnection sequence may take some time if the meter is not responding. 
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The times at which the Connect screen is shown may be controlled using the Tools 
→ Options → General → Connection Screen settings (Figure 3-21). 

 
• Figure 3-21 EziView Connection Screen options. 

Visibility controls when the connection screen is displayed.  Hide Always never shows it, 
Hide on Connect hides it after connection is established, Minimise on Connect 
minimises it after connection is made, and Show Always shows it until the connection is 
broken. 

The Operation setting controls when interactive mode is used.  In interactive mode the 
connection details are displayed before the connection is attempted (Figure 3-22). 

 
• Figure 3-22 Interactive Connection. 
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Automatic never uses interactive mode, Interactive Modem uses it only for modem 
connections, and Interactive Always uses it for all connections. 

Online Functionality 

Once the meter is connected and online, extra options become available on the meter’s 
menu.  Figure 3-23 shows these options.  Most obvious is the Disconnect button, which 
terminates the connection with the meter. 

 
• Figure 3-23 EziView online options. 

The Screens group provides a range of status screens updated in real time, along with 
those settings that can only be performed online such as setting the clock. 

The Transfer Setup group allows transfers between the setup in the MTR file kept by 
EziView and the setup in the meter itself. 

The Special group allows registers in the meter to be changed directly, and allows the 
meter to be restarted, simulating a momentary loss of power. 

The use of these menu options is explained in the following chapter. 
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• Figure 3-24 EziView Status screen example. 

As a quick example of the information available, selecting Screens→ Status gives a real 
time display of the meter’s basic measurements (Figure 3-24).  In this example the 
meter is only connected to phase C with a very low current. 

Disconnecting 

To disconnect from the meter simply choose Disconnect from either the site or the 
meter’s right-click menu, or from the File menu, or by using the Connect/Disconnect 
icon on the left hand end of each tool bar. 
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Bits and Pieces 

Different Languages 

EziView supports languages other than English.  EziView will automatically detect the 
language of the computer and set the filename under Tools → Options → Language 
(Figure 3-25) to the appropriate “.LNG” file.  This may be overridden by setting a 
filename here. 

 
• Figure 3-25 EziView Options Language page. 

The Default Desc option selects whether default descriptions are converted to the new 
language.  Default descriptions are written to the meter by default for display on the 
LCD as a description.  The meter cannot display the variety of languages that the 
computer can, so unchecking this options allows these default descriptions to remain in 
English to ensure that they display properly. 

Language files may be obtained from your local agent where you obtained EziView, or 
from EDMI. 
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MTR File Locations 

The Tools→Search List option (Figure 3-26) allows meter files to be located outside the 
default location.  The default location is the directory EziView is installed in. 

 
• Figure 3-26 EziView directory search list. 

One use of this is to locate meter files on a network, or to only load groups of sites when 
needed to speed up EziView’s loading time. 

To add a directory to the list select it from the browse list, then click the right facing 
arrow.  To delete a directory from the list select it, then click the left facing arrow. 

Notes 

The Monitor option, where available on the View menu, provides a range of diagnostic 
tools for communications beyond the scope of this document.   

The toolbar may be turned off using the Toolbar option on the View menu. 

The Tools→Options dialog provides a series of ways to customise EziView, discussed 
in detail in the rest of this manual where appropriate. 

When using drop down selection boxes, pressing a letter cycles the box through the 
options which start with that letter. 

EziView uses a significant amount of Windows resources, especially when displaying 
the setup pages.  If you get messages warning that the system is low on resources, try 
closing other open applications. 

When EziView is connected to a site and meter, their properties cannot be edited.  Also, 
the site and/or meter cannot be cut while connected. 
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Chapter 4 Viewing Data 
This chapter covers the basic status displays available from EziView.  The previous 
chapter explained how to reach these screens. 

Data Storage 
Some features such as waveform capture (covered later in this chapter) and reading files 
(covered in Chapter 23) save a file of data from the meter.  The location and naming 
convention for these files is set using Tools → Options → File Locations (Figure 4-1). 

 
• Figure 4-1 EziView Options File Locations page. 

The first part of the file name may be either the serial number of the meter, or the plant 
number of the meter.  This is selected under Save By.  If the plant number is longer than 
8 characters the file name will be a long file name. 

The file may be stored either in the same directory as the MTR file (Meter File option), 
or in a fixed directory for all meters that may be entered below the Fixed Directory 



  

   

option.  Checking the Always Append box causes new data to always be appended to the 
file.  If this is not checked you will be prompted for the action to take when a file may 
be overwritten. 

The Viewer Program setting is not used by this meter. 

Link Active Icon 
Many of the data viewing screens have a small animated icon which changes to indicate 
that data is being transferred.  This animation can be changed using the Tools → 
Options → Animation Icon page. 

Basic Status 
These screens show basic information about the meter’s measurements. 

Analogue and Alarm Status 

 
• Figure 4-2 EziView Status screen. 

The Status screen (Figure 4-2) displays instantaneous readings, the state of the alarm 
system, and a phasor diagram.  The Analogue Readings are one second averaged 
readings from the meter.  The Status Flags pane shows the state of the meter’s alarms – 
see Chapter 15 for details.   
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The button on the bottom left shows a very small phasor diagram.  Clicking on the 
button changes the display to a detailed view (Figure 4-3).  Clicking on the 
corresponding button in this screen returns to the main status screen.  Right-clicking in 
the display pane gives a small menu of display options for the diagram. 

 
• Figure 4-3 EziView Phasor screen. 

  Viewing Data  4-3 



  

   

Waveform 

This option allows the waveform of the voltages and currents measured by the meter to 
be displayed (Figure 4-4).  This feature is a feature code enabled option and may not be 
present in your meter. 

 
• Figure 4-4 EziView Waveform screen. 

The phases are displayed in their respective colours.  The colours may be changed using 
the Tools → Options → General → Phase Colours settings.  Below the graph the scale 
is listed, along with the value of voltage and current at the cursor position. 

Right-clicking on the graph and selecting Print from the popup menu prints the graph.  
The other two options on this menu select 5 cycle or 1 cycle viewing modes.  The 1 
cycle mode displays a single cycle in detail for periodic waveforms. 

When not in continuous mode (set under the options tab) the Refresh button is enabled. 
Refresh gets a new waveform from the meter and updates the display.   
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• Figure 4-5 EziView Waveform screen, Options page. 

The Options page allows the details of the display to be changed.  Cycles has already 
been covered.  Continuous mode causes the display to constantly update; otherwise the 
waveform is only captured and displayed when the Refresh button is clicked.  The 
Remove DC Offset option removes any DC component present in the waveform, usually 
due to measurement rather than the physical system.   

The Graph section allows the displayed waveforms to be selected.  Choosing fewer 
traces does not increase the update rate.  The Colors section allows the colours of the 
Background and the grid to be changed. 
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The Summary page displays a variety of measurements taken from the waveform 
(Figure 4-6). 

 
• Figure 4-6 EziView Waveform screen, Summary page. 

Table 4-1 gives the definitions for these quantities, where Waveform represents the 
sample points, and LengthofWaveform represents the number of points. 
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Quantity Description 

RMS √ ( ( ∑ Waveform2 ) / LengthofWaveform ) 

THD ((RMS – Fundamental) / RMS) * 100 

TDD ((RMS – Fundamental) / RMS) * 100 (in terms of the Load Current) 

Dist ((RMS – Fundamental) / Fundamental) * 100 

Average ( ∑ Waveform ) / LengthofWaveform 

K ( ∑ Abs(Waveform-Average) ) / LengthofWaveform / RMS 

Max Maximum (Waveform) 

Min Minimum (Waveform) 

Crest (Max – Min) / 2 ) / RMS 

Ref Internal value. 

TIF Another measure of harmonic noise in the signal. 

True PF Same as the power factor calculation in the meter. 

Neutral 
Current 

Magnitude of the Phasor Addition of IA, IB and IC. 

Voltage 
Unbalance 

A meaure of the balance of the system. 

• Table 4-1 Summary definitions. 
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Harmonics 

The waveform display in EziView (Screens → Waveform) also has the capability to 
view information about harmonics from the 2nd to the 50th.   Figure 4-7 shows an 
example graph of harmonic magnitudes for voltage.  The graph shows a typical 
harmonic profile for a General Purpose Output with 5th, 7th and 11th Harmonics. 

 
• Figure 4-7 EziView Waveform screen, Harmonics Graph page. 
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The Harmonics Options tab sets up what information is displayed (Figure 4-8).  Note 
that the Options page settings for colours and capture mode are still effective. 

 
• Figure 4-8 EziView Waveform screen, Options page. 

The Phases setting allows selection of the phases to display. 

The Quantity setting selects what quantity is displayed.  Table 4-2 shows the possible 
options. 

Quantity Description 
Voltage Displays the voltage harmonics as a percent of the fundamental. 
Current Displays the current harmonics as a percent of the fundamental. 
Voltage Mag Displays the voltage harmonic magnitudes in volts. 
Current Mag Displays the current harmonic magnitudes in amps. 
Watts Displays the power of each harmonic in watts, with sign. 

• Table 4-2 Harmonic quantity options. 

The first two options have a wide range of formatting options for the display.  These are 
listed in Table 4-3. 
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Graph Option Description 
Phase Displays the phase (A, B and C) under the bars if there is room. 
Gaps Puts gaps between each harmonic. 
Number Numbers the harmonics. 
Log If checked, the scale is a log scale.  If unchecked the scale is linear. 
Max % The maximum % value to display on the graph for linear scales. 
Avg EziView will perform a running average over this many readings 

from the meter.  This can settle down the display when harmonics 
are changing. 

Width This is the number of harmonics to display. 
• Table 4-3 Harmonic graph options. 

The other three options have a single formatting option of Show Fundamental.  
Unchecking this box prevents the fundamental from being displayed, bypassing scaling 
problems when the harmonic levels are relatively low compared to the fundamental. 

The Default button returns the graph settings to their default values. 

To see the harmonic values in table form use the Harmonics Table page (Figure 4-9). 

 
• Figure 4-9 EziView Waveform screen, Harmonics Table page. 

The table displays relative and absolute magnitudes, as well as power and V to A angles 
(VIA).  You will need to resize the rows by dragging the dividing lines to see the 
information properly. 
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Right clicking on a rows data and selecting Info brings up a graph of the voltage and 
current vectors for the selected harmonic number (Figure 4-10). 

 
• Figure 4-10 Single Harmonic Graph. 
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Time Of Use 

This screen is used to display the current values from the Time Of Use system of the 
meter.  The display shown (Figure 4-11) is from a partially configured meter.  See 
Chapter 13 for complete information. 

 
• Figure 4-11 EziView Time Of Use screen. 

Gated Energy 

The gated energy screen shows the contents of the gated registers, used for accuracy 
testing.   

 
• Figure 4-12 EziView Gated Energy screen. 
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Online Variables 
The Online Variables dialog (Figure 4-13) contains everything else that needs to be 
displayed or changed while online to the meter.  The tree diagram on the left of the 
dialog indicates the pages available.  Settings made on these pages take effect 
immediately, and are not stored anywhere but in the meter. 

 
• Figure 4-13 Online Variables screen, Date/Time page. 

Most of the options are discussed in other sections of the manual in detail.  The only 
pages not covered elsewhere are the options and system pages. 

 
• Figure 4-14 Online Variables screen, Options page. 
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The Options page (Figure 4-14) allows the rate at which the online variables will be read 
from the meter and updated.  The actual update rate may be slower, depending on the 
number of items to be read and the speed of the communications link to the meter. 

The System page (Figure 4-15) displays some basic information about the meter. 

 
• Figure 4-15 Online Variables screen, System page. 

The Hardware section gives the general model number, and the specific build code for 
this meter (not always present).  The Software section gives the firmware version of the 
meter and the revision number.  If contacting EDMI for technical support you should 
have the Version number available if possible. 

Special Commands 
The special commands cover the more specialised and esoteric functions.  The Read 
Register and Write Register commands allow registers to be read and written directly to 
the meter.  This functionality is covered in more detail in Chapter 5. 

The other command is the Restart Meter command.  It ‘reboots’ the meter, an effect 
very similar to turning the power off and on to the meter.  The connection with the 
meter will be broken after this command.  There should generally be no need to use this 
command, but it is provided for diagnostic purposes. 
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Chapter 5 Registers 
The Genius is able to store a vast amount of information.  In order to find a particular 
piece of information there needs to be a way to refer to it.  This is done using register 
numbers.  Each piece of information in the meter is stored in a register, and each register 
has a number.   

Register numbers provide a universal way of referencing information within the meter.  
A basic understanding of registers is important as much of the meter’s operation is 
based on registers. These registers can be used both as a reference to information within 
a device (as used by the meter’s LCD displays), and as a means of programming and 
reading the device remotely. 

However, it is not necessary to fully understand registers to use the meter.  EziView 
hides most of the usage of registers, so don’t be alarmed if the following more detailed 
sections seem a little complex.  

What’s in a Register? 
Each register has a number of different properties besides the value stored in it.  These 
include the type and unit of the value, and which security group it belongs to.  Registers 
can be read to retrieve their current value (e.g. displaying voltage on the LCD), or 
written to store a new value (e.g. setting the time).  Some examples of registers are 
shown in Table 5-1. 

Register Register 
Number 

Data Type  Example Value Unit Security 
Group 

Phase A Voltage E000 Float 237.345 Volts 35 
Plant Number F00D String Fred Electric None 21 
Number of Billing 
Resets 

F032 Long 453 None 92 

Last Billing Reset FC00 Time/Date 14:30:24 28/8/98 None 93 
Frequency E060 Float 50.056 Hz 200 
Channel 1 Unified 
Energy 

0009 Double 12332543.12234 Wh 42 

• Table 5-1 Example Registers 



  

   

Register Numbers 

The register number is represented as a hexadecimal number.  Whereas decimal 
numbers (base 10) count from 0 to 9, hexadecimal numbers (base 16) count from 0 to 9 
then A to F.  Thus the 4 digit hexadecimal numbers used for the registers listed in Table 
5-1 above give 164 possible registers, that is 65536.   

Normally register numbers can just be used as is, so there is no need to worry about 
hexadecimal arithmetic.  

Full register numbers are 8 digits (32 bit).  Wherever a 4 digit number is listed (as in 
Table 5-1 above) the first four digits are assumed to be zero.  For example, E000 is 
actually 0000E000.  The 4 digit numbers are used for convenience, as most of the 
commonly used registers fall into this category.  EziScript extensions use registers with 
non-zero digits in the first four positions. 

Register Types 

There are a few more parts to registers than are immediately obvious.  Each register has 
a defined type that gives information about what kind of data it can store.  The type is 
given a capital letter to identify it.  For example, type ‘C’ is an 8-bit integer that can 
store values from 0 to 255.   

Some types though have both an internal format, and an external format.  For example, 
type ‘E’ is used to store alarm strings.  Its normal External form is a string of 16 letters 
or dots depending on whether a particular alarm is active.  This is easily read on an LCD 
or other display.  Internally to the meter though, it is stored as a 16-bit number.  When a 
bit is on, the corresponding alarm letter is displayed instead of a dot.  Each bit of the 
number represents one of the 16 letters in the string. 

The Internal form of the type is much smaller to store than the external type, and some 
operations can be easier to perform.  In order to make this form available, the meter has 
both external and internal types for some data types.  The base data type of an alarm 
register like F01A is ‘E’.  Reading register 0000F01A gives the external value, with a 
data type of ‘A’ – a null terminated string of characters.  Reading register 0001F01A 
requests the internal form (note the 1), which is data type ‘H’ – a hexadecimal 16-bit 
number.  

Not all registers have internal types, and not all registers permit the internal version to be 
read.  Except in special circumstances the Internal types may be ignored.  Table 5-2 
gives a list of all available base data types and what they translate to.  In most cases 
EziView and the meter handle any type conversions transparently, but advanced users 
will find this information useful.   

A note for command line users - all number formats more than 8-bits have big-endian 
byte ordering – that is the Most Significant Byte occurs first.   
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Base Data 
Type 

Name Data Format External 
Type  

A  String Null terminated ASCII string.  A series of ASCII 
characters, with the end being marked by a zero.  For 
example, “Hello” is represented as the bytes: 
 {72}{101}{108}{108}{111}{0} 

A 

B Boolean This is a byte that can be 0 meaning false, or 1 being 
true.  Setting it to any non-zero value will result in a 
setting of 1. 

B 

C Byte 8-bit unsigned integer. C 

D Double Double precision IEEE 64-bit floating point number. D 

E EFA String External 16 character + null EFA string. 
Internal 16-bit unsigned integer. 

A,H 

F Float Single precision IEEE 32-bit floating point number. F 

G String/Long External string representation of an integer. 
Internal 32-bit signed long integer. 

A,L 

H  Hex Short 16-bit Hex unsigned short. H 

I  Short 16-bit signed short integer. I 

J  Variable 
Special 

If the written size is less than the maximum size it is 
padded with zeros. 
When read always returns the maximum size. 

J 

L Long 32-bit signed long integer. L 

N None Used by the meter to indicate an invalid type.  N 

O Float Energy Internal 32-bit unsigned integer micropulses. 
External float (with transformer ratio applied). 

F,L 

P Power 
Factor 

Internal signed short from –32767 to 32767. 
External float from –1.0 to +1.0. 

F,I 

Q Time Internal unsigned 32-bit seconds since midnight. 
External time as 3 bytes:  {Hour}{Minute}{Second} 
Displays on an LCD formatted as HH:MM:SS 

Q,X 

R Date Internal unsigned 32-bit seconds since 1/1/96. 
External date as 3 bytes:  {Date}{Month}{Year} 
Displays on an LCD formatted as DD/MM/YY 

R,X 

S Special Special (not a regular type) S 

T Time/Date Internal unsigned 32-bit seconds since 1/1/96. 
External time/date as 6 bytes: 
 {Date}{Month}{Year}{Hour}{Minute}{Second} 
Displays on an LCD formatted as 
HH:MM:SSDD/MM/YY 

T,X 

U Double 
Energy 

Internal 64-bit integer micropulses. 
External double (with transformer ratio applied). 

D,V 

V Long long 64-bit signed integer generally expressed in 
hexadecimal for ease of display (16 digits). 

V 

W Waveform Captured waveform, with status data.  Format of the 
F402 register. 

W 

X Hex Long Hex unsigned long. X 

• Table 5-2 Types of Register  
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Register Units 

Each register has a unit, although many simply have ‘None’ as a unit.  These are 
displayed on the LCD when selected, and are available to command line users using the 
information command. A single capital letter is used to refer to the unit.  The possible 
units are listed in Table 5-3. 

Unit Code Measurement Unit 
A Amps 

D Angle in degrees 

H Hz 

M Minutes 

N No unit 

P Percent 

Q Power Factor 

R vars 

S VA 

T Seconds 

U Unknown  

V Volts 

W Watts 

X Wh 

Y varh 

Z VAh 

• Table 5-3 Types of Register  

Security Groups 

Every register belongs to one of 256 security groups.  Access to a register is granted 
only if the user has access to that group to perform the requested operation.  Security is 
discussed fully in Chapter 16. 

Accessing Registers with EziView 
EziView communicates with the meter using registers, although this process is generally 
hidden from the user.  The Special→Read Register and Special→Write Register 
commands in EziView while online to a meter allow registers to be accessed directly. 
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General Read 

 
• Figure 5-1 General Read Screen. 

The register to be read is entered into the Register field of the General Read screen 
(Figure 5-1).  Pressing enter or clicking the Go button causes the register to be read from 
the meter and displayed in the top pane.  The default Auto Dec Type option causes 
EziView to read the type of the register from the meter so that it can be displayed in the 
correct format.  The other Type settings allow this to be overridden.  The middle part of 
the window simply displays the last value read in a variety of formats. 

The Mask and Format specifiers are used to read complex registers and are not 
generally used with the Genius.  See Chapter 23 for more information. 

The ClrScr button simply clears the screen. 
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General Write 

 
• Figure 5-2 General Write Screen. 

The General Write screen (Figure 5-2) allows data to be written to registers.  The 
register to write to is entered into the Register field and the data to write is entered into 
the Send Data field.  Pressing enter or clicking the Go button will write the data to the 
meter.  The Auto Send Type causes EziView to retrieve the type of the register before 
writing so that it can format the data correctly.  This may be overridden by selecting 
another option.   

In the example of Figure 5-2 the string “Hello” has been written to register F00F, which 
is the miscellaneous string register.  The data written is displayed in the top part of the 
screen, followed by whether the operation was successful.  If unsuccessful a reason is 
given. 

Unchecking the Debug option prevents the data written from being displayed. 

To enter a hexadecimal value in the Send Data field precede the number with a ‘$’.
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Part II Configuration 
 

his section of the manual covers the information and procedures required for 
the initial installation and setup of the meter.  The first chapter in this section 
should be read first as it covers how to transfer setup information to the meter.  
The remaining chapters may be read in any order as required. 

Before you setup a large number of meters, you should decide how you will use the 
features of the meter consistently within your organisation.  This is particularly 
important in deciding security groupings, and basic setting such as TOU channels. 

 

T 

• Chapter 6: “Configuration Basics” 

• Chapter 7: “Miscellaneous” 

• Chapter 8: “External Transformers” 

• Chapter 9: “LCD Display” 

• Chapter 10: “Pulsing Outputs” 

• Chapter 11: “Pulsing Inputs” 

• Chapter 12: “Date and Time” 

• Chapter 13: “Time of Use” 

• Chapter 14: “Communications” 

• Chapter 15: “Alarms/EFA” 

• Chapter 16: “Security” 

 

Note that EziPort configuration is covered in Chapter 14. 



  

   

 

 

 

 

 

 

 

 

 

 

Intentionally Blank 

 

 

II  EDMI Genius/Mk6E User Manual 



 

   Configuration Basics  6-1  

C h a p t e r 

6
 

Chapter 6 Configuration Basics 
The Setup option for a meter allows the configuration for the meter to be changed.  
What is edited is the copy of the configuration kept by EziView in the MTR file for the 
meter.  This chapter deals with the basics of setting up, and ways of transferring this 
information between EziView and the meter. 

Changing Configuration 
To change the configuration/setup of a meter select Setup from its right-click menu.  
The meter may be connected or off line.  A screen similar to Figure 6-1 will be 
displayed. 

 
• Figure 6-1 Meter Configuration Setup Screen. 

The data shown in the fields is the data in the MTR file maintained by EziView.  
Changing the data and clicking OK saves the changed data back to the MTR file and 



  

   

closes the setup screen.  Clicking Apply does the same but does not close the screen.  
The Cancel button will exit the screen and cancel any changes made since the last 
Apply.  The Help button is currently non-functional – refer to this manual when help is 
required. 

The only items of setup data not stored in the MTR file are extensions (tools).  These are 
stored as separate TBX files, and are referred to by the MTR file.  For more information 
on this see Chapter 17, “Using EziScript Extensions”. 

Most configuration changes are made using the Setup pages.  The tree on the left side 
shows the available pages, and clicking on the tree moves to the selected page. 

Changing data in the Setup pages may be performed when connected to the meter or 
offline.  The changes will not be sent to the meter in either case unless they are 
transferred (discussed next). 

Transferring Configuration 

Read Setup from Meter 

This is the most basic option.  It simply reads the entire setup from the meter into 
EziView.  To change the setup of an exisiting meter use this option first to ensure that 
the EziView copy of the meter configuration is complete.  The setup can then be edited 
and sent back to the meter. 

EziView first asks for confirmation to proceed with the download (Figure 6-2). 

 
• Figure 6-2 Read all setup values dialog. 
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Continuing, EziView checks the meter’s time against the computer’s time.  If it is 
different by more than the amount set in Tools → Options → General → Max Time 
Error EziView will prompt you to set the clock in the meter (Figure 6-3).  Clicking Yes 
will set the time in the meter to the same as the computer.  Clicking No will skip the 
time set, and clicking Cancel will abort the read operation. 

 
• Figure 6-3 Set time dialog. 

EziView will now download the entire setup from the meter (Figure 6-4).  This 
operation may take some time, depending on the speed of the communications link. 

 
• Figure 6-4 Read setup in progress. 

If any problems occur during the transfer you will be notified.  The most likely problem 
is that you do not have permission to read some of the setup values.  Any values that 
could not be read will be listed.  For these values EziView will retain its existing 
settings. 

EziView caches reads and writes to setup registers in the meter.  As a result, if the setup 
is read again without disconnecting, the data will “transfer” very quickly.  EziView is 
simply using its cached values.  To force EziView to clear the cache, disconnect from 
the site and reconnect. 
 

Write Setup to Meter 

This option writes all of the setup to the meter.  You should be sure that you want to 
overwrite all existing settings in the meter before using this option.  EziView will 
prompt before sensitive sections (TOU Setup, Extensions and Security) are written.  
Meter calibration is not written. 
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Synchronise Setup 

This option allows the information that is to be written to the meter to be specified based 
on the grouping in the setup pages.  The meter setup is synchronised with EziView. 

 
• Figure 6-5 Synchronise Setup. 

If the group is checked then the setup from EziView will be sent to the meter for that 
group.  If unchecked, the setup in the meter is read and stored in EziView.  The All 
button checks all boxes except for Restricted Setup boxes – these may be checked 
manually.  The None button clears all boxes.  Confirmation is asked for when checking 
any of the Restricted Setup boxes.  The Extensions box is for the transfer of tools to the 
meter, while the TOUSetup box is for the transfer of the TOU channel setup.. 

Clicking OK will transfer the selected settings to the meter, and read the unselected 
settings into EziView.  A completely unchecked form has the same effect as Read Setup 
from Meter, while a completely checked form has the same effect as Write Setup to 
Meter. 
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Compare Setup with Meter 

This is the most sophisticated of all of the transfer methods.  It compares the setup in the 
meter with the setup maintained by EziView, then allows fine control over how to 
resolve the differences.   

 
• Figure 6-6 Compare Setup. 

The comparison is done in two parts.  The first part compares the meter and EziView 
without making any changes.  A screen such as that shown in Figure 6-6 is displayed.  
This details any differences between the meter and the EziView file.  The top left pane 
lists the properties that had differences.  Selecting one of these properties displays the 
differences in the right hand pane.  The radio button allows the method of resolving the 
difference to be set. 

The first option Data in Meter read into File will read the setting from the meter and 
write it to the EziView file.  The second option does the reverse.  A meter or disk icon is 
displayed next to each setting to indicate its selection.  The All File and All Meter 
buttons may be used to change the settings of all parameters. 

Once the method of resolving the differences has been finalised, click the OK button.  
This performs the writes and reads as selected.  Clicking the Cancel button will abort the 
operation without making any changes. 

Note that extensions (tools) appear as a single entry – you may need to scroll across the 
listed extensions by clicking on the display field and using Ctrl and the right and left 
arrows. 
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Automatic Transferral 

EziView may be configured to automatically initiate setup transfers.  This option is 
configured using the Tools → Options → General → Auto Transfer option (Figure 6-7). 

 
• Figure 6-7 Auto Transfer Options. 

The None option is the default, which disables auto transfer.  The Prompt option causes 
EziView to prompt whenever the setup pages are opened while the meter is connected.  
The prompt asks if the setup should be transferred from the meter to ensure that the 
current meter setup is edited.  EziView will also prompt when the OK or Apply buttons 
are clicked on the setup pages to ask if the new setup should be written to the meter 
immediately. 

The Auto option performs a similar function, but performs the transfer without 
prompting. 

Copying Setup 
EziView also provides tools to copy setup from one meter and transfer it to another.  
This is useful where the setup for one meter needs to be copied to a number of other 
meters.  Select Edit→Copy Setup from the right-click menu (or Edit menu) of the meter 
to copy setup from.  A copy icon will appear  next to the meter as a reminder which 
meter is being copied from.   

6-6  EDMI Genius/Mk6E User Manual 



 

  Copying Setup 

Now select the meter or meters to paste the setup to and select Edit→Paste Setup from 
the right-click menu (or Edit menu).  The following screen will be displayed (Figure 
6-8), very similar to the synchronise setup dialog. 

 
• Figure 6-8 Paste Setup. 

The source and destination meter are listed at the top of the dialog.  If multiple 
destination meters have been selected they will all be listed.  Multiple meters may be 
selected at a site by holding the control or shift key down while selecting, following 
standard windows conventions. 

The bottom part of the dialog selects what parts of the setup will be copied.  Where the 
box is unchecked, that part of the setup will remain unchanged.  Where the box is 
checked, the setup will be copied from the source meter to the destination meter.  The 
All and None button provide an easy way to select all boxes or clear all boxes. 

Clicking OK performs the copy of the selected parameters. 
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Chapter 7 Miscellaneous 
This chapter covers the configuration parameters that do not fit into any of the other 
chapters.  This includes feature codes, extended feature codes and miscellaneous ID 
strings. 

Feature Codes 
Feature codes provide a way of upgrading meter functionality at a later date.  A feature 
code consists of a string of 16 upper case characters.  It will only work for the specific 
meter that it was created for.  The feature code unlocks a number of options – different 
feature codes can unlock different combinations of options. 

 
• Figure 7-1 Online variables feature code page. 

To change the feature code of a meter: 

1. Connect to the meter with EziView. 

2. Go to the Screens→Online Variables→Feature Code page (Figure 7-1). 



  

   

3. Enter the new feature code into the feature code field.  Make sure that it is the 
correct code for this meter. 

4. Click the Set button.   

5. The Feature Code Status section will update to show the new code and the features 
enabled.  If no features are enabled, check the spelling of the feature code for errors 
and check that it is the correct feature code for the meter. 

The available features are listed in Table 7-1: 

Feature Meaning 
Single rate TOU Allows a single rate of TOU. 

Two rate TOU Allows two rates of TOU. 

Four rate TOU Allows four rates of TOU. 

Eight rate TOU Allows eight rates of TOU. 

Billing Resets Allows billing resets to occur. 

Maximum Demand Enables maximum demand calculations. 

Manual Output Control Allows outputs to be set manually (not just pulsing/time 
sync). 

4 Quadrants Enables full 4 quadrant measurements. 

var and VA Measurements Enables var, varh, VA and VAh measurements. 

Waveform Capture Allows waveforms to be captured and downloaded. 

Extension Upload Allows new EziScript extensions to be written to the meter. 

Enhanced Modem  Allows the enhanced modem script to operate, which 
supports turning off of modems. 

Eziport Enables the Eziport. 

• Table 7-1 Feature code features.  

To see the list of available features, connect to the meter and go to the Screens→Online 
Variables→Feature Code page. 

Extended Feature Code 
In addition to the feature code system, the meter has an extended feature code system.  
This is used to control access to EziScripts and Toolbox tools.  Unlike the normal 
feature code scheme, extended feature codes are cumulative.  Each extended feature 
code enables one or more options, in addition to the existing options.   
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The Screens→Online Variables→Extended Feature Code page is used to enter new 
codes (Figure 7-2). 

 
• Figure 7-2 Extended feature code setup page. 

To enter a new code, type it into the Feature Code field and click the set button.  Check 
it is for the right serial number if it has no effect.  Where large number of codes are 
required they may be supplied in a file.  The Load From File button allows a file to be 
selected which contains the extended feature codes. 

The extended feature codes enabled in the meter are listed on the page.  If a code is 
enabled which your version of EziView does not understand, three question marks will 
be displayed beside the extended feature number, but the feature is still enabled. 
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System Parameters 
These settings do not change the meter’s operation.  They simply allow names to be 
applied to the meter for reference. 

 
• Figure 7-3 System Parameters setup page. 

The following table (Table 7-2) lists suggested uses for these settings.  All are character 
strings. 

Feature Length Use 
Site ID 4 Quick code identification for the site. 

Site Name 20 Name of the site the meter is located at. 

Feeder Name 20 Name of the Feeder connected to the meter. 

Utility Name 20 Name of the company that owns the meter. 

Plant Number 20 Assigned plant number for this meter. 

Miscellaneous 49 Any extra information. 

• Table 7-2 System Parameter string uses.  
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Chapter 8 External Transformers 
This section is dedicated to configuring the meter for its voltage and current 
connections. 

In many applications external measurement transformers are used between the meter 
and the system to be measured.  The values at the input to the meter are defined as 
secondary quantities and the values on the high voltage/current side of the measurement 
transformers are defined as primary quantities.  The meter allows the ratios of these VTs 
and CTs external to the meter to be accounted for. 

Changing the transformer ratios in a meter with existing data may have variable effects 
on the data already stored.  Much of the information recorded by the meter is effectively 
in secondary quantities.  Changing the transformer ratios affect how these stored values 
are read out as primary values.  This mainly affects the Time of Use system.  The effect 
on load surveys will depend on the survey (See Chapter 19 for more information).   
Because of this it is strongly recommended that the Time of Use readings be cleared if 
the transformer ratios are changed. 
 

The meter also needs to know the nominal voltage and current at the meter terminals, 
i.e. the secondary values.  The meter uses these for the generation of alarms (see Chapter 
15 for more information).   

Finally the meter needs to know if it is connected in two element or three element mode 
(See Chapter 2 for connection details).  This is not automatically detected in order to 
make the detection of alarm conditions more reliable. 

 



  

   

Transformer Ratios 

 
• Figure 8-1 Transformer ratios page in EziView. 

To set up the connection characteristics of the meter: 

1. Go to the TransformerRatios page of the Meter Configuration Setup screen 
(Figure 8-1). 

2. Set the Measurement Config to 2 Element or 3 Element.  It must match the 
wiring configuration of the meter. 

3. Set the External CT ratio.  This is the ratio of any external measurement CT.  
Set to 1:1 if no external CTs are used, such as whole current meters. 

4. Set the External VT ratio.  This is the ratio of any external measurement VT.  
Set to 1:1 if no external VTs are used. 

The Measurement Method defines whether the energy values recorded by the meter are 
limited to only the Fundamental Energy or the Total Energy including harmonics 
measured by the meter. 

Note that like all changes to the setup pages, these changes take effect when written to 
the meter (see Chapter 6). 
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Chapter 9 LCD Display 
The LCD of the meter is for displaying information from the meter’s registers.  The 
LCD is a two line by 16 character display which can display any letter, number and a 
variety of symbols.  See the section “LCD/Select Button” on page 2-17 for information 
on how to use the display. 

The meter allows for up to 64 pages of display.  Each page can display a single 
register’s contents.  How the register is displayed is controlled by a format for each 
page. 



  

   

LCD Formatting 
There is a wide range of formatting options available that affect how a register’s 
contents are displayed.  Most options only affect floating point numbers, which have 
data types of ‘F’ or ‘D’.  All displays are left justified unless otherwise indicated. 

Base Data 
Type 

Name Display Format 

A  String Displayed as is.  If longer than 59 characters it is not displayed 
at all – “Unreadable 5” is shown instead. 

B Boolean If true, the word “TRUE”.  If false, the word “FALSE”. 

C Byte Displayed as a number from 0 to 255. 

D Double See the Floating Point Numbers section below. 

F Float See the Floating Point Numbers section below. 

H  Hex Short Displayed as 4 hexadecimal digits.  Leading zeros are shown. 

I  Short Displayed as a number from 0 to 65535.  Units may be enabled 
for display following the number, with a space separating. 

J  Variable 
Special 

Cannot be displayed.  “Undefined” is shown instead. 

L Long Displayed as a number from 0 to 4294967295. 

Q Time Displayed in the form “HH:MM:SS” 

R Date Displayed in the form “DD/MM/YY” 

S Special Cannot be displayed.  “Undefined” is shown instead. 

T Time/Date Displayed in the form “DD/MM/YYHH:MM:SS” 

V Long long Displayed as 16 hexadecimal digits.  Leading zeros are shown. 

W Waveform Cannot be displayed.  “Undefined” is shown instead. 

X Hex Long Displayed as 8 hexadecimal digits.  Leading zeros are shown. 

• Table 9-1 LCD data type formatting.  

Floating Point Numbers 

The formatting capabilities for floating point numbers are far more extensive than for 
other types of data.  In the following examples (Table 9-2) the number 
12345.67890234567 is being displayed.  For clarity, hashes (#) are used to illustrate 
spaces.   

Digits Places 0 Fill Displayed as… 
15 3 No 12345.678 

10 3 No #####12345.678 

4 3 No 2345.678 

0 3 No .678 

15 3 Yes 12345.678 

10 3 Yes 0000012345.678 

4 3 Yes 2345.678 

0 3 Yes .678 

15 0 No 12345 

15 8 No 12345.67890234 

• Table 9-2 LCD floating-point formatting examples.  
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The Digits parameter (for values 0 to 14) sets the length of the number, including a 
minus sign if present, up to the decimal point (but not including the decimal point).  If 
the number is shorter than set by the parameter it is padded with spaces from the left.  If 
the 0 Fill parameter is set then the number is padded with zeros instead of spaces.  This 
option should not be used with numbers that may be negative.  The zero fill option is 
useful for duplicating the look of mechanical counters. 

A Digits setting of 15 causes all digits of the number before the decimal place to be 
displayed. 

The Places parameter sets the number of digits to be shown after the decimal point.  The 
number is rounded to this precision.  It may be set from 0 to 15.  If set to 0 the decimal 
point is not shown.  Floating-point numbers have an infinite number of decimal places, 
but not all digits are significant. 

The number of significant digits in a floating-point number is not infinite – it is limited 
by the floating-point format.  Type ‘F’ registers have 7 significant digits, while type ‘D’ 
registers have 15 significant digits.  All digits beyond these limits have no meaning. 
Also, take account of the basic accuracy and resolution of the quantity that is being 
displayed. 
 

Units 

The formatting also allows units to be specified.  This is controlled by the Multiplier and 
Units settings.  Turning Units on enables the display of a unit after the number.  The 
meter knows the units of all registers. 

The Multiplier parameter allows the number to be scaled.  It only has an effect on 
floating-point formats.  A prefix is also added to the unit if displayed.  Table 9-3 lists the 
available multipliers. 

Multiplier Meaning Displayed value 
G Giga Reading divided by 1 000 000 000 

M Mega Reading divided by 1 000 000 

K Kilo Reading divided by 1 000 

-None-  Reading as normal 

M Milli Reading multiplied by 1 000 

U Micro Reading multiplied by 1 000 000 

• Table 9-3 LCD unit multipliers. 
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Table 9-4 gives a series of examples of using units.  All examples have Places set to 2, 
and Digits set to 15.  The number is in Wh. 

Number Unit Multiplier Displayed as… 
1234.56789 No None 1234.56 

1234.56789 Yes None 1234.56Wh 

1234.56789 Yes k 1.23kWh 

1234.56789 No k 1.23 

1234.56789 Yes m 1234567.89mWh 

• Table 9-4 LCD unit examples.  

Registers with a Unit of Q (Power Factor) display the absolute value of the number, then 
indicate lead or lag as the unit.  If no unit is shown the sign of the number indicates lead 
and lag. 

LCD Setup 

 
• Figure 9-1 EziView LCD setup. 

The LCDScreens page in EziView (Figure 9-1) has the setup for the LCD pages. Each 
line of the table is the setup for one page.  The displays higher up the table are shown 
before those shown further down.  

To add an LCD screen: 

1. Double click on the first blank register field of the table.  This displays the register 
selection screen (Figure 9-2). 
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If the register to display is known, it may be entered directly into the register field 
without using the Register Selection Dialog.  In this case go straight to step 4. 
 

 
• Figure 9-2 EziView Register Selection Dialog with “Phase A Instantaneous 

Voltage” selected. 

2. Select the register to display.  As each entry is selected the options within that entry 
are displayed in the next column to the right.  When the register is completely 
defined the Add and OK buttons will activate. 

3. To add a series of registers to the list of screens click on the Add button.  To add a 
single register and return to the table click on the OK button. 

4. To display leading zeros check the 0 Fill box.  This only has an effect for floating 
point registers.  Digits must be less than 15 as well. 

5. To limit the number of digits to the left of the decimal point set a number other than 
15 in the Digits field.  Set the Digits field to 15 to allow any number of digits.  This 
only has an effect for floating point registers. 

6. Set the Place field to the number of digits required after the decimal point.  This 
only has an effect for floating point registers. 

7. Set the Multiplier field to the desired unit multiplier.  See Table 9-3 for a list of the 
available options. 

8. Check the Units field to display a unit after the value.  If a multiplier has been 
selected it is prefixed to the unit.  The meter knows the units of all registers, 
although not all registers have units. 

9. Select the display set the register belongs to from the list in the Set field.  Note that 
set D cannot be reached from the Select button. 
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10. Enter a description of the register to be displayed on the top line of the LCD.  A 
default description is entered when a register is selected from the Register Selection 
dialog.  Descriptions may be up to 16 characters long.  If the description is blank, 
the description “Reg: XXXXXXXX” is used, where the Xs represent the register 
number in hexadecimal. 

If the same register is displayed several times, the description from its first occurrence in 
the list is used for all entries. 
 

To delete an LCD screen: 

1. Select the register number to remove. 

2. Delete the register number using delete or backspace so the field is blank. 

3. Press <Enter> or click in another field. 

To move an LCD screen: 

1. Click on the numbered tab to the left of the screen to move. 

2. Drag the screen to the new location.  A highlighted line will show where the screen 
will be inserted when the mouse button is released. 

Other display parameters 

Set the Cycling Rate to a non zero number of seconds to enable display cycling.  The 
display will automatically step to the next screen after the Cycling Rate period has 
passed.  The range is 1 to 255 seconds.  A setting of zero disables display cycling. 

Set the Hold Time to the time in seconds to pause automatic display cycling when the 
Select button is pushed.  The range is 0 to 255 seconds. 

Set the Display Revert field to a non zero number to ensure the display returns to a 
known state after use.  If the Select button has not been pressed for the set number of 
minutes the display will revert to the default screen of display set A.  The range is 1 to 
255 minutes.  A setting of zero disables display revert.  

The backlight of the display is usually configured to light only when the meter is being 
read. Set the Backlight On Time to the time in seconds (1 to 254) that the backlight 
should remain on after the Select button is pressed.  A setting of 0 disables the backlight.  
A setting of 255 keeps the backlight on permanently. 

Change the Contrast setting to adjust the contrast of the LCD.  Adjustments of this 
setting are not normally required, as this is set at the factory.  Adjusting the contrast may 
help visibility in some lighting environments. 

Set the User Level to the user level that the meter will use to access the registers to 
display on the LCD.  A level of none prevents all access. 
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If a register is displayed as “Access Denied”, this is caused by the security level’s access 
being insufficient to read the register.  See Chapter 16 for more information. 
 

Direct LCD control 
The meter allows the LCD to be controlled directly from EziView.  This allows for 
everything from displaying a register without having to set it up, through finding 
suitable formatting for a register, to displaying custom messages on the LCD.  This 
dialog (Figure 9-3) is located under Online Variables → LCD in EziView. 

 
• Figure 9-3 EziView Online Variables LCD dialog. 

The LCD Status window displays what is being shown on the LCD of the meter updated 
in real time.  The Sel button has the same effect as pushing the Select button on the 
meter.  The Set button is for changing display sets, having the same effect as holding 
down the Select button on the meter. 

Below this is listed information about the current display: what register is being shown, 
its format and LCD number.  Each of the programmed LCDs is numbered from 0 to 63.  
The default LCD screen is numbered 64.  The active display set is also shown, along 
with the remaining freeze time (discussed later). 

The LCD Setting section allows the display to be controlled directly, bypassing the 
preprogrammed screens.  The Register tab allows a register to be displayed with the 
same sort of formatting controls used for programmed pages.  The settings are updated 
when <Enter> or the Set button is pressed. 
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• Figure 9-4 EziView Online Variables LCD dialog, Number Tab. 

The Number tab (Figure 9-4) allows the LCD to go straight to a programmed page using 
its number from 0 to 63, or 64 for the default page.  If the page is unused the message 
“No Display Defined” is shown. 

 
• Figure 9-5 EziView Online Variables LCD dialog, Display Set Tab. 

The Display Set tab (Figure 9-5) allows the active display set to be changed. This is 
where the meter can be changed to display set D, normally inaccessable. 
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• Figure 9-6 EziView Online Variables LCD dialog, Screen Tab. 

The Screen tab is used to override what is shown on the LCD with a custom message.  
The text to be displayed is entered into the edit field, then the Set button is pressed to 
send the change.  The text will be displayed for the Freeze time, set on the final tab. 

 
• Figure 9-7 EziView Online Variables LCD dialog, Freeze Tab. 

The Freeze tab allows the LCD freeze time to be set.  When the freeze time is set (in 
seconds, 0 to 255) the Freeze counter will count back down to zero.  During this time 
updates to the display are frozen, stopping the display from changing.  The freeze time 
is set when the Set button is pressed, or the Set button on the Screen tab is pressed.  
When the freeze counter reaches zero, normal updates of the LCD will resume. 
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Q & A 
Q. What seems like an error message is displayed instead of the data.  What does it 
mean? 

A. Refer to the following table. 

Message Meaning 
The top line shows “Reg: 
XXXXXXXX” instead of a 
description. 

No register description was entered in setup.  
XXXXXXXX is the register number. 

The top line is blank. The register description has only spaces in it. 

The bottom line shows 
“Unreadable X”. 

The register could not be read.  X gives the response 
code.  Common codes are: 
3: Register not found. 
4: Access Denied for security reasons. 
5: Read data too long (More than 60 bytes) 

The bottom line shows 
“Undefined”. 

The data type of the register to be displayed cannot be 
shown on the LCD. For example, a waveform. 

The top line shows 
“XXXXXXXX: Undef”. 

The register indicated cannot be found. 

The top line shows 
“XXXXXXXX: Spec”. 

The register indicated is a type ‘S’ register and cannot be 
displayed on the LCD. 

The top line shows “Revert to 
set A” occasionally. 

This is the meter returning to the beginning of set after 
the user specified revert time. 

The display shows “No Display 
Defined”. 

The display number has been set manually to a 
programmed page that is not used. 

• Table 9-5 LCD unit examples. 

Q. Nothing seems to happen when I press the Select button. 

A. There are no pages enabled in the current set.  Try changing the set by holding 
down the Select button for a second. 

Q. The bottom line seems to scroll around and around. 

A. The line to show is longer than 16 characters so the meter is scrolling it to display 
it.  To avoid this try to format pages so that the bottom line is no more than 16 
characters. 

Q. I need to light all segments as a display test. 

A. Use register FFFE (LCD only Status → Display Test).
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Chapter 10 Pulsing Outputs 
The pulsing outputs of the meter provide more functionality than simply an indication of 
power usage.  Among other things they also allow for a synchronising time pulse to be 
generated or for various fixed output uses where the state of the output is used rather 
than its pulse rate. 

Output Hardware 

EDMI Mk6 Genius Meter 

The Mk6 Genius Meter has up to 9 outputs of various types.   

C h a p t e r 
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There are two red LEDs on the meter face located just below the LCD.  These would 
generally be used to generate pulses for meter accuracy testing.  They are labelled Pulse 
1 and Pulse 2. 

Up to 7 ouputs are available on the terminals under the terminal cover (Figure 10-1). 

 
• Figure 10-1 Mk6 Genius Terminal block diagram. 

TB3 to TB9 may be outputs, depending on the exact meter type.  These correspond to 
outputs 1 to 7.  TB3 is shared with input 2, so depending on the meter’s configuration 



  

   

the terminal may be an input or an output. Refer to the terminal cover or order code for 
details. 

All outputs are clean contact, voltage free.  All outputs are fully isolated from each other 
(2kV).  The BOSFET drivers are rated up to 110V. 

EDMI Mk6E Meter 

The Mk6E Meter has a maximum of 8 outputs built in directly to the meter.   

There are two red LEDs on the meter face located just below the LCD.  These would 
generally be used to generate pulses for meter accuracy testing.  These LEDs are 
connected to Output’s #1 and #2.  Their status is directly mirrored by the two outputs on 
TB3. 

Figure 10-2 shows the terminals of the EDMI Mk6E.  TB3, TB4, TB5 and TB6 are the 
terminals where outputs are fitted.  All outputs are clean contact, voltage free.  The 
outputs are fully isolated from other circuits, though some of the outputs share common 
terminals.  The BOSFET drivers are rated up to 110V. 

1

2

3 4
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6 8
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10 12

13

14

117

TB 1

TB 12

TB 2 TB 3 TB 4 TB 5 TB 7 TB 8

TB 10 TB 11

TB 6

 
• Figure 10-2 Mk6E Terminal block diagram. 

The following table shows the terminals used by the first 4 outputs in the meter. 

Terminal Description 
TB3-1 Common Terminal (#1 and #2) 

TB3-2 Output #1 (LED #1) 

TB3-3 Output #2 (LED #2) 

TB4-1 Common Terminal (#3 and #4) 

TB4-2 Output #3 

TB4-3 Output #4 

• Table 10-1 Mk6E Standard Output Terminals 
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Table 10-2 shows the terminals used by the second 4 outputs that can be fitted on the 
Mk6E.  All of these outputs share a single common terminal on TB4 (Pin 1). 

Terminal Description 
TB5-1 Output #5 

TB5-2 Output #6 

TB6-1 Output #7 

TB6-2 Output #8 

• Table 10-2 Mk6E Extended Output Terminals 

Programming Outputs 
All of the outputs are functionally identical.  The PulsingOutputs setup screen in 
EziView allows them to be configured.  Figure 10-3 shows the configuration screen for 
a Mk6 Genius Meter. 

 
• Figure 10-3 Mk6 Genius EziView Pulsing Outputs Setup page. 

The fitted outputs are listed down the page.  Each output has its own 2 line display.  
LED1 and LED2 refer to the two pulse LEDs.  Outputs 2 and 3 refer to 2 of the outputs 
on the top row of terminals. Outputs 1 and Outputs 4 to 7 can be setup by clicking on 
the Add button.  These are not currently listed on the setup screen since they have been 
configured as Not Fitted (Discussed later). 

Figure 10-4 shows the Pulsing Output setup page for a Mk6E meter.  Notice that LED1 
and Output1 are setup as the same output as are LED2 and Output2. 
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• Figure 10-4 Mk6E EziView Pulsing Outputs Setup page. 

Each output has a mode which is listed next to the Output designator.  Depending on the 
mode, various other options become available.  Each mode operates as described in the 
following sections. 

Most modes have an invert option Inv. which defines what active means.  Normally an 
active pulse is generated by lighting an LED or closing a contact.  If this box is ticked 
then this convention is inverted – pulses are generated by turning off an LED or opening 
a contact. 

To change the mode of an output or other options, click on the Edit button.  Figure 10-5 
shows the page used to edit individual Pulsing Output settings. 

 

• Figure 10-5 Pulsing Outputs Settings page. 
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Not Fitted 

This is used to indicate that this output is not physically fitted to the unit.  This is simply 
a tag to remind the user – it is not something detected from the actual hardware. 

Off 

This is used to indicate that the output is fitted, but is not being used for anything.  The 
output will be off.  There are no other options. 

Pulsing 

The pulsing output mode is the most complex as there is a lot of flexibility in 
configuring this mode.  Pulsing outputs may be used to test the meter’s accuracy, or to 
supply an indication of energy usage to another device.  The output pulse rate is 
proportional to the energy measured such that each pulse represents a defined amount of 
energy. Table 10-3 lists the options available. 

Setting Description 
Inv. Output polarity. 

Active Time This is the approximate time in milliseconds that the output will pulse 
active for.   

Inactive Time At least this time (in milliseconds) should occur between pulses.  If it 
does not, a pulsing output overflow EFA alarm is generated to warn 
that pulses may be lost. 

Parameter This is the amount of energy that each pulse represents in Wh, varh, 
or VAh as appropriate.  Valid settings are from 0.000001 to 
1000000000000.0 

P/S The parameter may be either a primary (at VT/CT inputs) or a 
secondary (at meter terminals) quantity.  This selects which: P for 
primary, S for secondary.  Secondary is especially useful for test 
LEDs in laboratory testing so that they are unaffected by the 
transformer ratio set. 

Channel This selects what input channel the energy is from.  “All” is the most 
used option, where it is the total of all three phases (2 in two element 
mode).  The phase by phase options (“A”, “B” and “C”) are most 
useful in 3 element mode where each phase may be indicated 
independently.  

Type This gives the type of energy – “Wh”, “varh”, or “VAh”. 

Sign The “Abs” option here means that the output will operate for energy 
flowing in either direction.  The “+” and “-” select Export only or Import 
only energy respectively.  The diagram at the bottom of the setup 
page illustrates the energy directions.  Figure 2-16 on page 2-20 gives 
more detailed information. 
The remaining options allow any combination of quadrants to be 
selected.  The numbers refer to the quadrant numbers 1 to 4 given in 
the setup page diagram.  An x is shown for disabled quadrants that 
will not give an output.  

• Table 10-3 Pulsing Output options. 
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Notes 

For the active and inactive times, the exact time is 1% less than set, and is also less if the 
system frequency is higher than nominal.  The output is less by the percentage 
difference.  In normal operation these variations will have no noticeable effect on the 
pulse length and are only listed here for completeness.  Note that this only changes the 
duration of the pulse and the minimum off time, not the pulse rate. 

If the pulse rate results in an inactive time of zero or less, the output will remain active.  
If the pulse rate slows down, pulses will once more be distinguishable.  Pulses do not 
‘back up’ if the rate becomes too fast – they simply merge into each other.  Therefore it 
is important to select an appropriate parameter to prevent pulses from being lost under 
high load conditions. 

Example 

An LED output is needed for testing the delivered Wh accuracy.  A pulse rate of 0.01 
Wh per pulse is needed at the meter terminals.  The sense head needs a 90ms light pulse 
with at least a 50ms gap between pulses to sense properly.   

The required setup is no inversion, 90ms active time, 50ms inactive time, a parameter of 
0.01, Secondary, All channels, W, Export (+). 

More Help 

EziView has a built in calculator that assists you in setting the Parameter for a pulsing 
output.  It is accessed by clicking on the calculator icon when configuring an output 
setup as Pulsing.  This calculator allows you to set your system characteristics (Line to 
Line or Line to Neutral Voltage, Current and Load Rating) and then tweak the rate of 
the pusling output through different representations of the pulsing rate. 

 

 

• Figure 10-6 Pulsing Outputs Settings page. 
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Pulsed 

The pulsed output mode is mostly designed for use with EziScript for pulse 
transmission.  In this mode a number of pulses are written to a register (F96X series), 
which is added to a total of pulses to be sent.  Pulses are sent with the indicated Active 
and Inactive times.  Each time a pulse is sent the pulses to be transmitted is decremented 
by one, until there are no pulses left to send.  If the meter is turned off then any pulses 
that were queued for transmission will be lost.  Table 10-4 lists the options available.  
Normally instructions for this setup will be given with the EziScript documentation. 

Setting Description 
Inv. Output polarity. 

Active Time This is the time in milliseconds that the output will pulse active for.  
This has a resolution of 5ms – if the time is not divisible by 5ms, it will 
be rounded down. 

Inactive Time This is the time between pulses.  This has a resolution of 5ms, as for 
the Active Time. 

• Table 10-4 Pulsed Output options. 

Fixed Output and Fixed Output Persistent 

This allows the state of an output to be controlled directly.  This may be done from 
EziView or other such communications program, or via an EziScript extension within 
the meter to generate outputs such as demand exceeded or active tariff indication.  This 
feature is controlled by a feature code. 

The only difference between Fixed Output and Fixed Output Persistent is when power 
to the meter is lost.  When power to the meter is restored, a Fixed Output Persistent 
output will return to the state it was last set to before power off.  A Fixed Output mode 
output will return to the inactive state under the same circumstances.  

The only option is the invert option, listed in Table 10-5. 

Setting Description 
Inv. Output polarity. 

• Table 10-5 Fixed Output/Persistent options. 
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Time Pulse 

This output mode is designed to give a synchronising time pulse to other equipment or 
meters.  The pulse is generated at a programmed interval to the second.  Table 10-6 lists 
the options. 

   Setting Description 
Inv. Output polarity. 

Active Time This is the time in milliseconds that the output will pulse active for.  
Has a resolution of 5ms – if the time is not divisible by 5ms, it will be 
rounded down.  

Inactive Time This is the time between the start of each time pulse in seconds.  The 
pulse starts at the indicated time. 

• Table 10-6 Time Pulse options. 

The offset of the time pulse from the hour or such can be calculated.  A time pulse is 
generated every Inactive Time seconds from the beginning of the meter’s time (the start 
of 1996).  Thus a setting of 61 seconds would give a time pulse every 61 seconds 
starting at midnight on the 1st of January 1996.  Of course such a setting is not very 
useful - the following list indicates some common settings. 

Interval Setting 
Every minute 60 

Every 15 minutes 60 * 15 = 900 

Every half hour 60 * 30 = 1800 

Every hour 60 * 60 = 3600 

• Table 10-7 Time Pulse options. 

Example 

A 500ms time pulse contact closure is required every 15 minutes at 0, 15, 30, and 45 
minutes past the hour. 

The active time should be set to 500, and the inactive time to 15 * 60 = 900 seconds. 
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Output Status Information 
EziView allows some of the output parameters to be displayed and changed via the 
Screens → Online variables → PulsingOutputs page (Figure 10-7). 

 
• Figure 10-7 EziView Online Variables Mk6 Genius Pulsing Outputs page. 

All outputs are listed, along with their mode.  For Fixed Output and Fixed Output 
Persistent modes the State column shows their current output state.  For Pulsed mode 
the Pulses column gives the number of pulses queued for transmission.  Clicking on an 
output of one of these types allows it to be changed in the window at the bottom of the 
page.  For Pulsed mode entering a number and clicking Set adds that number to the 
number of pulsed to be transmitted.  Note that for a Mk6E Meter, the Online Variables 
page shows LED1 and Output1 and LED2 and Output2 as the same physical output as 
explained previously. (see Figure 10-8) 

 

• Figure 10-8 EziView Online Variables Mk6E Pulsing Outputs page. 
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Chapter 11 Pulsing Inputs 
Up to six pulsing inputs may be fitted to the meter, depending on the supplied options.  
Pulsing inputs allow the meter to count pulses from other devices such as energy, water 
or gas meters.  They may also be used to synchronise the time with other units, allow the 
remote reading of other equipment’s status, or used to gate energy for accuracy tests.  In 
conjunction with EziScript extensions they may be used for specialised tasks such as 
external control of tariff rates.  

Physical Input Types 
Pulsing inputs are an input into the meter which may accept either a series of pulses at 
up to 10Hz, or a steady state input.  Inputs accept both 50Hz and DC voltages and are 
insensitive to polarity.  The inputs are volt free – an external voltage source is needed to 
operate them. 

As with the Pulsing Outputs, the Mk6 Genius and the Mk6E have slightly different 
hardware options. 

EDMI Mk6 Genius Meter 

The Mk6 Genius Meter supports up to 6 inputs (Figure 11-1). 
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• Figure 11-1 Mk6 Genius Terminal block diagram. 



  

   

TB2, TB3, and TB6 to TB9 may be inputs, depending on the exact meter type.  These 
correspond to inputs 1 to 6.  TB3 is shared with output 1, so, depending on the meter’s 
configuration, the terminal may be an input or an output.  Refer to the terminal cover or 
order code for details. 

EDMI Mk6E Meter 

Figure 11-2 shows the terminal block for the Mk6E Meter.  TB2 houses the two inputs 
with common terminal for the Mk6E. 
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TB 2 TB 3 TB 4 TB 5 TB 7 TB 8

TB 10 TB 11
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• Figure 11-2 Terminal block diagram. 

The following table shows the individual terminal connections for the Mk6E’s inputs. 

Terminal Description 
TB2-1 Common Terminal (#1 and #2) 

TB2-2 Input #1 (LED #1) 

TB2-3 Input #2 (LED #2) 

• Table 11-1 Mk6E Standard Output Terminals 
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Configuration 
There are several uses of the meter’s pulsing inputs.  This section explains how to set up 
the inputs via EziView’s PulsingInputs setup page (Figure 11-3).  

 
• Figure 11-3 EziView PulsingInputs setup page. 

The PuslingInputs setup page lists all the meters inputs.  If an input is not listed on this 
page or is listed when it is not fitted, use the Add and Delete buttons to update the list of 
fitted inputs.  All inputs have the same properties, ignoring any electrical differences 
between the input circuits.  Each input has a mode setting that determines how it may be 
used.   

Mode Description 
Unused The input is fitted, but is unused. 
Pulsing This is used where the number of pulses that occur is the important 

information.  The input is sampled at a rate of 40Hz.  A change of 
state from inactive to active causes a pulse to be measured.  As such 
the maximum detectable pulse rate is just under 20Hz, but this is 
derated to 10Hz to allow for the 50Hz filters on the inputs. 

SteadyState This is used for inputs where the state of the input is important, not 
whether it is pulsing. 

• Table 11-2 Pulsing input modes. 

On the Mk6 Genius Meter, the physical hardware of the meter means that Input 2 and 
Output 1 share the same connector.  Which one is fitted to the meter is a factory option.  
At least one of Input 2 or Output 1 should always be set to Not Fitted. 
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There are a number of other options available for each input, listed briefly in Table 11-3. 

Field Description 
Mode Explained above in Table 11-2. 
Type This is a simple flag that may be set as a reminder of the input 

source.  It has no effect on readings. 
Invert If true then the sense of the input is inverted so a loss of voltage on 

the input is taken as activation. 
Parameter This is a multiplier that is used to convert the number of pulses to 

real quantities.  For example it may be set to the energy per pulse to 
give TOU accumulations in energy instead of pulses. 

Description This is a description of the input, kept locally by EziView. 
• Table 11-3 Pulsing input field descriptions. 

Information about the status of the inputs can be obtained from the EziView Online 
Variables → PulsingInputs page (Figure 11-4). 

 
• Figure 11-4 EziView Online Variables PulsingInputs status page. 

State gives the current state of each input.  On means active - if the input is set to be 
inverting then On actually means no voltage is applied to the input. 

Unscaled gives the number of pulses accumulated in the last second.  This is only 
calculated for Pulsing mode inputs.  The Scaled column gives the same information, but 
scaled by each input’s multiplier factor. 

The various uses for the inputs are covered below. 

Pulsing Inputs from other Meters 

The meter can count pulses that are supplied from another meter.  Other chapters such 
as Chapter 13 on Time of Use give information on how to accumulate the pulses over 
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time.  The pulsing input system simply calculates the number of pulses over the last 
second and leaves other systems to log the results. 

 
• Figure 11-5 EziView PulsingInputs setup page, pulsing inputs. 

To set up a pulsing input: 

1. Set the mode to pulsing. 

2. Set the type as a reminder to what is being logged. 

3. If the input source produces a pulse by applying a voltage, set Invert to false.  If the 
input source produces a pulse by dropping out a normally applied voltage, set Invert 
to true. 

4. Set Parameter to the quantity per pulse of the input, such as Wh/pulse. 

5. Add a description as a note to what the input is connected to. 

Now the input may be used as a source for other systems of the meter.  
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Time Synchronisation Inputs 

The meter can accept a regular synchronising time pulse from a time source.  Chapter 12 
has information on setting up the period and use of the pulse.  This section covers how 
to set up the input so that it will work in conjunction. 

 
• Figure 11-6 EziView PulsingInputs setup page, time synchronisation. 

To set up the input: 

1. Set the mode to pulsing. 

2. Ignore the Type setting. 

3. If the input source produces a pulse by applying a voltage, set Invert to false.  If the 
input source produces a pulse by dropping out a normally applied voltage, set Invert 
to true. 

4. Parameter has no effect.  

5. Add a description as a note to what the input is connected to. 

Now the input may be used as a time pulse source.  Note the input number so that the 
correct number is used in setting up the rest of the time synchronisation.  The TimeSetup 
page must be used to complete the setup. 
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Input Status Reading 

The simplest use for an input is to view the status of a steady state input.  Set up the 
input with a mode of SteadyState and give it a description.  The state of the input can 
then be read from the Online Variables → PulsingInputs status page (Figure 11-4 
above).   

 

Inputs for Testing Gate Control 

See Chapter 22 for information on testing the meter’s accuracy using gated readings. 

Using Inputs with EziScript Extensions 

Refer to the documentation on the EziScript extension on how to set up the meter to 
work with the extension.  
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Chapter 12 Date and Time 
Time is a fundamental quantity.  The management of time is extremely important, 
especially in how time changes are handled.  For example, having two 2pms in the one 
day is not physically possible, but is possible for the meter to experience when a time 
change occurs. 

Consequences of Changing the Time 
Changing the time may affect the Time of Use system and EziScript extensions - 
especially fixed interval surveys.  See the section “The Effect of Time Changes” in 
Chapter 17 for more information on the effects to EziScript extensions.  For information 
on time changes with regards to Time of Use, see Chapter 13. 

Changing the Time 

Time and date information from the meter is accessible from the Screens → Online 
Variables → Date Time dialog in EziView (Figure 12-1). 

 
• Figure 12-1 EziView Date and Time page. 



  

   

The top panel displays the time on your computer (PC) and the time read from the 
meter.  To set the time on the meter to the same as the computer click the Set Meter 
button. 

Changing the time may have an effect on stored data.  Make sure you understand the 
possible consequences before changing the clock by large amounts. 
 

The time displayed is daylight saving time.  As such, the computer time should be set to 
daylight saving time – not standard time. 

Note that EziView checks the time difference between the meter and the computer when 
transferring setup with the meter.  If the time difference is too large, it will ask if it 
should synchronise the time.  See Chapter 6 for more information. 

Year 2000 Issues 
The meter is fully year 2000 compliant.  It uses two-digit year, with a defined pivot date 
of 96.  Years from 96 to 99 are treated as 1996 to 1999.  Years from 00 to 95 are treated 
as 2000 to 2095.  The year 2000 is treated as a leap year.  The meter keeps time 
internally as the number of seconds since the start of 1996, using 32-bit numbers to 
ensure operation beyond 2050.   

Timing Source 
The reference for timekeeping may come from one of two sources.  The first is an 
internal crystal clock.  This clock is also maintained during loss of power by the meter’s 
battery.   

The second time source synchronises the time to the system frequency of the measured 
voltages and currents, any phase.  Many generation authorities adjust the system 
frequency slightly over the course of the day to ensure that clocks based on the system 
frequency read correctly in the long term.  There may be some short-term variations that 
will depend on the generation authority. 

The meter may be set to operate only on the internal crystal clock (called Internal 
operation), or to operate in the system frequency (called Line operation).  In Line mode 
the clock will revert to Internal operation if there is no signal to extract the system 
frequency from. 
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• Figure 12-2 EziView Date and Time Setup page.  

The time source is configured via EziViews TimeSetup page (Figure 12-2).  Set the 
Time Source field to the required mode of operation.  The System Frequency field 
allows the base system frequency to be specified.  At this time 50Hz and 60 Hz are 
supported. 

Synchronisation from an External Source 

The meter has the ability to synchronise the clock to a time pulse input via any one of 
the meter’s pulsing inputs.  The meter is programmed with the expected interval 
between pulses (e.g. ½ hour). When a pulse occurs the meter’s time is changed to the 
closest boundary of the expected interval (e.g. to the nearest ½ hour). 

To minimise the disruption that changing the time causes, the meter will slide the time 
for small errors.  If the time change required is within 30 seconds, the meter will run the 
clock fast or slow (by up to 10%) as appropriate to correct the time.  If time pulses stop, 
the meter continues as if time pulses were not enabled. 

To configure external synchronisation: 

1. Configure the pulsing input with a Mode of Pulsing, and set Invert as appropriate 
(sync occurs on the leading edge) via the PulsingInputs page.  See Chapter 11 for 
more information on pulsing input configuration. 

2. Go to the TimeSetup page in EziView (See Figure 12-2) 

3. Set the time interval for the syncronising pulse.  If the required interval is not 
available, use a submultiple. 
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4. Select the input channel that was configured in step 1. 

To disable external synchronisation: 

1. Go to the TimeSetup page in EziView (See Figure 12-2) 

2. Set the time interval to -Disable-. 

The input MUST be set to Pulsing mode for time synchronisation to work. 
 

Generating an External Synchronising Pulse 

See Chapter 10 for information on generating a pulse that may be used to synchronise 
the time of other devices. 

Loss of Power 

If no battery is fitted or it is discharged the meter will use the time that the meter 
powered off, or if that is not available then it reverts to 1/1/1996.  A Clock alarm will 
also be raised.  Restarting with the “power off” time reduces the possible ‘loss’ of data 
that changing the time could cause. 

Daylight Saving 
The meter fully supports daylight saving.  Figure 12-3 shows the setup page. 

 
• Figure 12-3 EziView Date and Time Setup page – Daylight Savings.  

12-4  EDMI Genius/Mk6E User Manual 



 

  Daylight Saving 

Check the Enable Daylight Savings box to enable the other settings.  When unchecked 
the start date and end date are set to be the same which disables daylight saving. 

DLS Start Hour: This is the hour during the day when daylight savings will become 
active on the specified date. This is always specified as Standard Time. (Default is 2am) 

DLS Start Day: This is the day on which daylight savings will begin. Sunday is 0 
through to 6 which is Saturday. In most cases this will be Sunday. (Default is Sunday) 

DLS Start Date: The date on which daylight savings will begin. This is written to the 
meter with a year but the year is always ignored. The exact date on which daylight 
savings will occur will be the day (DLS Start Day) on or after the set date. Reading this 
register will always return the set date rather than the actual date on which the change 
will occur for the year. (Default is 01/01) 

The DLS End Hour (Default is 1am), the DLS End Day (Default is Sunday) and the 
DLS End Date (Default is 01/01) work identically to the DLS Start times. The DLS End 
Hour is set to the Standard time at which time should revert back from Summer Time. 

Example  

To set the start time to be 2 a.m. (Standard Time) on the first Sunday in February: 
 Start Hour = 2, Start Day = 0, Start Date = 01/02/xx 

 To set the end time to be 2 a.m. (Summer Time) on the last Sunday in October: 
  End Hour  = 1, End Day  = 0, End Date = 25/10/xx 

Note that if the begin and end dates are the same daylight saving will be deactivated.  

The Hours To Jump setting specifies in whole hours, the number of hours to jump 
forward on the Start Date and the number of hours to jump back on the End Day. 

Register 0xF061 reports the system time after any daylight savings corrections have 
been added. Both internal and external datatypes are supported. The register cannot be 
written. The meter time can only be set to Standard Time through the normal registers. 

How DLS affects meter operation 

1) The actual time change will occur as follows in Table 12-1 for the previous example 
of start/end times in 1999 using a jump of one hour: 

Time Time Mode 
01:59:58  07/02/99 Standard 
01:59:59  07/02/99 Standard 
03:00:00  07/02/99 Summer Started 
03:00:01  07/02/99 Summer 
… Summer 
01:59:58  31/10/99 Summer 
01:59:59  31/10/99 Summer 
01:00:00  31/10/99 Standard Started 
01:00:01  31/10/99 Standard 

• Table 12-1 DLS example 1. 
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2) EziScript Surveys of any description will always use Standard Time for the date 
stamp. If daylight savings is active when an entry is made, the daylight saving flag will 
be set in the status word for that entry. 

3) Time dependent settings (Billing Resets, Rates and Seasons) will run as normal off 
Standard Time if the daylight saving box is not checked. If the daylight saving box is 
checked in their settings, the setting will run off Summer Time if daylight saving is 
active and Standard Time if it is inactive. 

4) Time based events (particularly Billing Resets and script based time events) will not 
be activated on the start date if they are set to occur in the period over which the time 
jumps. In the example, a Billing Reset set to occur at 2:30:00 07/02/99 (Standard Time) 
will not occur since there is no actual 2:30 on that day. Similarly, a Billing Reset set to 
occur at 1:30:00 31/10/99 (Summer Time) will occur twice, since there are two 
instances where the time is 1:30. However, in the case that the event is set to occur on 
Standard time it will only occur once - there is only one 1:30 (Standard Time). 

For these reasons it is suggested that any time based events should be set to occur during 
the periods when a time change does not occur due to daylight saving starting or ending. 

5) Time range based settings (Rates and Seasons) will work correctly. However if a 
range begins during the period in which time is changed back, the results may seem odd. 
In the case of a Season or a Rate beginning at 1:30:00 31/10/99 (Summer Time) the 
following would result (Table 12-2). 

DLS Active? Time Active Rate 
D 01:29:59  31/10/99 Rate 1 
D 01:30:00  31/10/99 Rate 2 
D 01:30:01  31/10/99 Rate 2 
D … Rate 2 
D 01:59:59  31/10/99 Rate 2 

Ending 01:00:00  31/10/99 Rate 1 
 01:00:01  31/10/99 Rate 1 
 … Rate 1 
 01:29:59  31/10/99 Rate 1 
 01:30:00  31/10/99 Rate 2 
 01:30:01  31/10/99 Rate 2 

• Table 12-2 DLS example 2. 

This is correct since there are two 1:30 time instances on 31/10/99.   

6) The display of time on the default LCD display includes daylight saving.  To display 
standard time on the LCD use register F03D.  Register F061 gives daylight saving time, 
but cannot be written.  All time settings to the meter are done using standard time to 
avoid ambiguous times.  EziView converts daylight saving time to standard time when 
writing the time to the meter. 

A ‘D’ is shown on the default LCD display just to the left of the time if daylight savings 
is active. 
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Time Statistics 
The meter maintains a set of statistics about when it was operating.  These can be useful 
in fault and outage tracking, and in tamper detection. The Screens → Online Variables 
→ Date Time dialog in EziView displays this information (see Figure 12-1). 

The Power On/Off panel gives accumulated power on and power off times since they 
were last cleared.  To clear the on and off times click the top Clear button.  The number 
of power ups is also shown.  To clear this click the bottom Clear button. 

The Last Power On/Off panel gives statistics about when and how long ago that power 
was last applied.  It also gives the time and duration of the last power outage. 
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Chapter 13 Time of Use 
The Time of Use system (TOU) is used when there is a need to measure usage patterns 
without going to the detail of load survey type recordings.  The aim of the TOU system 
is to produce directly from the meter the type of tariff information that is generally 
extracted from a load survey.  This reduces the amount of information that must be 
transferred from the meter, and makes the information more easily accessible to the 
customer on site. 

Some of the key features of the TOU system are: 

• Up to 12 channels of TOU. 

• Channel data can be from the meter’s own measurements, or pulses from external 
sources.  Example sources are Imported Wh, Export varh or Input #1 pulses. 

• Each channel records the accumulated energy, as well as the maximum demand of 
energy and the time of maximum demand of energy. 

• Maximum demand may be rolling up to 15 sub intervals. 

• Each channel records this information in up to eight rates, each rate being a time 
period over which the information was recorded.  There is also a unified rate that 
behaves as if it was always active. 

• The occurrence of a billing reset causes the contents of all current channels to be 
copied into a set of previous channels.  This data is also added to a set of total 
registers.  After this processing the current set of channels is cleared to zero. 

• Each channel belongs to one of 5 rate groups (W, VAR, VA, EX1, and EX2).   

• There are 5 active rates (one for each of the 5 rate groups), each being independently 
programmable using the scheduler.   

• Scheduler time specifications may repeat hourly, daily, weekly, monthly, yearly and 
never, or repeat at a user defined interval.  Specifications with a longer repeat rate 
have priority over others. 



  

   

• Demand time periods are also programmed via the scheduler, as are automatic 
billing resets.  Billing resets may also be initiated by a push button on the meter, or 
by a communications command.   

• Billing resets may be locked out for a defined period to stop repeated triggering. 

• Manual Billing Resets may be initiated using the sealable billing reset button. 

• Support for up to seven seasons. 

A running example is used throughout this chapter which is built upon as new concepts 
are covered.  It is important to read the examples as some information is covered only 
there. 

Overview 
This section covers the fundamentals and terminology of the TOU system.  The 
following diagram is used throughout and illustrates the overall structure of the TOU 
system (Figure 13-1). 

 Total      
 Billing Total       
 Previous        
Current Channel 1 Channel 2 Channel 3 … Channel 12    
Rate 1 Accumulation 

Max. Demand 
Time of Max. 

       

Rate 2         
Rate 3         
…         
Rate 8         
Unified 
Rate 

        

• Figure 13-1 TOU overview, cell.  

Each cell in the structure consists of three registers: 

• An accumulation register (64 bit).  This accumulates consumption data. 

• A maximum demand register (32 bit for current and previous, 64 bit for total and 
billing total).  This stores the maximum demand, covered in more detail later. 

• A time of maximum demand register (32 bit, 1-second resolution).  The current time 
is stored here when a new maximum demand occurs. 
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TOU Channels 

 Total      
 Billing Total      
 Previous       
Current Channel 1 Channel 2 Channel 3 … Channel 12   
Rate 1 Accumulation 

Max. Demand 
Time of Max. 

      

Rate 2        
Rate 3        
…        
Rate 8         
Unified 
Rate 

        

• Figure 13-2 TOU overview, channels.  

Information about a particular quantity is recorded in a TOU channel.  The meter has 12 
TOU channels available, each being largely independent of the others.  One TOU 
channel may record information on kWh consumption, while another is used for kvarh 
consumption. Figure 13-2 illustrates how channels fit in to the system. 

Rates 

 Total      
 Billing Total      
 Previous       
Current Channel 1 Channel 2 Channel 3 … Channel 12   
Rate 1 Accumulation 

Max. Demand 
Time of Max. 

      

Rate 2        
Rate 3        
…        
Rate 8         
Unified 
Rate 

        

• Figure 13-3 TOU overview, rates.  

Rates allow energy used at different times to be treated differently, generally in terms of 
the cost to the customer.  Up to eight rates are available, determined by the feature code.  
Figure 13-3 illustrates how rates fit in to the system. 

The active rate of a channel is where new data is recorded - it specifies which cell is 
active out of the eight.  The unified rate gives readings as if there was only ever a single 
rate active - i.e. it is the sum of the accumulation registers, the maximum of the 
maximum demand registers, and the time of the maximum of the maximum demand 
registers.  
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• Figure 13-4 TOU overview, rate groups example.  

There are situations where one active rate for all channels is not enough, e.g. a pulsing 
input from a gas meter that is subject to different timings to energy readings.  To cover 
this, the meter has 5 independent rate groups. 

At any one time one rate is active in each of the 5 rate groups.  The rate groups are 
called ‘W’, ‘var’, ‘VA’, ‘EX1’, and ‘EX2’.  The names do suggest uses for them, but 
any rate group can be used for any purpose.  The active rates for the first 3 rate groups 
are displayed on the default LCD screen.  

The active rate that affects a channel is determined from the TOU channel’s rate group.  
Each TOU channel belongs to a rate group for accumulated energy, and a rate group for 
maximum demand (they may be different). 

In the example of Figure 13-4 the 5 rate groups are shown down the side, with times of 
the day along the top.  Different colours in the grid represent different active rate 
numbers.  Rate group VA has the same active rate all day, while rate group EX1 has 
three different active rates during the day. 

The active rate in each group may be controlled by the scheduler, or from a manual 
override. 
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Billing Resets 

 Total       
 Billing Total       
 Previous        
Current Channel 1 Channel 2 Channel 3 … Channel 12   
Rate 1 Accumulation 

Max. Demand 
Time of Max. 

      

Rate 2        
Rate 3        
…        
Rate 8         
Unified 
Rate 

        

• Figure 13-5 TOU overview, billing resets.  

The current registers are where TOU information is currently being accumulated.  
When a billing reset occurs, these registers are copied into the previous registers 
(identical) and the current registers are cleared.  All TOU channels are reset at once.  As 
well as this, the accumulation registers are added to the billing total accumulation 
registers, and the maximum demand registers are added to the billing total maximum 
demand registers.  There are no billing total time of maximum demand registers as they 
have no meaning. 

The total registers are a sum of the billing total registers and the current registers 
following the same rules. 

Billing resets may be caused by: 

• Pressing the billing reset button on the front of the meter. 

• Initiating a billing reset from a communications session. 

• Being automatically generated by the scheduler. 

A billing reset lockout period may also be specified.  Two billing resets may not occur 
within this time of each other.  If an attempt is made, the second billing reset will be 
ignored. 

The ability to perform a billing reset is controlled by a feature code.  Your meter may 
not have this code. 

To extend the number of previous readings stored, an EziScript survey may be used.  
See Chapter 19, Billing History Tool on page 19-5 for more information.  

Overflows 

The reason for the large number of bits in the registers is to totally eliminate the 
possibility of overflow within the lifetime of the meter, and to provide high resolution 
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results.  For energy quantities the data is stored as a number of micropulses.  
Micropulses are an internal pulse value used for measured energy, and should be scaled 
to a primary or secondary quantity.  There is approximately 1 micropulse per 0.000001 
kWh (for a 5A meter).  This means that even under very low input conditions a 
significant number of pulses are recorded.  For example, at 63.5V, 0.05A on a single 
phase, around 800 pulses are still recorded for a 15 minute period, ensuring that the 
meter’s accuracy is not lost though an inadequate number of pulses.   

At the other end of the scale, even at full load the registers will not overflow.  The 
maximum demand registers (which never record energy for more than an hour) would 
take almost 6 days to overflow.  The energy accumulation registers will take more than 
70 million years to overflow at full load.  Even a billing reset every minute would mean 
the cumulative maximum demand registers would not overflow for well over 1 million 
years. 

Gated energy tests are performed at an even higher internal pulse rate to ensure 
maximum accuracy, at a rate of over a hundred thousand times faster. 

Maximum Demands 

In support of the maximum demand registers are the rising demand registers.  These are 
the registers that accumulate energy over the demand period, generally from 1 minute to 
60 minutes.  The demand for the period is simply the accumulated energy divided by the 
fraction of an hour that the demand period is.  Each TOU channel has its own set of 15 
rising demand registers.  The reason there are fifteen is to allow for rolling demand 
schemes.  For example, there might be three 15-minute demands, but they start with 
offsets from the hour of 0, 5 and 10 minutes.  An offset of 5 minutes results in resets at 
times of 0:05, 0:20, 0:35, and 0:50.   

When a demand period ends, the demand is compared with the channel’s active 
maximum demand register.  If it is larger, the new maximum demand is written to the 
maximum demand register and the time of maximum demand is updated to the current 
time. 

The maximum demand feature is optional and is enabled by a feature code. 
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• Figure 13-6 Demand example.  

In this example (Figure 13-6), the power trace on the graph shows the power that the 
meter is measuring at that time.  The three demand traces show how 3 rising demand 
registers behave.  They are all 15-minute demands on 5-minute windows. The demands 
shown are the rising demands, computed from the energy accumulated over the 15 
minute period multiplied by 4 (60 / 15 = 4) to convert Wh to W.  The value rises until at 
the end of the 15 minutes it is equal to the average power over the 15 minutes. 

The first maximum occurs at 0:15, then at 0:20, 0:25, and 0:30.  After this no new 
maximums occur. 

Seasons 

The meter allows up to seven seasons to be defined.  Only one season is active at any 
one time, although it is possible for no seasons to be active.  Each entry in the scheduler 
may optionally be set to only be active when a certain season is active.  This allows for 
different schemes in summer and winter, or even as a way to change tariff schemes on a 
certain day. 

Care must be taken with using seasons with single time scheduler events like billing 
resets.  If the meter is turned off or the time is changed, the season which is used to look 
for a skipped over event such as a billing reset is that which is active at the beginning of 
the period.  As such it is recommended that seasons only be used for range type 
scheduler events like rates, not for single time events like billing resets. 

The Scheduler/Calender 

This is the system within the meter to determine when things happen.  This system is 
used to automatically control the active rates, billing resets, demand resets, and seasons, 
as well as several other sections of the meter. 
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The calender is made up of a number of entries.  Each entry defines either a single time 
(billing resets and demand resets) or a time range (rates and seasons), and what happens 
if the entry occurs.  Entries are also qualified by a season - entries from an inactive 
season are ignored.  If no season is specified then the entry is not affected by season. 

There are several ways to specify a time, based on how often it repeats.  The times are 
specified in minutes past a reference point.  The table below shows the options (Table 
13-1).  The size columns give the size of an entry of this type in bytes. 

Time Type Description Event 
Size 

Range 
Size 

Hourly Minutes since the start of the hour. 6 8 
Daily Minutes since the start of the day. 6 8 
Weekly Minutes since the start of the week. 6 8 
Monthly Minutes since the start of the month. 6 8 
R. Monthly Minutes from the end of the month, back towards the 

beginning of the month.  (Reverse Monthly) 
6 8 

Yearly Minutes since the start of the year, assuming February 
has 28 days. 

8 12 

Special Day Days since the start of 1996.  1 day range assumed. 
Firmware v1.55 and later. 

6 6 

Special Minutes since the start of 1996. 8 12 
Rate 1st argument: Minutes between operations. 

2nd argument: Minutes offset. 
12 20 

• Table 13-1 Time specification options. 

If two single time entries occur in the same minute to generate the same event (e.g. a 
billing reset), the event will still occur only once.  If power is switched off or a time 
change occurs, the intervening time is searched for events that would have occurred 
during the period.  At most only one of the same event will be generated by this method. 

Time range entries are specified in a similar manner, except that two times are given - 
the start time and the end time.  If the start time is after the end time, the range extends 
over the boundaries.  For example, starting at 20:00 on a daily time type and going to 
7:00 would result in a range that extends through midnight, but excludes the period 7:00 
to 20:00 during the day. 

When time range entries for the same event overlap (e.g. active rate) there is a defined 
precedence.  Time types lower down in Table 13-1 (i.e. those with longer repeat rates) 
override types higher up the table, e.g. Yearly overrides Daily.  For time types with the 
same type, those higher up in the scheduler table will override those lower down.   

The Memory Available bar at the bottom of the scheduler setup pages indicates how 
much memory is left in the meter for entries.  Note that the BillingReset, Demand, Rates 
and Season pages all share the same block of memory.  The meter has 1600 bytes of 
memory allocated for the scheduler.  This gives up to 266 of the smallest entries, but in 
practice there will be a mix of types so this figure will be less. 
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Setup via EziView 
The TOU system is configured from EziView.  The order of the following sections is a 
suggested order of operations.  The preceding overview section should be read before 
this section. 

Channel setup 

Information about a particular quantity is recorded in a TOU channel by the meter.  The 
meter has 12 TOU channels available, each being largely independent of the others.  
The TOUSetup page (Figure 13-7) in EziView allows the content of each channel to be 
defined.  This should generally be done as the first part of setting up the TOU system. 

 
• Figure 13-7 EziView TOUSetup page.  

Each line 1 to 12 of the table is the setup for a channel.  The setup for each channel is as 
follows: 

Register 

This field gives the source of the channel as a source of ‘pulses’.  Every second the 
register listed in this field is read to retrieve the number of pulses that occurred during 
the last second. 

The convention for energy directions is as shown in Figure 2-16. 

Four quadrant measurement is an option requiring a feature code to activate it.  Without 
the feature code only quadrants 1 and 4 are available.  Var, varh, VA and VAh readings 
are also an option requiring a feature code. 
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Double clicking on the register field brings up a list of useful source registers. Selecting 
OK will insert the selected register into the field. To find out what a register is, double 
clicking the register field will bring up the register selection form for the register.  
Alternatively, a register may simply be typed into the register field.  Any register may 
be used if it is of type L, I or C.  Other types may lead to an extremely large (and 
incorrect) number of pulses being recorded.  If the Nothing register (0000FFFF) is 
specified the channel is deactivated. 

In the following example Total Export Wh has been selected (Figure 13-8). 

 
• Figure 13-8 Register selection, Total Export Wh.  

The Energy group (Figure 13-8) allows the selection of energy quantities based on 
import/export direction.  They are in micropulses.  

 
• Figure 13-9 Register selection, Total quadrant 1 Wh.  
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The Quadrant group (Figure 13-9) allows energies to be selected on an individual 
quadrant basis.  They are in micropulses.  The quadrants are as labelled in Figure 2-16, 
on page 2-20. 

 
• Figure 13-10 Register selection, Pulsing Input 1.  

The pulsing inputs group (Figure 13-10) allows pulsing inputs to be selected as a source.  
The values read are the number of pulses on the indicated input.  The input must be set 
up appropriately as a pulsing input. 

Acc. Type (Accumulated Type) 

This puts the channel into one of five groups for accumulated energy calculations.  The 
groups are ‘W’, ‘var’, ‘VA’, ‘EX1’, and ‘EX2’.  The usage of the groups doesn’t need 
to follow what is suggested by the names - all groups have the same functionality.  The 
usage of groups will become clearer when rates and demand times are described later in 
this chapter. 

Acc. Unit (Accumulated Unit) 

This selects the unit that will be displayed after the value on LCD displays.  It should 
generally be Wh, varh, or VAh as appropriate to the quantity being measured, or No Unit 
where none is appropriate (Pulses from a gas meter for example). 

Dem. Type (Demand Type) 

This puts the channel into one of five groups for demand calculations.  The groups are 
as for Acc. Type. 

Dem. Unit (Demand Unit) 

This selects the unit that will be displayed after the value on LCD displays.  It should 
generally be W, var, or VA as appropriate to the quantity being measured, or No Unit 
where none is appropriate (Pulses from a gas meter for example). 
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Scale 

This is how the pulses are scaled to real world quantities.  When displayed or read out 
anywhere, the pulse values from the TOU system are scaled by the indicated factor. 
Table 13-2  

Option Description 
1:1 No scaling is done.  This is generally not used, but may be useful for 

pulsing inputs if the unscaled value is required. 
Primary This is for scaling micropulses into primary quantities – the external 

transformer ratios are used.   
Secondary This is for scaling micropulses into secondary quantities – the external 

transformer ratios are not used. 
Pul Inp x This is for scaling pulses from a pulsing input by the scaling factor per 

pulse specified in the pulsing input setup.  The x specifies which input’s 
scaling factor to use. 

Factor x This uses one of the custom scaling factors from the table at the bottom 
right of the form.  This may be useful if the source of pulses to the TOU 
channel is not from one of the standard sources and needs to be treated 
differently. 

• Table 13-2 Scaling factors. 

Description 

This field allows an up to 10 letter description to be added to the channel.  This is the 
column heading that is displayed in the EziView TOU display table. 

User Level 

When a register is read by the TOU system, this is the user level that is used to read it.  
If the indicated user level does not have security access to the indicated register, the 
register will not be read and no pulses will be added to the channel. 

Example 

Suppose the meter needs to record import and export Wh and varh.  Pulses from pulsing 
input 1 also need to be recorded.  The read outs need to be in primary, real world 
quantities.  There is a requirement to keep the active rate for Wh, varh, and pulses 
independent, but no need to differentiate between accumulated and demand rates.  The 
Default_1 group has access to all of the registers required. 
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The configuration is shown in Figure 13-11. 

 
• Figure 13-11 Channel Example.  

Once this setup is loaded into the meter, it will start to record the indicated quantities.  
As no rates have been set up, all energy will record into the first rate. 

To see the effect of this setup use the EziView Screens → Time Of Use online display 
(Figure 13-12).  This display updates in real time as new energy is accumulated.  Five 
columns of figures are shown, one for each of the TOU channels.  The column titles 
come from the descriptions entered into the channel configuration. 

Only the first rate and the unified rate show any accumulated energy.  This is because at 
present the first rate is active by default because the rate scheduler is not configured.  
The rate scheduler is explained later in this chapter. 
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• Figure 13-12 Channel Example, TOU status.  

The columns may be re-sized using the mouse at the top of the column break.  The 
minimum column width to display may be configured on the Setup page. 

More details on the use of this screen are explained over the following sections. 
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Rates 

The Tariff Rates page (Figure 13-13) of EziView allows automatic rate changes to be 
scheduled. 

 
• Figure 13-13 EziView Tariff Rates page.  

Each line of the table specifies a range of time over which the specified rate should be 
active for the specified rate groups.  The scheduler in the meter resolves the priorities of 
the entries to give an active rate for each rate group.  The meaning of each column is 
listed briefly in Table 13-3 below. 

Column Description 
Type This is the type of entry, which gives the span of time it repeats over.  

Table 13-1 has a full list. 
Start This is the start of the time range. 
End This is the end of the time range. 
D Check this box if the Start and End times are in daylight saving time. 
Rate Select the Rate that this entry is to change to. 
Season Selecting a season means that the entry will be ignored unless that 

season is active. 
W Check to allow this entry to affect the W rate group. 
Var Check to allow this entry to affect the var rate group. 
VA Check to allow this entry to affect the VA rate group. 
EX1 Check to allow this entry to affect the EX1 rate group. 
EX2 Check to allow this entry to affect the EX2 rate group. 

• Table 13-3 EziView rate setup columns. 

The best way to explain how to use the system is with an example: 
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Suppose the following tariff was in place (Table 13-4): 

Time Rate 
0:00 to 7:00 Off Peak 
7:00 to 10:00 Peak 
10:00 to 17:00 Daytime 
17:00 to 21:00  Peak 
21:00 to 24:00 Off Peak 
Weekends:   
21:00 Friday to 7:00 Monday 

Off Peak 

• Table 13-4 Example tariff times. 

There are 3 rates in this tariff structure, each being charged at a different amount per 
Wh.  To separate this usage different rates in the meter are used for each tariff rate.  For 
this example the following assignment is used (Table 13-5): 

Rate Rate Number 
Off Peak 1 
Peak 2 
Daytime 3 

• Table 13-5 Example tariff rate allocations. 

It is best to use rate 1 for the most common rate.  Rate 1 is the default rate, and as such 
does not need any scheduler entries to define it. 

The scheduler commands needed to implement this are (Table 13-6): 

Type Start End Rate Number 
Daily 7:00 10:00 2 
Daily 10:00 17:00 3 
Daily 17:00 21:00 2 
Weekly 21:00 Fri 7:00 Mon 1 

• Table 13-6 Example scheduler commands. 

The first three lines are self-explanatory.  They define a daily schedule of changes.  The 
last entry overrides the daily entries to enforce off peak on a weekend.  This could be 
simplified even further by using the fact that entries higher up in the table override those 
lower down of the same type if they overlap.  In the following table (Table 13-7) the top 
entry will override the second entry during the middle of the day.  While this requires 
fewer entries, it is more cryptic than the earlier version (Table 13-6). 

Type Start End Rate Number 
Daily 10:00 17:00 3 
Daily 7:00 21:00 2 
Weekly 21:00 Fri 7:00 Mon 1 

• Table 13-7 Example alternative scheduler commands. 

We will use rate group W for the channels to be controlled by this tariff.  No seasons are 
used, and all times are standard time, not daylight saving time. 

13-16  EDMI Genius/Mk6E User Manual 



 

  Setup via EziView 

The EziView Tariff Rates page can now be filled in.  The following is for the first entry: 

1. Select Daily as the type from the drop down list. 

2. Enter the Start time.  This is done by double clicking on the field to bring up the 
Minute Calculator (Figure 13-14).  Earlier (Table 13-1) it was mentioned that the 
times are entered as a number of minutes past the repeat point.  The minute 
calculator lets you ignore that and enter times as hours, minutes, etc.  The field at 
the bottom left shows the time in minutes, while the field at the bottom right shows 
the calculated time.  Using the minutes and hours fields, set the start time to 10:00 
and click OK. 

 
• Figure 13-14 EziView Minute Calculator.  

3. Enter the End Time of 17:00 in the same way as the start time. 

4. The daylight saving column D should be left unchecked. 

5. Select the Rate from the drop down list.  Depending on EziView settings that rate 
will be either as letters A to H, or as numbers 1 to 8.  Select C or 3 as appropriate.  
(See the “Rates” section on page 13-3). 

6. The blank Season from the drop down list should be selected. 

7. Check the W rate group column, but leave the other columns unchecked. 

Fill in the other two entries in a similar fashion and the screen should look as follows 
(although the rate may be listed as numbers) in Figure 13-15: 
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• Figure 13-15 EziView Rates Example completed.  

Note that the Memory Available bar drops slightly in length.  Each entry in the Tariff 
pages uses a small amount of memory.  This is what limits the maximum number of 
entries the meter can be programmed with.  See Table 13-1 and its accompanying text 
for details. 

The rate groups not specifically changed will simply remain in the first rate. 

To delete an entry select the blank option from the type list. 
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Displaying the Status → Time Of Use screen (Figure 13-16) in EziView will now show 
that the energy in the W rate group channels is now being split across the first 3 rates.  
The other channels are not affected because the active rate for their rate group is the first 
rate.  Of course this will only show entries if the meter has been run over the time 
periods. 

 
• Figure 13-16 EziView TOU Status, with rates.  
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The active rates can be displayed using the Screens → Online Variables → Tariff page 
in EziView (Figure 13-17).  The active rate for the first three rate groups can also be 
seen on the default LCD screen, covered in the section LCD/Select Button, page 2-17. 

 
• Figure 13-17 EziView Online Variables Tariff page.  

Maximum Demand 

The Setup → Tariff → Demand page in EziView (Figure 13-18) is used to configure the 
maximum demand system.   

 

• Figure 13-18 EziView Tariff Demand Setup page.  
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Each channel in the meter has a set of 15 rising demand registers that accumulate energy 
continuously.  When the demand schedule indicates that one of these should be reset, 
the demand is calculated (using the rate of the scheduler event) and is compared against 
the channel’s maximum demand.  If the new reading is greater, a new maximum and 
time of maximum is set for the channel.  The demand register is then reset.  

The demand scheduler set up is similar to rate scheduler configuration.  The main 
difference is in the type of time event required.  What is needed to mark the ends of 
demand intervals is a type that resets the rising demand registers when the end of an 
interval is reached.  The type to use is Rate.  No other types can be used for demand. 

EziView has three different modes that can be use to configure the Demand reset points.  
These are described in Table 13-8. 

Demand Mode Description 
None Do not calculate Maximum Demand. (No reset) 
Block This sets a block Maximum Demand calculation for all types of energy 

for the selected Interval.  That means that after each Interval period, the 
first Maximum Demand register for each energy type will be reset to 
zero.  This is the only register used to calculate Maximum Demand. 

Rolling This sets the Maximum Demand calculations to a rolling window type 
calculation.  The section below details this type of calculation. 

Custom Create your own way of calculating Maximum Demand.  This could be 
used for example to use a Rolling Maximum Demand for active energy 
and Block calculations for reactive data. 

• Table 13-8 Maximum Demand Modes. 

Block Demand 

In a simple block demand, the first rising demand register for each type of energy is 
reset every interval period.  So at the end of each period the demand for that interval is 
compared with the Maximum Demand for the channel.  If it is bigger, then it becomes 
the Maximum Demand. 

Rolling Maximum Demand 

The simpliest way to describe a rolling window scheme is by providing a example.  If 
we setup the Demand Interval to be 15 minutes and the Sub-Interval to be 5 minutes, the 
meter will use 3 windows.  This is effectively running three demand calculations at once 
on the same data.  Figure 13-19 illustrates this, showing how the different windows 
overlap.  To achieve this in the meter, three of a channel’s rising demand registers are 
used, configured the same except for different offsets. 
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• Figure 13-19 Demand periods example.  
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By using this rolling window scheme, every 5 minutes the demand over the previous 15 
minutes is compared with the current Maximum Demand.  In a Block calculation, this 
check is only done every 15 minutes.   

Custom Maximum Demand 

The same rolling window setup as described above can be achieved by configuring a 
Custom Demand setup as shown in Figure 13-20 below. 

 
• Figure 13-20 Demand periods example EziView configuration.  

There are three entries listed.  Each has a type of rate, a 15 minute interval, and set to 
affect channels with a demand rate group of W.  The differences are the offsets and the 
period (Per.) settings.  The offsets create the windowed effect, and the periods set each 
one to reset a different one of the channel’s 15 rising demand registers.  If the periods 
were all set to 1, the meter would reset the first rising demand channel every five 
minutes, but would calculate demand based on 15 minutes – not the result required. 

The Time field becomes the demand interval, the time between resetting the demand 
back to zero.  It must always be divisible into an hour evenly (i.e. 60, 30, 20, 15, 12, 
10, 6, 5, 4, 3, 2, or 1 minute).  If it is not the demand calculated will be wrong. 

The Offset field is an offset from start of the interval.  For example, if the Time field is 
set to15 minutes, setting the Offset field to 5 results in resets at times of 0:05, 0:20, 
0:35, and 0:50.  This is used for rolling window demand schemes. 

The daylight saving field should not be used for demands.  The season field could be 
used to implement different maximum demand schemes in different seasons, although 
normally it should be left blank. 
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As with rates, each entry uses up some memory, as shown by the memory available 
bar.  The main issue here is making sure the rates doesn’t use so much memory that 
the other sections don’t have enough.  The number of demand entries will generally be 
minimal in comparison. 

Other settings 

The Forgiveness Time setting allows for a start up period forgiveness time.  If the power 
has been off for some time it generally takes a fair bit of power to start a plant up again.  
This abnormal situation can increase the maximum demand, even if it was caused by a 
loss of power that was not the fault of the plant.   

If the meter has been off for more than the Off Activation Time (in seconds), then when 
power is restored no new maximum demands will be recorded until the Forgiveness 
Time (in seconds) has passed.  It works by preventing new maximum demands from 
being registered, not by stopping the rising demand registers, which still accumulate and 
reset as normal. 

Seeing the changes 

The EziView Screens → Time Of Use screen can also show maximum demand figures.  
Simply tick the boxes for what is to be displayed.  Figure 13-21 below shows some 
readings from the setup so far.  Note that before a maximum demand has been recorded 
the maximum demand will read zero and time will read 1/1/96. 

 
• Figure 13-21 Demand periods EziView Time Of Use status. 
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The demands are set to work off the same rate groups as the accumulated energy 
readings.  Thus they are split into different rates along with the accumulated energy 
readings.  The time of maximum demand is the time at the end of the demand period, 
when the maximum demand was actually recorded. 

Billing Resets 

Billing resets are used to take a reading of the TOU registers.  They may be generated in 
either of three ways: 

• Manually using EziView. 

• Manually using the Billing Reset button on the meter (where fitted).  

• Automatically using the scheduler. 

When a billing reset occurs for any reason, the following message is shown on the LCD 
for several seconds (Figure 13-22), overriding any other display. 

 
• Figure 13-22 Billing Resets LCD screen. 

Details on the ways to perform billing resets follow. 

Manually using EziView 

Use the Screens → Online Variables → Tariff page (Figure 13-23) in EziView to 
perform a remote manual billing reset.  Clicking the Billing Reset button performs the 
reset.   

The date and time of the last and 2nd last billing resets (by any cause) are also displayed 
on this page.  If these resets have never occurred the date 1/1/96 will be shown.  The 
Number Of Billing Resets counter records the total number of billing resets the meter 
has had.  The lockout time figures are discussed later. 

 
• Figure 13-23 Billing Resets via EziView. 
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Manually using the Billing Reset Button 

This is the top push button on the face of the meter.  Pushing the button for more than a 
second initiates a billing reset. 

In order for the billing reset button to work it must be enabled via the meter setup (the 
default condition).  To enable the button, go to the Security setup page (Figure 13-24) 
and uncheck the Billing Reset Button Disable check box. 

 
• Figure 13-24 Enabling the Billing Reset button. 

The billing reset button may be physically sealed using a lead or plastic seal.   

Automatically using the Scheduler 

This method uses the scheduler to perform a reset without intervention.  There are four 
different modes used for Automatic Tariff Billing Resets.  These are described in Table 
13-9. 

Reset Modes Description 
None Do not automatically perform a Billing Reset. 
Beginning of 
Month 

Resets on a selected date and time at the beginning of each month. 

End of Month Resets at a selected number of days before the end of the month at a 
prescribed time. 

Special Create many Billing Resets and any special time you prescribe. 
• Table 13-9 Maximum Demand Modes. 

For the Beginning of Month and End of Month modes, the user must describe the 
following: 
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The Day field determines the day when the Billing Reset takes place.  For the Beginning 
of Month mode, this is selected as the 1st, 2nd, 3rd (up to 28th) day of the month.  For the 
End of Month mode, the Day field can be set to Last Day through to the 28th Last Day 
of the month. 

The Time field determines the time on the day prescribed by the Day field that the reset 
is to occur.  For the Beginning of the Month mode the default time is 00:00:00 or the 
beginning of the day.  For the End of Month mode the default timeis 24:00:00 or the end 
of the day. 

In each of these modes the next Billing Reset date and time are displayed to assist in 
your setup. 

In special mode, the Automatic Tarriff Billing Resets are configured via the Tariff 
BillingReset setup page in EziView (Figure 13-25).   

 
• Figure 13-25 Automatic Billing Resets. 

The most common type of entry used is the monthly. The configuration in Figure 13-25 
will perform a billing reset at the start of every month.  The day and time of the billing 
reset can be specified in the time field. 

Reverse monthly events are useful in situations where the billing reset must occur a 
certain number of days from the end of the month.   

The Offset field is used only for rate type events.  This is used where a reset should 
occur every 60 days for example.  The Time field gives the repeat rate, with the first 
event occurring 1/1/96.  The Offset field allows this start time (and thus all events 
afterward) to be shifted by a fixed amount. 
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Any other event type may be used, but they are not usually.  Multiple events may be 
specified, allowing scenarios such as “Perform a billing reset on the 15th day of every 
month, and on the 1st of January”. 

The daylight saving checkbox causes the event to be calculated on daylight saving time 
instead of standard time.  If this option is used, billing resets should not be scheduled to 
occur during the daylight saving change over period.  During this period times occur 
twice or not at all – affecting the occurrence of billing resets.  If time is changed past the 
change-over period the meter will always trigger just one missed reset.  Avoid these 
confusions by not programming resets during the daylight saving change-over periods 
(e.g. when 2am goes to 3am, or 3am goes to 2am). 

The season field allows specific billing reset events to only occur in the specified 
season, allowing changing of billing reset times automatically during the year.  As with 
other occurrences of this field, setting it to blank disables season control for the entry. 

Billing reset lockout 

Accidentally performing more than one billing reset when reading the meter can cause 
problems with the records of billing data.  To reduce the risk of this the billing reset 
lockout interval may be used.  After a billing reset the meter will prevent any further 
billing resets from occurring until the lockout interval has passed.  Turning off or 
restarting the meter will abort the lockout interval. 

The lockout interval may be set on the Tariff BillingReset page in EziView (Figure 
13-25 above).  The setting is in minutes.  A setting of zero disables this feature. 

The remaining lockout time may be seen on the Screens → Online Variables → Tariff 
page (Figure 13-23) in EziView. 

Viewing 

The Screens → Time Of Use status screen (Figure 13-26) may be used to view the 
effects of a billing reset.   

 
• Figure 13-26 EziView TOU status screen, periods. 
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The Period page allows different periods to be shown – see the earlier section Billing 
Resets on page 13-5 for more information about how the periods roll over.  The radio 
buttons at the top of the screen allow the displayed period to be changed. 

Periods before the most recent previous readings may be stored in a TOU history 
survey.  See Chapter 19, Billing History Tool on page 19-5 for more information on 
this.  

Seasons 

Seasons provide the capability of changing which entries in the scheduler tables are used 
at different times.  They are configured via EziView’s Tariff Season configuration page 
(Figure 13-27). 

 
• Figure 13-27 EziView Season configuration. 

Each entry in the other sections of the scheduler may be controlled by a season.  The 
entry is only used in calculating when that season is active.  There are seven seasons 
available, but only one may be active at any one time.   

Season entries are processed in a similar way to rate entries.  A time range is specified 
along with the season to enable during that time.  The same rules of precedence in the 
case of a conflict apply - types of longer interval have priority, entries towards the top of 
the table have priority.  The blank season setting means that no season is active. 

The example in Figure 13-27 shows a definition for Southern Hemisphere summer and 
winter seasons.  The season names may be changed from the defaults using the table at 
the bottom of the setup page. 
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The daylight saving checkbox allows the entry to be controlled by daylight saving time 
rather than standard time. 

The most obvious use for seasons is to enable different tariff structures at different times 
of the year.  Another use is to use them to define day types.  Different seasons would 
define different day types such as weekday, weekend, holiday etc., configured on the 
rates page.  The season page would then be used to define when those types of day 
occurred.  This could be useful to reduce the complexity of programming some types of 
tariff structures. 

More esoteric uses include changing demand intervals for different days of the week, or 
automatically switch over to a different tariff structure on a certain date. 

The current season may be displayed using the Screens → Online Variables → Tariff 
page in EziView (Figure 13-28).  The current season is shown at the bottom of the list of 
current rates. 

 
• Figure 13-28 EziView Online Variables Tariff page, current season.  
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Clearing the TOU system 
The entire TOU system of the meter may be cleared if required.  To do this, use the 
Reset TOU button on the TOU status screen. 

 
• Figure 13-29 EziView Reset TOU control. 

Resetting the TOU will set all accumulated energy, maximum demand, time of 
maximum demand registers in all rates, channels and periods to zero.  The last billing 
reset times will be cleared, as will any TOU log surveys.  The configuration of the TOU 
system will not be affected.   

This operation would normally only be performed when preparing a meter for 
installation where there were unwanted previous readings stored, perhaps from testing 
or another site.  Use this command with caution.  A good suggestion is to block the use 
of this command without the configuration jumper present – see Chapter 16 for more 
information. 

This command should also be used if the channel configuration has changed, or if 
demand times are reduced or added.  It should also be used if the transformer ratios are 
changed, as the scaling factors will change. 
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Chapter 14 Communications 
This chapter covers the setting of serial communication settings in the meter. 

Optical Communications Port 
The optical communications port on the front of the meter may be ordered with either a 
FLAG or ANSI physical standard port.  The protocol used is EDMI’s command line 
protocol.  Standard FLAG or ANSI read heads may be used to connect the meter to a 
computer.  EDMI can also supply read heads. 

The format of the data can be configured using the Communications → Ports setup page 
(See Chapter 14). 

 

• Figure 14-1 Communications ports setup. 



  

   

Set Baud Rate to the baud rate of the connection, up to 19200 baud.  Also set parity to 
the parity of the connection.  The default settings are 9600 baud, no parity.  The Fitted 
flag is simply used as a reminder whether the port is physically fitted or not. 

Default User Level allows the user level to be set when no user is logged in.  Normally 
this is set to -None-, which is user group 0.  This does not allow any operations to be 
performed.  Setting this to a different user level (also called user group) means that 
when no user is logged in, the port will revert to the set user level.  This setting is 
designed for SCADA systems where a permanent connection is needed without the 
need to login, simplifying the interface. 

Access is used in conjunction with the TimeWindow settings.  Windows of time where 
access is permitted or denied may be configured using these settings.  The All option 
allows the port to function normally.  The Lockout option causes the port to refuse all 
communications during denied time periods.  The Time Window setting does not 
actually refuse communications, but does set a flag which may be used by EziScripts. 

Time Windows 
Time windows allow access to be restricted during certain time periods.  It is configured 
using the Communications → TimeWindow setup page (Figure 14-2). 

 
• Figure 14-2 Time Window setup. 

The Type, Start, End and D settings have the same usage as in the TOU system – see 
Chapter 13 for more information on these.  The Access setting indicates whether the port 
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is to be enabled or disabled by this entry.  By default, access to ports are Permitted.  The 
Optical, EziPort and Modem checkboxes indicate which port(s) the entry controls. 

The Memory Available indicator shows how much memory is remaining for entries.  
There is space for approximately 20 entries, depending on their type.  

The setting in Figure 14-2 will disable the optical port outside the hours of 8am to 5pm. 

Modem Port 
The meter’s modem port can be fitted as either an RS-485 port or RS-232 modem 
interface.  To connect a modem, obviously RS-232 hardware is selected.  A modem 
cannot be used properly with the RS-485 port as there are no handshaking signals.  RS-
485 supports longer cable runs than RS-232, and supports multidrop operation, where 
multiple meters are connected in parallel on the same line.  One meter can be talked to at 
once, while the meters not being accessed disable their transmitters to avoid conflicts. 

EDMI meters supports both 2-wire RS-485 and 4-wire RS-485 operation (in 2-wire 
operation the transmit and receive lines are shared and used half duplex). 

The modem port is configured in a similar way to the other ports.  Baud rate, data bits 
(should be 8), parity, stop bits, access, and default user level may all be set using the 
modem section of the Communications → Ports setup page (Figure 14-3).  Once again 
Fitted is just a note whether the port is fitted or not. 

 
• Figure 14-3 Modem communications setup. 
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RS-485 

When an RS-485 port is fitted, the bottom three rows of modem port setup may be 
ignored, except that Type should be set to No Modem.  DTR/DCD should be turned off 
as the lines are not available on the port.  XON/XOFF flow control may be enabled if 
required.  Pass Through should not be enabled, and 2 Wire RS485 should be ticked if 
the appropriate hardware is being used. 

The Handshaking setting should be set to either RTS Always Active or Transmit Enable. 
RTS Always Active will enable the transmitter all the time, so should not be used in 
multidrop situations.  Transmit Enable will enable the transmitter only when 
transmitting a response to a request.  This is the mode that should be used in most 
situations including multidrop. 

The connections for the RS-485 port are covered in Chapter 2.  A converter is needed 
when connecting RS-485 to an RS-232 port.  For proper operation with EziView on a 2-
wire system the converter needs to detect a transmission from the computer and enable 
its transmitter. 

For IEC1107 and Modbus support please contact EDMI Sales and Marketing. 

RS-232 and Modems 

When an RS-232 port is fitted, the port is usually used to control a Modem.  The bottom 
three rows of modem port setup is used to detail the modem dial string, response, and 
initialisation string.  The Type field should be set to Normal Modem.  The remainder of 
the operation is controlled by an EziScript to allow maximum flexibility in modem 
support.  See Chapter 21 for information on using a modem with the meter. 

SCADA Port 
The SCADA Port on EDMI Mk6 Genius and Mk6E is an extra access port available on 
an add on SCADA Card.  It enables a meter to have an additional RS-485 port when the 
Modem port is fitted as an RS-232 port (and used to control a modem).   

Note that some Mk6 Genius Meters are fitted with an Eziport hardware option.  This 
hardware port (as mentioned in External Features on Page 2-3) is transmit only. A meter 
cannot have an EziPort and SCADA Card fitted at the same time.  If this port is fitted, 
the SCADA Port must be operated in Eziport mode, described below. 
 

The SCADA Port operates in two distinct modes.  The first is Command Line Login 
Mode, allowing normal access to the meter via user login and access.  The second is 
EziPort mode, which is a transmit only mode.  The meter is preprogrammed with 
register values that are continually transmitted out the port to be read by an always on 
SCADA system.  The following sections describe how to set up these two differnet 
modes. 
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Command Line Login Mode 

The SCADA Card in Command Line Login Mode is most often used to allow a Mk6 
Genius meter to act as a ‘Master Meter’.  The meter acts as a gateway between a modem 
connected to the Modem Port and other EDMI meters connected on an RS-485 bus.  
This allows a group of EDMI meters to be connected together and accessable via one 
modem. 

Command Line Login Mode is selected by ticking the Command Line Login option.  
This option requries the Eziport/SCADA Control Extension to be installed to operate 
correctly.  Refer to Chapter 17 for more information on installing Extensions. 

To enable a meter to act as a ‘Master’ or ‘Gateway’ Meter, the Pass Through option 
must be selected.  This option means that any Command Line request that is received on 
the Modem Port and is not for this meter is passed through to the RS-485 bus.  Any 
responses to this request received on the RS-485 (SCADA Port) are then routed back 
out the Modem Port to the original destination. 

All other setup options are the same as the Modem Port and should be set appropriate 
for RS-485 operation.  For IEC1107 and Modbus support please contact EDMI Sales 
and Marketing. 

Eziport Mode 

Eziport Mode is a transmit only scheme that is designed to send a stream of information 
to a receiving device.  It is used most often to send information that is constantly 
updated to a SCADA or Control System.  It reads a user definable set of registers, then 
transmits these values.   EDMI has several utilities for reading and displaying EziPort 
data, but their usage is covered in their own documentation.  Ensure that the Command 
Line Login option of the SCADA Port setup is not selected to make the meter operate in 
this mode. 

There is provision for two sets of up to 50 registers that can be transmitted via the 
EziPort.  The High Speed set (left hand pane of the setup screen) is transmitted every 
second.  The Low Speed set (right hand pane) is transmitted every ten seconds. 

Registers can be entered directly or selected using the register selection dialog by double 
clicking on the register field (or right clicking and picking Select Register…).  The 
register to transmit should be set up to the registers to display in the EziPort reader 
program. 
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The following Figure shows the Communications → Eziport setup page that allows the 
registers to transmit to be selected (Figure 14-4). 

 

• Figure 14-4 Eziport registers for transmission setup. 
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Chapter 15 Alarms/EFA 
During operation the meter monitors a variety of internal and external conditions.  If a 
problem is detected an alarm is raised called an Equipment Failure Alarm, or EFA.  
These tests are designed to detect measurement faults, tampering attempts, and 
hardware failure. 

 
• Figure 15-1 EziView Status screen. 

The alarm status can be viewed on the Screens → Status screen using EziView.  See 
Figure 15-1.  In this case there is an active pulsing output overflow alarm. 



  

   

Alarm States 
There are 14 different EFAs, each representing a different type of fault.  Each alarm has 
a corresponding flag letter that represents it, listed in Table 15-1. 

Flag Letter Alarm Name 
S Asymmetric Power. 
V Voltage Tolerance Error. 
F VT Failure. 
R Incorrect Phase Rotation. 
C Clock Failure. 
M Reverse Power. 
L Calibration Data Lost. 
H Modem Failure. 
X RAM Failure or LCD Failure. 
Y Program Flash Failure. 
Z Data Flash Failure. 
N Pulsing Output Overflow. 
D Battery Failure 
U User Defined. 

• Table 15-1 Alarm names and flag letters. 

An alarm flag can have one of 3 states.  The active state means that the alarm has been 
detected and is still occurring.  The latched state means that the alarm was active but 
isn’t now.  The inactive state means that the alarm is not active and has not been in the 
past.   

Latched alarms stay latched even if power is removed from the meter.  They may be 
cleared using the Clear Flags button on the Screens → Status screen in EziView. 

An EFA is generated if any alarms are active.  The letters “EFA” are displayed on the 
default LCD screen at the bottom left (See the Chapter 2 section Default Display on 
page 2-18 for more information on the display).  If there are latched alarms, but no 
active alarms, the letters “efa” are displayed to indicate the fault is no longer active.  
Alarms may be set to a flashing mode, where if active they will flash the “EFA” sign.  
This could be used for serious alarms or indicating certain types of tamper. 

Alarms that should not cause an EFA may be disabled.  Each alarm has a mask that 
when set stops it from causing an EFA. 

For displaying flags in space restricted places such as the LCD a string format is used.  
The alarm status is displayed as a string of 16 characters, with each alarm’s flag letter 
used to indicate an alarm.  An inactive alarm is represented by a full stop.  A masked 
flag is represented by lower case.  An active flag is represented by upper case.  All flags 
active looks like “.SVFR.CMLHXYZNDU”.  The two full stops represent two unused 
alarm positions.  The letters always appear in the same locations. 
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Alarm Setup 
The alarms may be configured using the Alarms setup page of EziView (Figure 15-2). 

 
• Figure 15-2 EziView Alarms setup page. 

Each alarm has a checkbox that can be in one of 3 states.  Unchecked means that the 
alarm is masked and as such will not cause an EFA.  A plain tick indicates that the alarm 
is not masked and will generate an EFA.  A greyed tick indicates that the alarm is not 
masked and will generate a flashing EFA. 

There are a number of other parameters that relate only to certain alarms.  Full 
descriptions are in the section “Alarm Types” below.   

The Asymmetrical Power setting gives the limit in percent for the unbalance in power.  
The Voltage Tolerance figures set the allowable voltage range, given as upper and lower 
percentages of nominal.  The VT Failure setting gives the minimum VT voltage, given 
as a percentage of nominal. 

All of the measurement based settings in the top half of the screen have a time that they 
must be active for, and a current that must be flowing before they are active (Alarms 
Disabled Below setting).  These factors are used to prevent false triggering. 

The nominal voltage and current to be used for the alarms are also set on this page.  

Set the Nominal Current to the nominal secondary current of the meter.  This is the 
nominal current at the meter terminals.   
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Set the Nominal Voltage to the nominal secondary line to line voltage of the meter.  This 
is the nominal voltage at the meter terminals.  For example, a 110V/63.5V system the 
Nominal Voltage should be set to 110V, regardless of whether the meter is connected in 
2 Element or in 3 Element mode.  The voltage is always specified as a line to line 
voltage – the meter adjusts it automatically based on the element mode. 

The meter also has an inbuilt Sag / Swell (Sag & Surge) Alarm.  This alarm is treated 
differently to the Equipment Fault Alarms.  It does not have three different states. The 
alarm monitors the voltage on each phase for sags and surges.  If the voltage is outside 
the limits set in Figure 15-2, the meter will record how long it was out of tolerance in 
seconds, the worst voltage, and the current at the time of the trigger on the 
corresponding current phase.  This information is stored in an EziScript Sag & Surge 
Survey that must be loaded in the meter for this alarm to work correctly.  Refer to 
Chapter 17 and Chapter 19 for more information on how to install the Sag & Surge 
Extension. 

Alarm Types 
A list of all possible alarm conditions is provided below, followed by a detailed 
description of each test. 

Note that where a programmed delay time is specified, this means that the fault must 
exist continuously for the set time before an alarm will be raised.  Meter reset/loss of 
power will restart the timers. 

Calibration Data Lost. 

This is a check for valid calibration data in the meter.  If a reference value has its default 
value of 0, then the calibration data has been initialised and a ‘Calibration Data Lost’ 
alarm will be raised.  This will occur if a unit has never been calibrated, or if a major 
fault causes both the non-volatile RAM and FLASH to be corrupted. 

Asymmetric Power. 

Power Symmetry (Pu) is defined as the amount of unbalance between the individual 
phase powers.  The calculation of this figure depends on the measurement configuration 
(2 or 3-element) as detailed below.  This test is not performed if all of the input currents 
are below the minimum current threshold, Imin. 

If the value Pu is greater than or equal to the set limit, then a power symmetry error is 
considered to be present.  Unbalance must exceed the bounds for a programmed time 
(default 1 minute) before an alarm is raised. 

For 3 Element configuration : 

The calculation of power unbalance (Pu) is based on the maximum and minimum power 
levels from the three phases  (Pmax and Pmin): 
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Voltage Tolerance Error. 

The voltage input levels on each phase are tested to ensure that they remain within the 
limits set by Vmax and Vmin.  Only those phases with at least Imin current are tested.  
Vmax and Vmin are specified as a percentage of the nominal voltage, Vn.  For 3-
element measurements, Vn = line to line nominal / √3, for 2-element measurements, Vn 
= line to line nominal.  In 2-element mode, only inputs Va and Vc are tested.  A 
programmed time delay (default 1 minute) is applied to this test. 

VT Failure. 

A VT failure is indicated if the voltage measured by any input is less than Vfail and the 
corresponding current input is at least Imin.  Phase B is not tested in 2-element mode.  A 
programmed time delay (default 1 minute) is applied to this test. 

Reverse Power. 

A reverse power alarm is indicated if power is negative on any phase (provided the 
phase is carrying current and the voltage is within tolerance).  In 2-element mode this 
test is applied to the total power.  A programmed time delay (default 1 minute) is 
applied to this test. 

Incorrect Phase Rotation. 

The phase rotation of the applied signals is tested to ensure that the correct phase 
rotation is maintained.  The method of determining the phase rotation is dependent upon 
the measurement configuration.  For both methods, the test is applied only if all of the 
currents are greater than the minimum current level (Imin) and all of the voltages are 
between the limits of Vmin and Vmax. A programmed time delay (default 1 minute) is 
applied to this test.  (An error condition must be present for more than the programmed 
time delay (default 1 minute) before the alarm is activated.) 

2-Element - For 2-element measurements, the angle between the two applied voltages 
(Vab to Vcb) must be between +30 and +90 degrees, while the angle between the two 
applied currents (Ia-Ic) must be between +60 and +180 degrees. 
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3-Element - For 3-element measurements, the angles between each successive voltage 
input (Vab, Vbc, Vca) must be between -90 and -150 degrees, while the angle between 
each successive current input (Iab, Ibc, Ica) must be between -60 and -180 degrees. 

Clock Failure. 

The clock test consists of a simple check to determine that the real time clock (RTC) is 
running.  It also checks that the RTC is operating at approximately the correct rate.  If a 
clock is running significantly fast or slow, the event log will show a large number of 
“System Time Synchronised” events.  It may also be caused if the time in the RTC was 
found to be invalid during start-up.  In this case the time will be set to the turn-off time if 
available.  The appearance of inactive clock failure alarms after power up may indicate 
that the reserve battery is almost exhausted.  During operation the RTC time is 
compared against the system clock to check for a failed oscillator. 

User Defined 

This alarm is controlled by a simple flag that may be set by the user or by an EziScript.  
The alarm will be active while the flag is set.  The flag can be turned on and off using 
the Online Variables → Gate → Alarm → User Defined checkbox (Figure 15-3). 

 
• Figure 15-3 EziView User Defined flag setting. 

Modem Failure. 

This alarm is generated by the modem script if the modem is found to be faulty.  This 
would generally be indicated by no response from the modem.  See Chapter 21 for 
details. 
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RAM or LCD Failure. 

Each byte of the RAM is tested by performing a read/modify/write operation.  If any 
faults are found, then an alarm is raised.  If the LCD does not respond correctly to 
commands the alarm is also raised.  This test is performed continuously. 

Program Flash Failure. 

The content of the program Flash memory is tested using a checksum.  If the checksum 
calculated is different from that stored with the program an alarm is raised.  This test is 
performed continuously. 

Data Flash Failure. 

The data Flash memory contains information about the system configuration and 
calibration data as well as back ups of EziScript extensions.  Erases and writes to the 
Flash are monitored, and the alarm is raised if an erase or write fails to operate correctly, 
indicating a possible error with the Flash device. 

Pulsing Output Overflow. 

A pulsing output overflow alarm is generated if the rate of pulses to be output is such 
that the off time between pulses violates the specified minimum off time for the output.  
The pulses will still be output, but the off time will be less than the specified minimum, 
and in extreme overflows the off time will be zero, resulting in a permanently on output. 
This alarm provides a warning that the settings for the pulsing outputs may need to be 
changed.   

Battery Failure. 

Tested at power up, this flag is set if the backup battery is low/non existent.  It is only 
tested when the meter is powered up, not when simply reset.  When simply reset (e.g. 
via the Restart Meter option) the meter will always indicate that the battery is ok. 
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Chapter 16 Security 
The security systems of the meter and of EziView allow for fine control over who is 
allowed to do what with the meter.  Each user has their own user name and password.  
This grants them access to their user group, which defines what they can and can’t do.   

Note that there is some coverage of EziScripts in this chapter.  Although they have not 
been covered in any preceding chapter, this information is here because it is best located 
here. 

User’s Perspective 
Security is controlled by EziView using usernames and passwords on a meter by meter 
basis.  When EziView loads it will ask for a username and password (Figure 16-1). 

 
• Figure 16-1 EziView Login dialog. 

Enter your username and password, then click OK.  Clicking Cancel will not log you in.  
To avoid entering your username and password every time you start EziView, it can be 
remembered by using the Tools → Options → General → Save Main Password 
checkbox (Figure 16-2).  Note that this reduces the security of EziView as no password 
need be entered when starting EziView to access meters. 



  

   

 
• Figure 16-2 Save Main Password setting. 

The username and password may be changed within EziView using the Tools 
→ Current User option.  If the Save Main Password option has been selected then a 
Save Password checkbox will also be displayed.  Checking this box remembers the 
entered username and password. 

Additionally there is a Tools → Alternate Logon option.  This allows for the provision 
of an alternate password to use if the main password fails.  This can be useful for 
instance where meters are to be configured and only have the EDMI standard username 
and password.  This can be entered as the alternate logon, while the normal password 
remains set to your normal password.  It can also be useful if you are changing 
passwords in the meter. 

The Link Security field in a login is used when you don’t have an account in the meter 
and are attempting to map the site.  Select the MTR file of a meter in which you belong 
to a group.  EziView will use the group username and password from that meter to map 
the site. 
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The current login information in use in the meter can be viewed using Screens 
→ Online Variables → Security (Figure 16-3). 

 

• Figure 16-3 Security Online Variables Display. 

The top section shows the details of the current logged-in user.  The bottom section 
allows the user to change their password in the meter.  Enter the new password in both 
fields then click the Set button. 

Meter Security Overview 
Before going into how to configure security using EziView, this section covers the 
security features of the meter.  This should be read first. 

The meter allows for up to twenty users.  Generally before any operations may be 
performed a user must log.  Each user has a user name and a password, each up to ten 
characters long.  Sending a valid user name and password to the meter logs on the user.  
The user remains logged on until logged out by whatever means. 

Each user also has a phone number for dial back security, although this is not presently 
used.  More importantly, each user has a user level, also called a user group.  When a 
user logs on, the user group they belong to is used to decide what they can access. 

There are ten user groups numbered 1 to 10.  A user group of 0 means no access at all – 
this is generally the access level when no user is logged in.  The exception to this is 
where a default user level other than 0 has been set for a port under port settings 
(Chapter 14). 

Several other systems in the meter also must belong to user groups.  EziPort, LCD 
displays, TOU channels and EziScripts all must belong to a user group to define their 
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access.  There is no point stopping someone reading a value when they log in, but still 
allowing them to show the value on an LCD screen.  Just like a logged-in user, the 
group controls what data they can access. 

Each user group has an inactivity timeout setting.  If a user makes no valid (checksum 
OK) communications in this period of time the user is logged out.  It may be disabled by 
setting to zero, useful for applications like SCADA. 

More importantly, each user group has the permissions of the group.  Every setting or 
value in the meter (every register) belongs to one of 256 security groups.  For example, 
the settings for each pulsing output belong to separate security groups.  The permission 
settings allow read and write access to be independently controlled to each of these 
security groups. 

This means that, for example, a user could be given access to read all pulsing output 
settings, but only to change some of them.  Generally when write access is given, read 
access should also be given, but does not have to be.  However, setup settings used by 
EziView need read and write access to write a setting as it reads all settings to check if a 
change needs to be made. 

In addition to this, there is an additional mask for writing controlled by the configuration 
jumper (also called the config jumper).  This is located under the main meter cover, 
below the right hand end of the LCD (See The Config Jumper on page 2-9).  When in 
the Config position the jumper has no effect on security.  When in the Secure position 
additional user set masks are applied to all operations.  This allows hardware security to 
be applied that cannot be defeated without breaking two sets of seals on the meter.  
Changing the settings for the config jumper requires the config jumper to be in the 
config position.  

By default, meters are usually shipped with a single user ‘EDMI’, which has a password 
of ‘IMDEIMDE’.  The user is in the user group number 1, which is given full access.  
This user may and should be deleted after you have configured your own administrator 
user. 

As described above, the internal security provisions of the meter are considerable.  
EziView uses these capabilities, and adds more of its own. 
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EziView Security 
Each meter in EziView has its own separate security settings – there are no program 
wide settings.  The Security page is used to configure the settings for the meter. (See 
Figure 16-4)  

 
• Figure 16-4 EziView Security setup page. 

The tree diagram shows the user groups and the users within those groups.  Properties 
for the selected item appear to the right of the tree view.  The plus and minus boxes may 
be used to expand or collapse parts of the tree view.  The Expand and Collapse buttons 
affect the entire tree view. 

When changes are made OK and Cancel buttons appear just above the Additional 
Security box.  Settings are not validated until OK is clicked.  Clicking Cancel cancels 
the changes.  If an attempt is made to leave the settings page without clicking OK or 
Cancel, a dialog will ask if the changes should be made (Figure 16-5).  Cancel returns to 
the settings page.  The Yes and No buttons act the same as the OK and Cancel buttons 
discussed. 

 
• Figure 16-5 Security change confirmation. 
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User Groups 

There are up to ten user groups in the meter, numbered one to ten.  There is no 
difference between the groups – group 1 does not do anything more or less than group 
10.  Each group has a Name and a Description – these are not stored in the meter, but 
EziView keeps track of them in the MTR file.  The name is what appears in the tree 
view.  Users belong to one of the groups – the settings of a group affect all users 
belonging to the group.   

The Inactivity Timeout sets the longest time in minutes that a logged-in user can be 
inactive (no valid communications).  After this time the user will be logged out and 
disconnected.  A setting of zero disables this feature. 

The Group Number setting allows the group’s number to be changed.  Dragging the 
group in the tree view can also do this.  The actual group number of a group has very 
little meaning, except where EziScripts are concerned.  EziScripts are coded to run with 
the access of a particular group number – rearranging group numbers may affect this. 

Several other systems in the meter also use the group number.  The TOUSetup, 
LCDscreens, and Communications → Ports pages all have a security group setting.  
These sections must access information, and they use the access rights of the indicated 
group to do so.  If group numbers are changed EziView will automatically change the 
group number settings on these screens to keep the groups the same.  

Permissions allow the access permissions of the user group to be changed.  The use of 
this is covered in the “Permissions” section later in the chapter. 

 
• Figure 16-6 Users not in the meter settings. 
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Users in meter allows for selection between two types of security restrictions.  When the 
Users in Meter box is checked, the username and password of a user is used both for 
EziView and for the meter.  If the box is unchecked (Figure 16-6), a username and 
password for accessing the meter must be entered for the group.  Users log into EziView 
using their username and password, but the user does not know the username and 
password used to access the meter as EziView translates this automatically.   

This feature is useful where it is undesirable to give users the ability to perhaps use other 
programs to access the meter.  Without the meter username and password, the only way 
the user can access the meter is via EziView.  The other advantage is that the meter only 
supports up to twenty users.  By only having one user account in the meter for a group 
of users, the number of users in that group is unlimited.  The disadvantage is that the 
meter can only log the connection of the user account in the meter (where the meter user 
name is displayed).  This affects that ability to track individual access. 

With this type of group, the permissions should be set to disallow access to the security 
setup as well as the CurrentUser, CurrentPassword security groups.  This is to prevent 
the users in the group from finding out the login password. 

Fill in the additional user information for the group as for a user (see the following 
section).  This is the username and password that will be used to log into the meter. 

Right-clicking on a group gives a number of options.  New Group (Ctrl-G) creates a 
new blank group.  New User adds a new user to the group.  Copy creates a new group 
with the same settings, and Delete deletes the group and its users. 

Users 

Users may be added to a group from the groups pop-up menu, or from another user’s 
pop-up menu.  Users may be dragged from one group to another.  The position of a user 
within a group makes no difference.  The meter supports up to 20 users.  For groups 
with user accounts in the meter each user counts as one user.  For groups with user 
accounts not in the meter the group counts as one user. 
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• Figure 16-7 EziView User setup. 

Figure 16-7 shows the settings for a user.  The Username may be up to 10 characters 
long (A to Z and 0 to 9).  The Full Name and Description fields are kept by EziView 
(not the meter) and are for information only.   

The Password may be from 5 to 10 characters (A to Z and 0 to 9).  Enter the password 
into both the Password field and the Confirm Password field – they must match or 
EziView will not accept the new password.  The password will usually be starred out.  
The Show/Hide button may be used to display the password text.  

The Phone Number is used for users with accounts in the meter only.  It allows dial back 
security when used with a modem EziScript capable of this.  See the modems 
chapter(Chapter 21). 

EziView will try to protect you from writing a setup to the meter that has no 
administrator user.  Care should be taken that there is always a user capable of changing 
user information. 
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Permissions 

 Clicking on the Permissions button displays the main permissions edit screen (Figure 
16-8).  The security groups are arranged under a tree diagram that follows the 
arrangement of the setup pages. 

 
• Figure 16-8 Permissions Edit screen. 

There are three check boxes for each security group.  The left-most box allows reading 
when checked.  The middle box allows writing when checked, and the right-most box 
allows modifying when checked.  Reading and writing are controlled by the meter, and 
modifying is controlled by EziView.  The Modify setting is used to prevent users from 
modifying settings in EziView.  If a user is not permitted to modify a setting, it is greyed 
out and cannot be changed.  If all of the modify settings for a setup page are cleared, the 
setup page is not displayed.   

For example, in Figure 16-8 the modify permissions have been removed from the first 
two pulsing outputs.  Note that the modify checkbox for PulsingOutputs is greyed to 
indicate that some of the boxes beneath it are not checked.  Checking a box with sub 
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branches changes all those settings too.  The All checkboxes at the bottom may be used 
to change all settings.  Expand and Collapse may be used to expand the detail shown in 
the tree view, as can using the plus and minus boxes. 

Figure 16-9 shows the effect of these settings on the PulsingOutputs page.  Note that 
outputs 1 and 2 are greyed out and cannot be changed.  The Modify setting is most 
useful where a user needs to be able to write a setting, but should not be allowed to 
modify the setting themselves. 

 
• Figure 16-9 Modified PulsingOutputs page. 

There are several security groups that are not directly related to setup pages (Figure 
16-10). 

 
• Figure 16-10 Extra Permissions. 
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The Display permissions are for values that can be displayed, such as voltage.  General 
has the security groups which don’t fit anywhere else, along with any currently unused 
groups.  Extensions has the settings for EziScript extensions (Table 16-1). 

Security Group Effect 
ExtensionSetup1 Access to read the EziScript memory usage information. 

Write access allows defragment command. 
ExtensionSetup2 Access to read the summary information of EziScripts. 
ExtensionSetup3 Access to create extensions. 
ExtensionSetup4 Access to upload and download EziScripts (this is not survey 

data). Access is also required to the EziScript’s security group. 
ExtensionXX These are security groups reserved for EziScripts to use.  They 

correspond to group numbers 230 to 245. 
• Table 16-1 Extension Security Groups 

The EnableLevelXScriptUpload security groups are used to control what level 
EziScripts may be loaded by a user.  EziScripts have a user group level that they use to 
access the registers they need to operate.  To load an EziScript into the meter, the  
EnableLevelXScriptUpload write flag that corresponds to the EziScript’s user group 
must be set.  This allows the access abilities of EziScripts loaded by a user to be limited. 

The EziView options relate to features of EziSetup – only the modify flag is used.  
Security allows access to the security setup page.  Clearing the flag for this has a similar 
effect to clearing all the security flags.  If the security flags are set, the EziView security 
flag will be set.   

The Properties option allows access to the properties of the meter.  If this is not set a   
symbol will be displayed next to the meter in EziView.   

The GeneralRegister option controls the use of the read register and write register 
commands. 

Alternate Permissions Control 

In addition to the tree view of permissions, there is another display that simply lists the 
security groups.  They both allow the same things to be done, but are simply presented 
in a different way.  This way may be more useful when working with registers directly. 
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Right-clicking on the Permissions button brings up a small menu with options for Read, 
Write and Modify.  Selecting one of these will display the setup for that type of flags 
(Figure 16-11). 

 
• Figure 16-11 Alternate Permissions setup method. 

All security groups are listed, along with their security group number in brackets.  The 
left hand pane shows the enabled security groups, while the right hand pane shows the 
disabled ones.  Selecting entries and selecting Enable or Disable will move them as 
directed one side to the other.  The Enable All and Disable All buttons move all entries, 
regardless of selection.  OK saves the changes, Cancel ignores the changes. 

Permission Schemes 

With the huge number of security groups it can become tedious to keep on setting up the 
same security for several users.  To overcome this EziView has Permission Schemes.  
This allows permission setups to be stored and reused.  The schemes are stored in a 
single file, the location of which may be setup in Tools → Options →Perm.Scheme 
(Figure 16-12). 

 
• Figure 16-12 Permission Scheme Options. 
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To create a permission scheme, first setup the permissions as normal.  Then enter a 
name for the scheme into the Perm. Scheme field on the Security setup page.  A save 
button will appear to the right of the field – click this button to save the new scheme.  It 
will be added to the drop down Perm. Scheme list. 

To apply a permission scheme simply select it from the drop down list.  When a scheme 
is selected, a delete button will appear to the right.  Clicking this button will delete the 
scheme. 

In order to reduce the risk of accidentally changing a scheme, the options page (Figure 
16-12) has a Read Only check box.  Checking this box stops the display of the Save and 
Delete buttons and thus prevents the schemes from being changed. 

Additional Security 

The Config Jumper setting allows the effect of the config jumper to be setup.  When the 
config jumper is in the Secure position any security group without its rights enabled here 
will not be accessible.  In these permission settings only the read and write settings have 
an effect – the modify setting does not do anything.  The config jumper settings can only 
be written to the meter if the config jumper is in the Config position. 

The Billing Reset Button Disable check box may be checked to disable the operation of 
the billing reset button on the front of the meter. 

Lost Passwords 
Care should be taken that at least one user has permission to change user security 
information.  Contact EDMI if you do manage to lock yourself out of the meter. 

 

 

 

  Security  16-13 



  

   

 

 

 

 

 

 

 

 

 

 

 

 

Intentionally Blank

16-14  EDMI Genius/Mk6E User Manual 



 

   EziScript Extensions  

P a r t 

III
 

 

 

Part III EziScript Extensions 
 

lthough the meter has quite a range of built-in functions, there are limits to its 
versatility.  There always seems to be something that needs to work a little bit 
differently for your application.  This is where EziScript extensions are useful.  
EziScript is a kind of macro language that allows the meter’s operation to be 

customised.  It works just in the way a macro language for a word processor or 
spreadsheet works, by piecing together the existing features to create new functionality. 

This section of the manual gives an overview of how EziScripts work and how to load 
them into a meter.  The following chapters then detail EziScripts that are available for 
specific tasks:  

A 

• Chapter 17: “Using EziScript Extensions” 

• Chapter 18: “Toolbox” 

• Chapter 19: “Survey Tools” 

• Chapter 20: “Control Tools” 

• Chapter 21: “Modem Control” 

Chapter 17 gives an introduction to EziScript extensions and the basics on how to use 
them. Chapter 18 covers the use of toolbox to create customised extension tools.  The 
other chapters document the available tools and may be read in any order. 
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Chapter 17 Using EziScript Extensions 
An EziScript extension is a macro that can be loaded into a meter to extend its 
functionality.  It works to tie together the operations of the meter to create new 
functionality and customisations.  Each EziScript extension consists of several parts that 
combine to produce the desired operation. The parts are: 

• User defined registers.  These can be used to store items of information, just like the 
meter’s built-in registers. 

• Survey.  This allows multiple channels of data to be recorded and retrieved 
efficiently. 

• Time Events.  These allow operations to be scheduled to occur at set times. 

• Scripts.  These tie together the operation of the other parts and the existing meter 
functions. 

There are two ways of using EziScript extensions.  The easy way is to use them as part 
of the normal EziView setup pages.  This allows EziScripts to be configured offline just 
like other settings.  EziView Toolbox contains a collection of scripts to accomplish a 
variety of tasks.  These ‘tools’ can be selected, configured, and added to the setup. 

The second way is accessible when the meter is connected.  A list of the scripts 
currently in the meter can be displayed, and scripts added or removed.  Status 
information about the scripts can also be shown. 

The terms EziScript, EziScript extension and extension may be used interchangeably, 
although extension is a slightly more generic term.  

Where are EziScript extensions stored? 
A block of 192KB of memory is provided within the meter for the storage of EziScript 
extensions and their data.  EziView allocates a block of memory for a new EziScript, 
then downloads it to the meter and links it.  Linking checks the validity of the extension 
and activates it. 



  

   

The memory is maintained by the meter’s battery, but a limited size of extensions may 
be also stored in FLASH memory for more permanent storage. Approximately 32K of 
extensions may be stored in this way.   

EziScripts using setup and Toolbox 
This method of managing scripts views them as a method of achieving an end.  The 
focus is on the task required.  EziView uses the concept of tools, where a tool is made 
up of one or more scripts.  A tool is taken from a toolbox, then adjusted and customised 
for the specific task.  It can then be put into the meter, or kept in a holding area close at 
hand.  Once in the meter, the tool performs its function, gathers data, controls outputs, 
etc.  

The EziView Setup → Extensions page (Figure 17-1) is used to select the tools to be 
included in the meter.  

 
• Figure 17-1 EziView Extensions Setup page. 

EziView keeps a directory that holds all of the customised tools.  This is common for all 
meters.  The Extensions page lists all of these tools.  Selecting a tool brings up its 
description in the Description field. 

Each tool has a checkbox.  Checking the checkbox for a tool marks it for loading into 
the meter.  

The Memory and Flash bars indicate an estimate of the remaining memory in the meter 
for tools.  This does not take account of non-toolbox extensions in the meter. 
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The tool is actually loaded into the meter when a write of setup occurs (by any of the 
setup methods).  If a tool is already in a meter and the checkbox for it is unchecked, the 
tool will be removed from the meter.  Normal EziScripts loaded into the meter will not 
be affected. 

If a tool with the same extension number is already in the meter (e.g. loading a different 
setup for load survey #1), a confirmation dialog will be shown to make sure you want to 
delete the old extensions. 

Next to the checkbox is an icon that represents the status of the tool.  Table 17-1 lists the 
possible icons and there meanings. 

Icon Description 

 
This tool has no problems and is suitable for loading into the meter. 

 
The meter does not have the extended feature codes required to use this 
tool.  Alternatively the meter may not know about the codes in the meter.  
See below for more information. 

 
You do not have security permission to send this tool to the meter.   
Check your security permissions. 

 
This tool is listed in the MTR file, but its TBX file is not located on this 
machine.  You should try to obtain a copy of the TBX file from the 
computer where the tool was created. 

 
There is a newer revision of this tool available.  This is shown if EziView 
detects that it now has a newer version of the tool.  See below for more 
information. 

• Table 17-1 Tool icons in EziView. 

The  will be shown on all tools if EziView does not know what extended features the 
meter has.  To update EziViews record, bring up the Screens → Online Variables → 
Extended Feature Code page while connected to a meter.  This will read the current 
value into the MTR file, and aloow you to view the codes avaiable in the meter and 
enter new codes.  For more information see “Extended Feature Code”, page 7-2. 

The  will be shown if an update to the tool is now available.  EziView keeps track of 
the version of each tool, as new versions of toolbox may contain updates.  EziView will 
perform this check automatically if a new version of toolbox is installed.  This check can 
be performed manually using the manual update  button on the toolbar (3rd from the 
right).  This may be needed if a meter and TBX file are introduced to the computer that 
were created with an older version. 

EziView will give a warning of “Extension “xxx” needs to be updated to work correctly. 
The update process maintains the configuration, but ALL historical data will be LOST.” 
before an update is made.   

  Using EziScript Extensions  17-3 



  

   

Working with Tools 

The tools listed are the customised tools that EziView knows about.  EziView uses this 
information when it is reading the setup from a meter to identify what tools are present 
in the meter. 

To create a new customised tool, click on the new  tool button on the toolbar (1st on 
the left).  This will load the toolbox and allow a new tool to be created.  The use of 
toolbox is covered in Chapter 18.  When finished creating the new tool, it will be added 
to the list.   

To view the properties and setup of a tool, select the tool and click the properties  
button on the toolbar (2nd on the left).  Click Cancel or OK to return to the setup page.  If 
you have changed anything, do not click the OK button as a new tool will be created. 

To create a new tool based on an existing tool, select the tool to base it on and click the 
properties button on the toolbar (2nd on the left).  Change the settings and click OK to 
create a new tool based on the old one.  Clicking Cancel will discard any changes. 

To delete a customised tool from the list, select the tool and click the delete  button on 
the toolbar (3rd on the left).  This should only be done if the customised tool is not used 
in any meters.  The customised tool is used to track the tool and contains the full 
settings.  Without it, EziView cannot get the full settings of the tool in a meter.   

There are two views of the customised tool list.  The normal view (shown in Figure 
17-1), and the detailed view (Figure 17-2).  The views are switched using the two right-
hand buttons of the toolbar. 

 
• Figure 17-2 EziView Extensions Setup page, detailed view. 
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The detailed view gives additional information about the tool and version information.  
This also displays the exact memory and flash usage, as well as the security group of the 
tool. 

File Locations 

The customised tool files are kept by EziView in a special directory.  The location of 
this directory can be changed using the Tools → Options → File Locations 
→ Extensions Path setting (Figure 17-3). 

 
• Figure 17-3 EziView extensions path setup. 

The files are stored with the extension TBX.  The name consists of the GUID and the 
name of the customised tool.  TBX files contain one or more scripts that make up the 
tool, a description of the tool, and the setup of the tool. 

If you are distributing setups for meters to other machines, the TBX files associated with 
the extensions setup should also be copied to the new machine.  If this is not done, 
EziView will not be able to send the customised tools to the meter.  The MTR file only 
has a reference to the TBX files to use. 
 

Where to next? 

If you are not interested in the more detailed forms of script access at this stage, you 
may skip ahead to the "Detailed Survey Information” section.  This gives a lot of 
background information on surveys which is assumed in the descriptions of tools.  
Return to the following section if you encounter problems. 
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Online EziScript Control 
These functions allowed more detailed access to the way scripts are stored in the meter. 

Note that scripts loaded using the setup method also appear here.  Changes made using 
these controls will not update the setup for the meter kept by EziView.  TBX files 
loaded or deleted using these methods will however be recognised if setup is then read 
from the meter. 

Showing what EziScript extensions are loaded 

To display the list of extensions in the meter go to the Screens → Online Variables 
→ Memory Map dialog (Figure 17-4). 

 
• Figure 17-4 EziView Online Variables Memory Map dialog, List tab. 
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The content of the meter’s EziScript extension memory is now displayed.  The icons on 
the left indicate the type of each extension (Table 17-2).   

Icon Description 

 
This is an empty block of memory.  This is where new extensions may be 
stored. 

 
This is a survey extension.  This type contains data from surveys, 
including load surveys, event logs and TOU billing history. 

 
This is a script extension.  This type contains registers, scripts and timers.  
The total size of all of this type must not exceed 64Kb, including any 
empty gaps.   

 
This is a bad extension.  It either has not been fully loaded yet, or was not 
allowed to link, or has been unlinked.  The meter on start up will try to 
link “Bad” extensions.  If a “Bad” extension will not link it is deleted. 

 
This is a disabled extension.  Extensions which do something wrong 
during operation such as accessing restricted registers will be disabled.  
They will remain in memory until deleted or linked from EziView, but 
will not be active. 
• Table 17-2 EziScript extension icons in EziView. 

Each EziScript has a descriptive name and a number of other parameters.  For toolbox 
scripts the name is the name given to the tool, with a letter on the end to indicate the 
different scripts that can make up a tool (C for control, S for survey, A for a single 
script). 

RegID is the identification number for the extension, in hexadecimal.  The RegID must 
be unique within the meter as it is used to reference the extension.  The RegID is part of 
the extension, and forms the first 3 hexadecimal digits of any register references to the 
extension. 

The CPU Load figure is an indication of the computational loading the script places on 
the meter.  The total loading is limited to ensure proper operation. 

The Size gives the amount of memory the EziScript is using in bytes.   

The GUID is listed for toolbox scripts.  This is the GUID of the tool, and will be the 
same for all of the scripts that form part of the tool. 

The total memory statistics are listed below the list of extensions.  Table 17-3 lists the 
meanings of these figures. 

EziView Code Meaning 
Loaded Ext The number of extensions loaded in memory. 
Memory Blocks The number of memory blocks allocated, including empty blocks. 
Memory Used The amount of memory used by extensions in bytes. 
Memory Free The total amount of free memory in bytes. 
Total Memory The total amount of memory fitted for extensions in bytes. 
Unfraged The memory unfragmentation level in percent. 

• Table 17-3 Extension total memory statistics. 
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The Pie Chart tab shows the memory usage information in graphical form (Figure 
17-5). 

 
• Figure 17-5 EziView Online Variables Memory Map dialog, Pie Chart tab. 

Loading a new EziScript extension into the meter 

Note that loading new EziScript extensions is a feature controlled by a feature code. 

1. Right-click on any  Empty extension and select Load from the popup menu.  
There may be more than one Empty extension, but selecting any of them has the 
same effect as the meter determines the ultimate location of any new extensions.  
Survey extensions will load in the first large enough empty space, script extensions 
will go into the last large enough empty space.  If there is not enough space you may 
have to delete EziScripts or defragment the memory – see the following sections for 
more information on this. 

2. A dialog box is presented.  Select the extension binary file you wish to load into the 
meter.  These files have the “.SCB” extension.  Multiple files may be selected at 
once.  
Toolbox files with the extension “.TBX” may also be loaded in this way. 

3. EziView will now start to load the file into the meter.  

4. A confirm overwrite dialog box (Figure 17-6) is displayed if an extension already 
exists with the same extension number.  Select OK to delete the existing extension 
and load the new one in its place.  Selecting Cancel will stop the new extension 
from being loaded. 
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• Figure 17-6 EziView Extension Exists warning dialog. 

5. Finally EziView links the extension.  This tells the meter to verify it is a valid 
extension and to start using it.  Only linked extensions have any effect.  If a Bad 
icon appears, the extension was found to be invalid by the meter and has not been 
linked.  The bad extension will be deleted if the meter is restarted. 

Deleting an EziScript Extension 

  
• Figure 17-7 EziView extension delete confirmation dialog. 

1. Right-click on the extension and select Delete from the popup menu.   

2. A confirmation dialog box is presented.  Click OK to delete the extension.  Clicking 
Cancel will abort the delete operation.  

3. The list will update showing that the extension has been deleted.  If it was next to an 
Empty space the empty space will get larger - the spaces coalesce.  Otherwise the 
extension will simply become another Empty extension, leading to fragmentation. 

To delete more than one extension at once select all of the extensions to delete first 
using the Ctrl or Shift Windows selection methods.  Selecting delete for one of them 
will then delete all selected extensions. 
 

  Using EziScript Extensions  17-9 



  

   

Defragmenting the EziScript Memory 

After several EziScripts have been loaded and deleted the memory may become 
fragmented.  This is indicated by the occurrence of more than one  Empty extension.   
The Unfraged indicator in the bottom pane is the percentage of memory not fragmented.   

 
• Figure 17-8 EziView showing memory fragmentation.  

The meter has a feature to defragment memory.  This can be used when a new extension 
needs to be loaded, but there is no single empty block of memory in which it can fit.  
The meter will rearrange the extensions so that there is only a single block of empty 
memory.  There is no performance advantage to defragmenting memory.  In Figure 
17-8 the largest free block is 124598 bytes, but the total free memory is 144416 bytes.  
Defragmenting will allow a larger extension to be loaded. 

1. Right-click on an  Empty extension and select Defrag.  A confirmation dialog box 
is presented warning that all scripts will be temporarily unlinked.  Click OK to 
continue.  Clicking Cancel will abort the operation.  

2. The meter now unlinks all scripts, rearranges them, and then links them again. 

3. The list will update showing the new memory map.  There should be only one  
Empty extension. 
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• Figure 17-9 EziView showing memory after defragmentation.  

Figure 17-9 shows the effect of defragmentation on Figure 17-8.  The largest extension 
that can be loaded is now 144470 bytes.  This is slightly more than the free space listed 
before because of the overheads of multiple empty blocks. 

Defragmenting memory causes all scripts to be unlinked then linked again.  This may 
cause disruption to some scripts.  For example, load survey scripts with averaging or 
min/max functions may have the intermediate results for the current interval cleared, 
depending on the script.  
There is no need to defragment memory if there is sufficient space for all extensions – it 
does not improve performance. 
 

Disabling an EziScript Extension 

Manually disabling extensions can be useful to temporarily stop an extension from 
running.  The extension can then be linked without having to upload it to the meter 
again. 

To disable an extension: 

1. Right-click on the extension to delete and select Disable from the popup menu.   

2. The icon for the extension will change to  Disabled. 

To re-enable the extension select Link from its popup menu. 

To disable more than one extension at once select all of the extensions to disable first 
using the Ctrl or Alt windows selection methods.  Selecting disable for one of them will 
then disable all selected extensions. 
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Detailed Survey Information 
Surveys allow the creation of a database for the recording of large amounts of historical 
data.  This section explains the structure of a survey and its capabilities.  This section 
does get quite detailed, but this overview will help in understanding how surveys 
organise the data they record, ways of accessing this data, and the effect of influences 
such as time changes. 

An illustration will help at this point, see Figure 17-10 below. 

 Channel 0 
(Status) 

Channel 1 Channel 2 Channel 3 … Channel M 

Record 0       
Record 1       
Record 2       
Record 3       
…       
Record N       

• Figure 17-10 Survey storage structure. 

A survey consists of a number of records, each record then consisting of a number of 
channels (channels are called fields in database terminology).  Each channel stores one 
particular quantity, and each record therefore stores a record of the values of those 
quantities at a specific moment in time.  For example a load survey may have channels 
for Wh and varh, with records at 15-minute intervals. 

There may be up to 256 channels in a survey.  Each channel may be of any width and of 
any data type, with the only constraint being that the total width of all channels must be 
less than 65536 bytes.  Each channel has a source register.  When a record is stored, the 
source register for each channel is read and the returned value is stored into that channel 
in the record. 

The first channel (channel 0) of a survey is always used to record the status of the 
record.  The information is stored in a 16-bit integer (type ‘H’).  This consists of a set of 
flags that record the state of the system since the last record, and flags indicating the 
validity of the record.  A complete list follows in Table 17-4. 
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EziView 
Code 

Bit Meaning 

K 0 An error occurred reading one of the registers.  One or more channels of 
the record will be wrong. 

A 1 Filled entry – no data.   
If bit 3 is set as well, then this interval was lost due to a survey rewind, 
caused by a backwards time change. 

P 2 Power failed during interval.  This is set in the interval where power 
was lost, not where it just continued to be lost or was restored.  The I 
flag will be set for all intervals where power was not present, lost, or 
restored. 

I 3 Incomplete interval.  Caused by power failure or time change at some 
time since the last entry. 

D 4 Daylight saving was in effect. 
L 5 Calibration lost.  Meter was not calibrated. 
W 6 S,V,F,R or M alarm failure (any or all). 

S – Asymmetric Power 
V – Voltage Tolerance Error 
F – VT Failure 
R – Incorrect Phase Rotation 
M – Reverse Power 

U 7 User (U flag) alarm failure – User flag. 
B 8 Data check sum error – this record should be treated with caution. 

 9-15 Unused. 
• Table 17-4 Alarm names and flag letters. 

 

Note that EziView displays the flags as the right-most column when using a reading file. 

The number of records in a survey in theory may be over 4 billion, but in practice is 
limited by memory availability. 

There are two basic types of survey, each best suited to a particular use.  These are 
variable interval and fixed interval. 

A variable interval survey simply stores a record when triggered.  The interval between 
two triggers may be anything.  Generally time is stored in this type of survey in a 
channel using the 0000F080 register, which is 4 bytes wide.  This type of survey is good 
for things such as event logs and billing reset histories.  Functions exist via the 
command line interface to search for a record by time, based on the 0000F080 channel, 
or on another time channel if present. 

In contrast, a fixed interval survey stores with a fixed interval between records.  The 
interval is specified in the survey set up, and the meter will ensure that each interval is of 
the specified length by filling, rewinding, or even restarting the survey to cope with time 
changes and power failures.  Because the start time and recording interval of the survey 
is known, the time of any entry can be determined from the entry number, and no 
channel need be ‘wasted’ to record the time of the record.  This type of survey is best for 
load surveys and other situations where readings must be taken at set intervals.   
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Each record in a survey has a 32-bit record number, with record 0 being stored at the 
start time of the survey (stored when the first entry is triggered).  This way each record 
has a unique number which should never ‘wrap around’ (32-bits gives over 130 years at 
1-second intervals). 

The incomplete interval flag is set if a time change or a power failure occurred between 
the previous entry and this entry.  The first entry is always marked incomplete.  At times 
this may seem confusing for variable interval surveys.  For example, in the case of an 
event log the fact that there were incomplete intervals in the time between events has 
little meaning.  Incomplete interval flags are mostly useful for fixed interval surveys, 
where recordings are usually continuous.  

Another major setting for a survey is for how it deals with running out of space.  The 
number of records a survey has is specified as part of the setup.  When a survey records 
this many entries it has one of two choices.  The first is simply to stop recording data 
until the survey is cleared.  The second option is to start overwriting older records.  The 
record numbers are preserved, but older records simply become unavailable.  These two 
types are called no cycling and cycling respectively, and is part of the survey set up. 

Surveys are triggered to store either by an event such as a billing reset, or from another 
script.  For instance, load surveys usually consist of two scripts – one is the survey, the 
other controls the accumulation of data and triggering at the right time intervals. 

The Effect of Time Changes 

The most difficult part of load surveys is in handling time changes.  Note that a power 
outage is simply a time change, but causes the P flag to be set as well. 

Time change forward:   

• If the time doesn’t go past the end of the current interval there are no special effects. 

• If the time change goes past the end of the current interval, the current interval will 
be closed off (stored, calculated etc) and a new interval will be started.   

• If the change crosses more than one interval, the in-between intervals will be filled 
with zeros, and marked as filled.   

• If the time change is more than the number of entries the survey can record, the 
survey will be cleared and restarted. 

Time change backward:   

• If the time doesn’t go past the beginning of the current interval there are no special 
effects. 

• If the time change goes past the beginning of the current interval but not into the 
interval before that, there are no special effects.  (The current interval is the active 
interval, even though the time is before it started.  This allows time changes back 
over to just into the previous interval to put the energy into the currently being 
calculated interval.) 
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• If the time change goes past the beginning of the interval before the current interval, 
the current interval will be stored, then this interval and the intervals between it and 
the new time will be deleted.  A new interval is then started in the time period that 
the new time specifies.  

• If the change crosses more than one interval, the in-between intervals will be filled 
with zeros, and deleted.   

• If the time change goes to back more than an interval before the survey started, the 
survey will be restarted at the new time. 

Reading Survey Status 

More information on  survey type extensions can be obtained by right-clicking on the 
extension and selecting Info.  A dialog similar to the one below will be displayed 
(Figure 17-11). 

 
• Figure 17-11 EziView survey extension information dialog. 
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The top section gives a large number of statistics about the extension, most of which are 
for internal use only.  The table below (Table 17-5) lists the important ones. 

Line Description 
Mode This gives the cycling/no cycling, fixed/variable mode. 
Number of Entries The number of entries the survey can store. 
Number of Records The number of records stored in the survey. 
Stored Entries The number of records stored from the Start time. 
Number of Channels The number of channels of information stored. 
Interval For Fixed mode surveys this is the interval between records in 

seconds.  Otherwise it is ignored. 
Record Size The total size of each record in bytes. 
Start Time The time of record zero. 

• Table 17-5 EziView survey extension channel statistics. 

The bottom section of the dialog is a table that gives information about each channel.  
Table 17-6 lists the meanings of this information, with the most useful information 
shown in bold. 

Statistic Description 
Name This is the name/title of the channel.  Displayed in downloaded 

surveys as the name of the channel. 
Register This is the source register of the channel.  May be useful in 

problem solving, but usually will be of little use. 
Size This is the size in bytes of the channel. 
Type This is the data type of the channel’s data. 
Units The units displayed if the channel is shown on the LCD etc. 
Offset The offset from the start of the record of the channel. 
Scale The scaling code, internal use.  Used to get the scaling factor. 
Scaling Factor The factor to scale between stored and real world values for 

some data types. 
• Table 17-6 EziView survey extension statistics. 

Reading a Survey 

Reading the data from a  survey type extension is best done using a reading file.  See 
Chapter 23, EziView Reading Files. 
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To quickly download a survey simply right-click on the survey and select Download.  
EziView will display a dialog like that of Figure 17-12 to select a filename to save as.  
The survey will be saved as a standard survey text file with the name provided.  For 
details on the format see Chapter 23. 

 
• Figure 17-12 Download survey save dialog. 

Reading Survey Value Registers 

The last 256 entries in a load survey can be read out as registers.  This is most useful for 
LCD displays or EziPort.  The register number is made up of the extension number, 
followed by a 2, followed by two digits of the channel, followed by two digits of the 
entry.  An entry number of 00 is the most recent entry, an entry of FF is 255 entries ago. 

That is xxx2aabb, where xxx is the extension number, aa is the channel, and bb is the 
entry number. 

If the entry or channel specified does not exist, the meter gives a “register does not 
exist” error.  Of course as the survey fills new registers are brought into existence. 

Where from here? 
The following chapters explain the usage of the EziView Toolbox, and the various 
EziScript extensions that it makes available for use with the meter. 
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Chapter 18 Toolbox 
EziView Toolbox is a connection of EziScripts, referred to as Tools.  Each basic tool 
can be customised to the individual application.  For example, there is a load survey 
tool, a billing reset tool, and a modem tool.  Once customised, Toolbox creates a TBX 
file, which contains the new tool.  These customised tools may then be added to the 
setup of the meter.  Existing tools may be used as a basis to create new tools. 

Tool Selection 
When creating a new tool, the first thing to select is the tool to use.  This is done on the 
tool selection dialog (Figure 18-1). 

 
• Figure 18-1 Toolbox Tool selection dialog. 

The tools available are listed down the left hand side of the dialog.  More tools will 
become available as development continues. 

As each tool is selected the right hand side of the dialog gives a brief description and 
any feature requirements needed to use the tool.  Most of the tools require particular 
extended feature codes to be active on the meter to operate. 



  

   

Selecting a tool and double clicking it or clicking OK will load the dialog for the tool.  
Clicking Cancel will return to the EziView setup page. 

Tool Setup 
For the purposes of explaining some of the more general features we’ll look at the event 
log tool (Figure 18-2). 

 
• Figure 18-2 Event Log dialog. 

Every tool has a similar format.  Most of the dialog is devoted to the custom settings for 
the tool.  However, all tools have the same three buttons.  

The OK button goes ahead and creates a new tool with the indicated configuration.  It 
will be added to the list in the EziView extensions setup page.  The Cancel button will 
abort the tool creation and return to EziView. 

The Properties button allows a number of standard properties to be adjusted.   
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Tool Properties 
The properties dialog is the same for all tools. 

Settings 

Figure 18-3 shows the settings page of the properties dialog. 

 
• Figure 18-3 Toolbox Properties, Settings page. 

The Script Name is the name that will be used to identify the tool you have created.  It is 
used as part of the filename for the TBX file, and as the name displayed by EziView.  It 
is displayed at the top of the tool customisation dialog. 

The User Group is the user group that this tool will use to access registers and features 
within the meter.  A tool must have access to all the facilities it needs to function.  Note 
that most tools need access to themselves to work properly.  Either select a group from 
the list, or enter the number of the group.  See Chapter 16 for more information on 
security. 

The list of user groups is taken from the current settings in the security setup page.  It is 
the user group number that is stored with the tool.  If the groups are rearranged in 
EziView after the tool is created, the tool will be in the same group number as it was 
created with. 
 

Access to the Security Group is required for operations to be performed on the tool once 
in the meter.  This includes deleting the tool, reading the tool settings, and retrieving 
results from the tool.  One of the security groups reserved for tools may be selected from 
the drop down box.   

If you are having problems with a tool not functioning correctly, check the security 
properties.  This is the most common cause of problems. 
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The Flash Backup setting determines if and how this tool will be backed up to FLASH 
memory.  This is very important if there are times when the meter will not have a 
battery fitted.  All EziScript extensions (which is of course what tools are) are stored in 
battery backed up memory so that they and their accumulated data are not lost during a 
power outage.  This does not protect against the battery being removed however, which 
is particularly important if meters are going to be setup, then stored with the battery 
disconnected.   

There are several levels of battery backup.  This is to balance the fact that there is only a 
limited amount of FLASH memory, around 32KB.  This prevents large items such as 
load surveys from being completely backed up, but their setup still can be. 

Mode 0 – extension stored in battery backed RAM does not back up any of the tool to 
FLASH. 

Mode 1 – extension is backed up, all data is lost backs up the tool itself to FLASH, but 
none of its data.  This is the minimum setting if you have a situation where meters will 
not have a battery fitted at some time after setup. 

Mode 2 – extension/registers backed up backs up the tool and its registers to FLASH.  It 
does not however back up any survey data.  For tools without surveys this has the same 
effect as Mode 3. 

Mode 3 – extension/registers/survey backed up backs up everything, including surveys.  
This option should be used with care as surveys can be quite large.  Generally it should 
only be used with small surveys, such as billing history and perhaps event logs. 

Selecting the right modes will prevent against data loss in the case of a removed or flat 
battery when the main power to the meter is not present.  If the meter runs out of 
FLASH memory, not all extensions requesting flash storage will be stored to flash.  The 
meter will skip any extension that will not fit.  

The GUID is a totally unique identifier created by toolbox for this tool configuration.  
This code allows the tool to be tracked, and forms part of the TBX filename.  Two tools 
created with the exact same settings will still result in different GUID’s.  It cannot be 
edited. 
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Description 

The description page allows a description to be entered for the tool.  This is the 
description that will be displayed at the bottom of the EziView extensions setup page.  
Figure 18-4 shows the description page. 

 
• Figure 18-4 Toolbox Properties, Description page. 

The default description is a simple note on the author and the tool.  Clicking the 
Generate button creates a description based on the settings that are currently active for 
the tool.  Figure 18-5 shows an example of the results. 

 
• Figure 18-5 Toolbox Properties, Description page with generate. 

In any case, this description can be edited to say what you want.  Note that clicking the 
generate button again will update the description, but will delete any changes you have 
made. 

  Toolbox  18-5 



  

   

About 

The about page simply displays some version information about this tool, used by 
EDMI for version tracking.  Figure 18-6 gives an example page. 

 
• Figure 18-6 Toolbox Properties - About page. 

This information may be requested by EDMI when obtaining technical support. 

Tools 
The following chapters cover a range of tools provided by Toolbox.  They are broken up 
into two main groups – those that are a data recording type using a survey, and those 
that provide direct control.  More complex tools such as the modem have their own 
chapter. 
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Chapter 19 Survey Tools 
This chapter covers all of the general tools that record information in a survey.  These 
are at present: 

• Load Survey 

• Billing History 

• Event Log 

• Sag/Swell Log 

Work is ongoing on creating new tools.  Contact EDMI for more information. 

The preceding 2 chapters should be read before this chapter as knowledge of them is 
assumed.   



  

   

Load Survey 
The load survey tool allows data to be recorded from the meter over a series of fixed 
intervals.  Other names for this function include load profile and demand log.  Figure 
19-1 shows the setup dialog. 

 
• Figure 19-1 Load Survey tool. 

A load survey is made up of a number of channels, each recording a particular quantity.  
The quantities are calculated over the recording interval, and a new entry for each 
channel is stored at the end of each interval. 

Most of the dialog is devoted to the channel setup.  The right hand panel Survey Settings 
contains the settings that affect the whole survey. 

Number sets the survey number.  The tool allows for up to 10 different surveys to be 
running in the meter at any one time.  These are called Survey 1 to Survey 10.  Each 
different survey uses different extension numbers so that conflicts do not occur.  The 
extension numbers are 030 and 031 for survey 1, 032 and 033 for survey 2, etc.  The 
even number is the survey. 

There is another option called MV-90.  This is for use in conjunction with the MV-90 
program.  There are a limited number of options when using MV-90 mode due to the 
restrictions of MV-90.  See Appendix A for more information.  Extension numbers 003 
and 004 are used for this option. 

The Interval setting controls the time between successive entries.  The setting is in 
minutes, with a minimum of 1 minute.  It is recommended to made this setting an even 
subdivision of an hour, but not required. 

The Period setting is the number of days to record for.  The maximum setting is only 
limited by the memory of the meter. 
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Between the Interval and Period settings Toolbox calculates the number of entries that 
will be in the survey.  This is the Entries readout.  Toolbox also uses the channel setup 
and calculates the approximate size of the resulting tool (Estimated Size) when loaded 
into the meter. 

Channels 

The Channels setting allows setup of what is to be recorded.  The list under the 
Channels heading shows what channels are to be recorded.  Clicking the Add button 
adds a new channel to the list.  It will have the same settings initially as the selected 
channel when Add was clicked.  The number of channels is limited to 30. 

Selecting a channel displays its settings in the tab pages.  To change the settings for a 
channel, simply change the radio button settings and tabs.  Whenever settings are 
changed, the name of the channel listed will update to reflect the new settings.  This 
default name can be changed manually by simply selecting the text and editing it (up to 
30 characters long).  The name listed will be the name of the channel when EziView 
downloads the survey. 

To remove a channel from the list, select the channel and click the Remove button.  To 
remove all channels hold the shift key down when clicking the Remove button. 

Available Channels 

There are two broad types of channels – Energy and Instantaneous.   

Energy channels record the energy accumulated during each recording interval. Select 
the Energy tab page.  The type of energy, the source and the direction can be selected.  
Refer to Figure 2-16 and the accompanying text on page 2-20 for an explanation of 
direction conventions.   

 
• Figure 19-2 Load Survey tool, Instantaneous page. 
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The Instantaneous page (Figure 19-2) allows the recording of quantities like power, 
voltage, and current.  Quantity allows the raw quantity to be selected.  Phase selects 
which phase the reading is from for many of the quantities.  Processing selects how the 
intervals data will be processed. 

All the calculations are performed on approximately 1 second readings.  The minimum 
setting records the minimum of these 1 second readings over the recording interval.  The 
maximum performs a maximum of the same data.  The average setting records the 
average of the 1 second readings over the interval. 

Be careful when measuring average power factor, as the sign of the power factor is used 
to determine lead or lag, so if a load is crossing the boundary results can be confusing. 

The average of angles is performed correctly with account taken of the discontinuity in 
angle at 180 degrees. 

 
• Figure 19-3 Load Survey tool, Pulsing Inputs page. 

The Pulsing Inputs page (Figure 19-3) allows the selection of pulsing inputs as a source 
to the load survey.  The inputs must be set as Pulsing and should have appropriate 
scaling factors set – see Chapter 11, “Pulsing Inputs” for information on these settings. 

The Unit should be set so that the correct unit can be reported by the survey – it has no 
effect on data recording. 
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Billing History Tool 
The billing history tool is used to extend the TOU system (Chapter 13).  Normally the 
TOU system only records historical information for the last billing period.  The billing 
history tool allows the data to be logged for many more billing periods.  It does this by 
storing selected data items in a survey when billing resets occur.  Figure 19-4 shows the 
setup dialog. 

 
• Figure 19-4 Billing History tool. 

The structure is similar to the load survey tool.  The big difference is that stores occur 
when a billing reset occurs, not at a specific time interval.  The other difference is of 
course that different data is available for recording. 

The left hand Readings pane lists the reads to be recorded.  The number in the box 
besides each entry indicates the channel number, 1 to 12.  The name is automatically 
generated, but can be edited.   

The rest of the dialog shows the settings for the selected reading.  Clicking Add adds a 
new reading with the same settings as that selected.  Clicking Delete deletes the selected 
reading, and clicking Delete with the shift key down will delete all readings. 

The Meters Channel Name selects which TOU channel to record for the selected 
reading.  The names are taken from the TOU channel setup page in EziView. 

The Type section selects the type of reading to take – Energy, Maximum Demand, or 
Time of Maximum Demand. 

The Rate setting selects which rate to record in the reading.  The Entries setting sets 
how many previous periods will be recorded.  Estimated Size gives an estimated size for 
the tool when in the meter. 
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The Interval setting selects whether to take a reading of the value over the billing period, 
or to take a reading of the cumulative value over ‘all’ time.  Figure 19-5 gives an 
illustration of the billing history. 

Current Previous 1 Previous 2 Previous 3 Previous 4 Previous…  

      

• Figure 19-5 Billing Period Diagram. 

The Current period is data form now back till the last billing reset.  The Previous x 
periods are periods between billing resets.  The Previous… period is all previous data 
back to when the TOU system was cleared. 

A setup with Entries set to 4 would record data for the 4 numbers periods shown.  If 
Interval is set to Period the data recorded between the two billing resets that surround 
the period is recorded.  If set to Cumulative, the cumulative data at the time of the last 4 
billing resets is recorded.  Cumulative data is data since the TOU system was cleared. 
Time of Max. Dem. is not available for cumulative readings as it has no meaning. 

Notes 

Generally the size of this tool is quite small because the data rate is so low.  This allows 
it to be setup for FLASH backup if so desired. 

The extension number for the survey is 001. 

To display the previous periods on the LCD or read them out individually the survey 
recent data registers can be used.  For this tool the register number format is 0012aabb.  
The aa is the reading, 0 being the reading status, then 1 onwards is the readings in the 
order listed in the tool.  The bb is the reading number, 0 being the most recent reading. 

Note that before a reading has been recorded, the recent data register for it does not exist 
and will display on the LCD as undefined. 
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Event Log Tool 
The event log tool logs various events that occur in the meter into a survey.  The survey 
records the time of the event, and an up to 40 character description of the event.  Figure 
19-6 shows the settings dialog. 

 
• Figure 19-6 Event Log tool. 

The number of events to record is set by the Entries parameters. 

Events are divided into several groups.  The Event Groups setting allows the groups to 
be included in the event log to be selected.  Table 19-1 lists all the events and their 
grouping.  The diagnostic group should not normally be used unless requested by EDMI 
for support purposes. 
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Event String Group Description 
Power Off SYSTEM The time the meter was turned off.   

Power On SYSTEM The time the meter powered up. 

Recovered XXXX SYSTEM The battery backed up copy of the indicated 
parameters was lost, but the information was 
retrieved from the data FLASH memory.  May 
indicate a low battery. 

Initialised XXXX SYSTEM Both the battery backed up copy and the data 
FLASH copy of the indicated parameters was lost.  
The parameters have been initialised to default 
values.  May indicate a fault in the FLASH, 
shutdown sequence setup, or power supply.  Check 
for “Shutdown Complete” message on the LCD 
when power is disconnected. 

Recovering Extensions… SYSTEM The battery backed up memory that holds the 
extensions was lost.  The system is recovering the 
extensions that are backed up to the data FLASH. 

Recovered Ext XXX SYSTEM The indicated extension was recovered from the 
data FLASH.  The amount of information recovered 
depends on the backup setup of the extension. 

PORT: Logon User 
USERNAME 

SETUP User USERNAME logged on via the indicated port.  
A USERNAME of Anon means the user name is not 
known. 

PORT: USERNAME 
changed XXXXXX 

SETUP User USERNAME changed a setting in the 
XXXXXX group, via the indicated port. 

PORT: Logoff: Access 
Denied 

SETUP A user was logged off the indicated port because of 
a bad password. 

PORT: Logoff: User 
Request 

SETUP A user was logged off the indicated port because a 
log off was requested by the X command. 

PORT: Logoff: Timeout SETUP A user was logged off the indicated port because of 
an inactivity timeout.  

PORT: Logoff: Lost 
Connection 

SETUP A user was logged off the indicated port because of 
a lost connection. 

PORT: Logoff: User ID 
change 

SETUP A user was logged off the indicated port because a 
login under another name occurred. 

PORT: Logoff: Requested SETUP A user was logged off the indicated port because a 
logoff was requested via a register write. 

Changing System Time… SYSTEM These two events occur in pairs to show the extent 
of a time change. 

...System Time Changed. SYSTEM  

EFA: XXXXXXXX SYSTEM The indicated EFA was latched. 

EFA Conditions Cleared SYSTEM The latched EFAs were cleared. 

Firmware vX.XX changed 
to vY.YY 

SYSTEM The meter’s firmware was changed. 

Automatic Billing Reset BILLING An automatic billing reset occurred. 

Manual Billing Reset BILLING A manual billing reset occurred (Either by register 
access or via the billing reset button). 

TOU Cleared BILLING All TOU information cleared. 

Modem Port Overflow - 
Buffer Purged 

DIAG Diagnostic error. 

XXXXXXXXXXXXXXXX USER The event string was written to the FC68 register. 

• Table 19-1 Event Log events and groupings. 
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Writing a string to register FC68 will manually create an event in the USER group, with 
a time stamp of the current time. 

The groupings of setup are based on the security groups, and are designed to correspond 
with EziView setup pages.  A setup change event is generated when a write is 
performed on the indicated groups for the first time in a logon session.  Table 19-2 lists 
the setup groupings. 

Setup Group Security Groups 
Alarms 18, 25, 26, 117 - 121 

Calibration 65, 67 – 77 

Eziport 205 

Com ports 103 - 114, 206 

Time window 102 

LCD screens 78, 85 – 89 

Inputs 22, 188 – 193 

Outputs 146 – 154 

Security 123, 124, 137 - 143 

System parameters 3, 4, 5, 11, 12, 13 

TOU times 91 

Time setup 94, 187, 203 

TOU setup 122, 136 

Ratios 6, 66 

Extensions 198 

• Table 19-2 Event Log setup change events. 

The event log has an extension number of 005. 
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Sag / Surge Tool 
The Sag / Surge tool provides the ability to monitor the voltage phases for sags and 
surges every second.  If the voltage is outside the set limits, the meter will record how 
long it was out of tolerance in seconds, the worst voltage, and the current at the time of 
the trigger on the corresponding current phase.  Figure 19-7 shows the setup dialog. 

 
• Figure 19-7 Sag / Surge tool. 

The Phase setting allows the selection of the phases to be monitored.  For instance, in 2 
element mode there is no reason to record phase B. 

The Surge and Sag set the limits for the voltage.  If the voltage goes this far outside the 
nominal value an event will be triggered.  The nominal value is the value set on the Alarms 
setup page. 

Hysteresis sets the amount the voltage has to be back inside the limits before the event is 
deemed to be over.  For example, with the settings of Figure 19-7 the voltage would stop 
triggering once it dropped below 3% of nominal on the side of the trigger.  If the voltage 
crosses from one side to the other it is deemed to have finished one trigger and started 
another. 

Hysteresis cannot be set larger than either the surge or the sag setting. 

Entries sets how many events will be recorded. 

The High Speed option, when ticked, forces the meter to use the meter’s inbuilt Sag / 
Surge options as defined in the Alarms Setup Page in Chapter 15. 

Each of the phases is treated independently.  Multiple phases can trigger at once and are 
stored as separate events.  As well as the duration (in seconds as a 32 bit number), the 
worst voltage and the current at trigger, the tool also stores the phase that caused the 
trigger.  The numbers 0, 1, and 2 indicate phases A, B and C respectively.  

The time stored in the survey is the time at which the event completed.  This may cause 
some confusion in the order of the events when multiple triggers occur. 
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Chapter 20 Control Tools 
There are no pure control tools available at this time.  Check with EDMI for new 
releases. 
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Chapter 21 Modem Control 
This chapter describes how to configure the EDMI Genius Energy Meter for use with a 
modem.  

Required setup components 
The following is required for modem operation: 

• A Genius Energy meter with the modem port option. 

• A Hayes compatible modem. 

• A cable to connect the modem to the meter. 

• The Modem tool must be loaded into the meter. 

• The meter must be configured for the modem using EziView.  

Compatible Modems 
The meter is designed for use with modems that use the Hayes AT  command set to 
control the modem.  The modem should have an RS-232 connection, which must 
include the signals Ground, Tx, Rx, DCD, and DTR.  The hardware handshaking 
signals RTS and CTS are also supported. The meter does not use the RI signal. 

The modem must be able to support  

• No command echo 

• Hang up on DTR drop 

• DCD follows carrier detect 

• Auto answer 



  

   

Connection Requirements 
The RS-232 port on the meter is a male 9 pin D-type connector designed to connect 
directly to a modem using a standard modem to PC cable.  Full hardware handshaking is 
supported.  See Table 2-3 for connection details. 

Terminal Description 
TB10-1 DCD* 

TB10-2 RX* 

TB10-3 TX* 

TB10-4 DTR* 

TB10-5 GND* 

TB10-6 NC 

TB10-7 RTS 

TB10-8 CTS 

TB10-9 NC 

• Table 21-1 RS-232 connections  

The starred items are required connections.  RTS and CTS should be connected if 
available to allow hardware flow control.  

Care should be taken in choosing a cable for connecting to the meters connector as the 
terminal cover can interfere with some sizes of plug. 
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EziView Configuration 
EziView must be used to configure the meter to use a modem and to customise the 
meter for a particular modem.  Figure 21-1 shows the relevant setup page in EziView.   

 
• Figure 21-1 EziView Modem setup. 

The Modem section of the page allows the communication parameters and the modem 
setup strings to be configured. 

Communication Parameters 

The Baud Rate, Data Bits, Parity and Stop Bits may be left at the defaults of 9600, 8, 
None, and 1 for most modems.  Faster or slower baud rates may be set to more closely 
match the speed of the connection.  When hardware flow control is used, the Baud Rate 
can usually be set to 19200. 

Handshaking should be set to RTS/CTS Flow if the RTS and CTS lines are connected 
and the modem is configured for hardware flow control.    If this is not the case 
Handshaking should be set to Normal. 

Access should be set All. 

XON/XOFF should be cleared unless flow control is needed, hardware flow control is 
not possible, and the modem is configured for XON/XOFF flow control. 

The DTR/DCD box should always be checked. 
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Fitted should be checked to indicate that the port is fitted. 

The Default User Level should be set to –None-. 

Modem Setup 

Type should be set to Normal Modem for most circumstances.  The meter will send the 
initialisation string to the modem regularly.  For some modems this causes problems.  In 
this case the Modem No Init setting should be used and the setup string for the modem 
should be written permanently to the modem using a PC.   

Response should be set to the response received when a valid command line is received 
(generally 'OK') 

The initialisation string must include the AT and: 

• It must also turn echo off (generally E0) 

• It must set auto answer to on (S0=x, where x is the number of rings before answering 
and is not zero) 

• It must be set to go on hook and return to command state when DTR drops (&D2) 

• It must set DCD to follow carrier when modem is online (&C1) 

• There may also be a command for modem flow control (&K2) 

This gives a string such as “ATE0S0=3&D2&C1” for no flow control.  These 
commands are common for most modems, but some modems use slightly different 
commands.  See your modem manual for details. 

The Reg. Init and Dial fields are unused. 

The time between sending the initialisation string is 60 seconds.  After 5 failed attempts 
at initialisation the meter will set the modem EFA but keep trying to initialise it. As soon 
as the modem responds the EFA is cleared and the failed counter is zeroed. 

The script does not turn DTR/DCD handshaking on (&C1 turns it on for most modems) 
or RTS/CTS flow control (&K2 turns it on for most modems) on. These must be setup 
in the initialisation string in EziView. 
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Modem EziScript 
In order to support the widest range of modems, communication with the modem is 
handled using an EziView Toolbox tool – an EziScript.  Before using a modem the 
meter must be loaded with this tool.  See Chapter 17 and Chapter 18 for information on 
loading tools.  Figure 21-2 shows the Modem Control tool. 

 
• Figure 21-2 Modem tool. 

The modem tool may have been provided as a separate EziScript file in older 
installations.  The use of the Extended Modem Control option is covered later in this 
chapter. 

If you need to communicate directly (e.g. using a PC) with the meter using the RS-232 
port while the modem script is installed the DCD line must be asserted. 

 

Trying it out 
The meter should now be ready to access remotely.  When the meter powers up the 
LCD should display “ModemScript v1.5” on the top line (or a later version number).  
The bottom line should show “Initing Modem”, which will change quickly to “Inited 
Modem” if the modem has responded to the initialisation string with the specified 
response string (generally “OK”).  If this does not occur, check the setup and 
connections, and that all the commands in the initialisation string are supported by your 
modem. 
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Try ringing into the meter using EziView.  You’ll need to set a modem as the 
connection method and a phone number to dial. (See Figure 21-3). 

 
• Figure 21-3 EziView Site Properties Setup. 
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These are fairly normal dialing properties for Windows.  The Configure button will let 
you configure the modem attached to the computer.  To change dialing location details 
use Tools → Location (Figure 21-4).  

 
• Figure 21-4 Dialing Location Properties. 

When the modem is ringing the meter should display “RING” on the LCD for each ring.  
If it does not, check that the modem is set up to send the string “RING” when a ring is 
detected.   

When the modem answers the meter should display “Modem Connected”.  EziView 
will then log into the meter and it can be used remotely.  If the modem does not answer, 
check the auto answer settings in the modem initialisation string. 

When disconnecting using EziView the modem will hang up.  The meter will display 
“Modem Hung Up” when carrier is lost. 

The meter is now properly configured for use with a modem. 
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Enhanced Modem Script 
The enhanced modem script option allows each of the outputs from the meter to be used 
to turn off power to the modem.  This is useful with non-industrial modems that are 
prone to latch-up after prolonged operation.  While the modem is turned off the meter 
will not attempt to talk to it, preventing erroneous modem EFA’s.  Figure 21-5 shows 
the tool. 

 
• Figure 21-5 Extended Modem Control Tool. 

The output to use to control the modem is selected by the Output setting.  To use the 
enhanced modem script the meter must have an enhanced modem feature code.  For this 
script to work additional setup must be performed.  The output and the turn off period 
must be configured. 
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Output Setup 

The output configured for use in the Modem Control tool must be configured as a Fixed 
Output.  (See Figure 21-6, e.g. Output 3) 

 
• Figure 21-6 EziView Pulsing Output Properties Setup. 

With the Inv box cleared the relay will close when the modem is to be turned on.  If this 
is the wrong way around for your application the Inv box can be checked to change the 
polarity. 
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Time Window 

The Time Window setup page is used to configure when the modem is to be turned off 
(see Figure 21-7).   

 
• Figure 21-7 EziView Time Window Properties Setup. 

The Type, Start, End and D settings have the same usage as in the TOU system – see 
Chapter 13 for more information on these.  The Access setting indicates whether the 
modem is to be enabled or disabled by this entry.  By default the modem is Permitted.  
Denying access turns off the modem for that period.   

The Optical and EziPort boxes should be unchecked, and the Modem box should be 
checked. 

The example in Figure 21-7 will turn off the modem between 2pm and 3pm every day. 
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Part IV Advanced Topics 
 

his section covers topics in some of the more advanced usages of the meter that 
have not been covered so far.  The chapters in this section may be read in any 
order, but familiarity with the previous parts of the manual is assumed. 

 

T 
• Chapter 22: “Testing” 

• Chapter 23: “EziView Reading Files” 

• Chapter 24: “EziView Script Files” 

• Chapter 25: “Summation” 
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Chapter 22 Testing 
There are two main ways to test the accuracy of the meter.  These are via pulsing 
outputs, or via gated energy.  Use the method that best suits your testing system. 

Using the Pulsing Outputs 
The easiest way to test the accuracy is to use a pulsing LED (or pulsing output) from the 
meter.  The testing is then performed as it would be for a rotating disk (Ferraris-type) 
meter. 

Pulsing outputs are configured using EziView.  For best results the pulse rate should be 
no faster than 10 pulses per second.  The test time should be at least 10 seconds. 

Using Gated Energy 
The meter has the ability to measure the energy between two gating pulses.  This allows 
testing against another standard such as Radian RM-10’s that also has a gating 
capability.  The meters are gated for the same period of time, and the readings are then 
compared. 

This method of testing is only feasible if a gate input can be supplied to the meter and 
the standard being tested against.  Another method is to gate the meter using the energy 
pulses from another meter. 



  

   

The gate can be fed into the meter either optically or via input 1.  The settings for the 
gate input are in the Gate Configuration section of the Pulsing Input page in EziView 
(see Figure 22-1). 

 
• Figure 22-1 EziView gate configuration. 

The Gate Configuration settings bypass the pulsing input settings in the top half of the 
setup page.  Table 22-1 lists the possible modes.  Usually only Normal and Pulsed with 
Reset modes are used with hand testing. 

Gate Mode Usage 
Normal When the gate input goes on, the gated energy registers are reset to 

zero and then begin to count up.  When the gate input goes off, the 
gated energy registers stop accumulating energy.  The test time must 
be at least 100ms 

Pulsed Designed primarily for use with automated systems using command line 
control of register F0B1, the gate is controlled by the falling edge of 
pulses on the gate input.  When the first pulse arrives, F0B1 is 
decreased by one and the gated energy registers are reset to zero then 
allowed to accumulate energy.  After the number of pulses specified by 
the F0B1 register, the gated energy registers stop accumulating energy.  
No further pulses will have any effect until F0B1 is written with a new 
value.  The minimum pulse width is 4ms, minimum test time is 100ms. 

Pulsed with 
Reset 

This operates in a similar manner to Pulsed mode, except that after 
F0B1 has reached zero another pulse will reset F0B1 to its original 
value.  This defaults to two at power on, giving a pulse start, pulse stop, 
pulse reset operation.  This is useful for testing the meter against a 
Radian RM-10 or similar.   The minimum pulse width is 4ms, minimum 
test time is 100ms. 

• Table 22-1 Gating Modes  
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Source allows the source of the gate to be selected from either input 1 or the optical gate 
input.  The optical gate input is an infrared receiver input accessed though the EziPort 
recess.  This can be triggered by an infrared LED, or some other infrared source.  Some 
visible LED’s may also be able to activate it. 

The normal sense of input 1 is gate off.  The normal sense of the optical gate input is no 
light.  The invert option allows the sense of the gate to be reversed.   

The current gate input can be viewed in the Online Variables → Gate page (see Figure 
22-2). 

 
• Figure 22-2 EziView Online Variables gate status. 

This page gives a lot of information about the gate input.  The Gate Status indicator will 
light up if the gate input is currently active (e.g. light is shining on the optical gate 
input).  The Gate Active indicator will light up if the meter is currently accumulating 
gated energy.  These indicators can be very useful in tracking down gate level and 
polarity problems. 

The Pulses box gives the number of pulses to count – this is the starting value for 
register F0B1 described in Table 22-1.  To change this value enter the new number into 
the Pulses box under Gate Setting.  Click the Set Meter button to confirm the change.  
By default Pulses will be 2, which gives the pulse on, pulse off action commonly used.  
It can of course be set to any value, useful if the gate is fed from the pulsing output of 
another meter.  

The Gate Override box allows the gate inputs to be overridden.  When this box is 
checked the gate is controlled by the Gate Status checkbox, normally greyed out. 
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To see the value of the gated registers, either display them on the LCD  or via the Gated 
Energy Status screen.  Figure 22-3 shows the current accumulated energy in the gated 
registers. 

 
• Figure 22-3 EziView Gated Energy status. 

The format button allows the number format to be changed, specified as a ‘C’ language 
like format specifier (the details of which are beyond this document).  The default 
format should be fine for just about all applications.  

Optical Gate Interface 
A convenient interface for the optical gate input is currently in development. 
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Chapter 23 EziView Reading Files 
Reading files are a method of generating reports from a connected meter.  EziView 
takes a user formatted text file that contains special control sequences.  These control 
sequences tell EziView which register values to insert to produce the final report.  
Reading files may be used for down loading surveys, reading TOU registers, and any 
other use where a report of values from the meter needs to be made.  

The use of reading files in EziView is covered first, followed by the structure of reading 
files so that you can create your own. 

Using Reading Files 

Reading files are registered with EziView by using the Tools → Options → Readings 
screen (Figure 23-1). 

 
• Figure 23-1 EziView Reading File Setup. 

The readings files registered with EziView are listed in the large pane.  The order they 
appear is the order that they appear on the meter menu.  Reading files can be removed 



  

   

from the list (does not delete the reading file itself) by selecting the entry and clicking 
the Remove button.  Entries can be moved around by dragging them with the mouse 
using the left button. 

To add a new reading file entry to the list use the Insert or Add buttons.  Insert creates 
the entry ahead of the currently selected entry.  Add creates the new entry at the end of 
the list. 

The name of the reading file to appear on the menu is entered under Menu Name.  This 
is also the name shown in the list.  The Filename is the reading file name and location.  
It can be selected using the browse button, or simply typed in.   

The notepad button causes the reading file to be opened by the default viewer (Notepad 
works quite well for this). 

The entries in the list are added to the Meter menu under the item Readings (Figure 
23-2) when the meter is connected. 

 
• Figure 23-2 Reading files on the meter menu. 

Selecting a reading causes the reading file to be processed and generates the output file 
as detailed by the reading file. 
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Viewing Reading Result Files 

It is very useful to be able to easily view the newly produced file.  To make this easier 
EziView allows viewing programs to be configured.  This is done using the Tools → 
Options → Viewing screen (Figure 23-3). 

 
• Figure 23-3 Reading File Viewing setup. 

Each entry in the list is a viewing option.  Entries may be added or removed using the 
Add and Remove buttons respectively.  The order they appear in the list is the order they 
appear on the meter menu.  To change the order drag the entries using the left mouse 
button. 

The menu name of an entry is the name that appears on the menu and in the list.  The 
Program is the viewing program to run when the option is selected.  The file is passed 
as an argument to the viewing program.  Extension should be the extension of the output 
of the reading file.  EziView uses this and the meter serial number or plant number to 
determine the filename to pass to the viewing program. 

The Reading File option allows the reading file to be processed before the viewer to be 
selected from those listed under the Readings tab.  Selecting None will stop EziView 
from processing a reading file first.  This is useful where you may want to view the 
same data with several different viewing programs. 
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After an entry is added to the list, it will appear in the menu of a connected meter under 
the Viewing option (Figure 23-4). 

 
• Figure 23-4 Selecting a Viewer. 

Selecting the option will process the reading file producing an output file, then open the 
viewing program with the name of the output file as an argument. 

The Print option does virtually the same thing as the Viewing option.  The difference is 
that a /P is added to the arguments of the viewing program.  On many programs this 
causes the program to print the file to the default printer. 

Example 

As an exercise of using reading files with EziView, create a TEST.RDS file with a text 
editor such as Notepad.  Enter the single line “[PCExtension.tst][f002]”.  Save the file, 
and then setup EziView to use this file as shown in the Figures of this section.   

Connecting to a meter and selecting the Viewing → Test Results option should result in 
Notepad being opened and displaying the serial number of the meter.  The following 
sections describe how to create your own reading files. 

Reading File Structure 
The EziView control sequences are enclosed in square brackets.  EziView searches the 
file for ‘[’ characters and processes the following characters as control sequences until 
the matching ‘]’.  This is compatible with Rich Text Format files, allowing highly 
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formatted files to be created.  Reading files should have the extension “.RDS”, although 
other extensions may be used. 

The reading file control sequences recognised by EziView are listed in Table 23-1. 

Sequence Description 
[Reg] Replaced with the result of reading register Reg. Uses auto 

format. 

[Reg;Format] Replaced with the result of reading register Reg with format. 

[Reg;Format;OutputFormat] Replaced with the result of reading register Reg with format, 
displaying the result with formatted using OutputFormat 

[Reg;Format;OutputFormat;
Offset] 

Same as above with an offset into a complex structure. 

[PCDateTime] Replaced with the current PC Date Time. 

[PCAppend] Always append to the output file. Do not use with RTF files. 

[PCOverwrite] Always overwrite the output file. 

[PCExtension.xxx] xxx is the extension of the output file.  Defaults to “.RDG” if this 
is not specified. 

[PCHeading]…[PCEnd] The in between text is only written when the output file is 
created. Do not use with RTF files.   
Control Sequences in the text will not be processed. 

[PCLoadSurvey.xxx] The Survey specified by the EziScript extension id xxx is 
retrieved from the meter. 
Only one of these sequences is permitted.  If more than one is 
present, only the last one will be used. 

[PCFloatFmt.xxx] Specifies the format for floating point numbers in a Survey only. 
Example “%6.3f” to format the number as xx.xxx. See Numbers 
and Strings for details. 

[PCFloatMult.xxxx] Specifies the multiplier for floating point numbers in a Survey 
only. Options are Kilo, Mega, Giga, Milli, and Micro. 

[PCCtrlEnd] Signifies the end of initial PC Controls. These are PCAppend, 
PCOverwrite, PCExtension, PCLoadSurvey, PCEventLog, 
PCSagSwell. The file is searched for these first, then the whole 
file is processed. If the file is large it is wasting time searching 
the whole file once all initial PC controls are found. 

• Table 23-1 Read file control sequences. 

There are basically two types of data that can be read – register values and survey data. 
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Register values – Format 

The format specifier is the same as in the Special → General Read screen. This screen 
can be used to become familiar with the way formatting works. Table 23-2 lists the 
available format characters. 

Format Description 
‘A’ Auto detect type. Display Bytes, Words, and Longs in Hexadecimal 

‘a’ Auto detect type. Display Bytes, Words, and Longs in Decimal. 

‘B’ Hexadecimal Byte 

‘b’ Decimal Byte 

‘W’ Hexadecimal Word 

‘w’ Decimal Word 

‘L’ Hexadecimal Long 

‘l’ Decimal Long 

‘F’,’f’ Float 

‘D’,’d’ Double 

‘S’,’s’ String 

‘T’,’t’ Boolean 

‘V’,’v’ Time 

‘X’,’x’ Date Time 

‘Y’,’y’ Binary Byte 

‘Z’,’z’ Date 

• Table 23-2 Format characters.  

The format can be followed by a number to specify the number of that type, eg “b3” is 
the same as “bbb”. If the number is omitted the default is the number of that type that 
can fit in the message, eg if the message is 2 bytes long, ‘b’ will display 2 bytes. 

Notes: 

• If no format is specified the default is ‘a’. 

• Auto format asks the meter what format the register is. This takes an extra message 
and is slower. Therefore it is recommended that the register format be specified. 

• Some registers have no simple type in the meter. In that case Auto doesn’t work. These 
are specialised registers that will probably never be used. 
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Register Values – OutputFormat 

The OutputFormat specifies how the value of the register is to be formatted and printed. 

Do not specify an OutputFormat when there are multiple types. For example 
“[F119,fbb,%6.2f]” will fail because the OutputFormat “%6.2f” will be applied to a 
Byte. 

 

Numbers and Strings 
Format specifiers have the following form: 

"%" ["-"] [width] ["." prec] type 

A format specifier begins with a % character. After the % come the following, in this 
order: 

 

• An optional left justification indicator, ["-"]. 

• An optional width specifier, [width]. 

• An optional precision specifier, ["." prec]. 

• The conversion type character, type. 

The Table 23-3 summarises the possible values for type: 
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Type Description 
‘d’ Decimal. The argument must be an integer value. The value is 

converted to a string of decimal digits. If the format string contains a 
precision specifier, it indicates that the resulting string must contain 
at least the specified number of digits; if the value has fewer digits, 
the resulting string is left-padded with zeros. 

‘e’ Scientific. The argument must be a floating-point value. The value is 
converted to a string of the form "-d.ddd...E+ddd". The resulting 
string starts with a minus sign if the number is negative. One digit 
always precedes the decimal point. 
The total number of digits in the resulting string (including the one 
before the decimal point) is given by the precision specifier in the 
format string--a default precision of 15 is assumed if no precision 
specifier is present. The "E" exponent character in the resulting 
string is always followed by a plus or minus sign and at least three 
digits. 

‘f’ Fixed. The argument must be a floating-point value. The value is 
converted to a string of the form "-ddd.ddd...". The resulting string 
starts with a minus sign if the number is negative. 

‘.’ The number of digits after the decimal point is given by the precision 
specifier in the format string--a default of 2 decimal digits is 
assumed if no precision specifier is present. 

‘g’ General. The argument must be a floating-point value. The value is 
converted to the shortest possible decimal string using fixed or 
scientific format. The number of significant digits in the resulting 
string is given by the precision specifier in the format string--a 
default precision of 15 is assumed if no precision specifier is 
present. 
Trailing zeros are removed from the resulting string, and a decimal 
point appears only if necessary. The resulting string uses fixed point 
format if the number of digits to the left of the decimal point in the 
value is less than or equal to the specified precision, and if the value 
is greater than or equal to 0.00001. Otherwise the resulting string 
uses scientific format. 

‘n’ Number. The argument must be a floating-point value. The value is 
converted to a string of the form "-d,ddd,ddd.ddd...". The "n" format 
corresponds to the "f" format, except that the resulting string 
contains thousand separators. 

‘m’ Money. The argument must be a floating-point value. The value is 
converted to a string that represents a currency amount. The 
conversion is controlled by the CurrencyString, CurrencyFormat, 
NegCurrFormat, ThousandSeparator, DecimalSeparator, and 
CurrencyDecimals global variables, all of which are initialized from 
the Currency Format in the International section of the Windows 
Control Panel. If the format string contains a precision specifier, it 
overrides the value given by the CurrencyDecimals global variable. 

‘s’ String. The argument must be a character, or a string value. The 
string or character is inserted in place of the format specifier. The 
precision specifier, if present in the format string, specifies the 
maximum length of the resulting string. If the argument is a string 
that is longer than this maximum, the string is truncated. 

‘x’ Hexadecimal. The argument must be an integer value. The value is 
converted to a string of hexadecimal digits. If the format string 
contains a precision specifier, it indicates that the resulting string 
must contain at least the specified number of digits; if the value has 
fewer digits, the resulting string is left-padded with zeros. 

• Table 23-3 OutputFormat specifiers. 

Conversion characters may be specified in uppercase as well as in lowercase--both 
produce the same results. 
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For all floating-point formats, the actual characters used as decimal and thousand 
separators are obtained from the DecimalSeparator and ThousandSeparator Windows 
Control Panel variables. 

A width specifier sets the minimum field width for a conversion. If the resulting string is 
shorter than the minimum field width, it is padded with blanks to increase the field 
width. The default is to right-justify the result by adding blanks in front of the value, but 
if the format specifier contains a left-justification indicator (a "-" character preceding the 
width specifier), the result is left-justified by adding blanks after the value. 

Date Time 

Date and time values have their own format specifiers.  Table 23-4 lists the available 
formats. 
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Specifier Description 
‘c’ Displays the date using the format given by the ShortDateFormat 

global variable, followed by the time using the format given by the 
LongTimeFormat Windows Control Panel variable. The time is not 
displayed if the fractional part of the DateTime value is zero. 

‘d’ Displays the day as a number without a leading zero (1-31). 

‘dd’ Displays the day as a number with a leading zero (01-31). 

‘ddd’ Displays the day as an abbreviation (Sun-Sat) using the strings 
given by the ShortDayNames Windows Control Panel variable. 

‘dddd’ Displays the day as a full name (Sunday-Saturday) using the strings 
given by the LongDayNames Windows Control Panel variable. 

‘ddddd’ Displays the date using the format given by the ShortDateFormat 
Windows Control Panel variable. 

‘dddddd’ Displays the date using the format given by the LongDateFormat 
Windows Control Panel variable. 

‘m’ Displays the month as a number without a leading zero (1-12). If the 
m specifier immediately follows an h or hh specifier, the minute 
rather than the month is displayed. 

‘mm’ Displays the month as a number with a leading zero (01-12). If the 
mm specifier immediately follows an h or hh specifier, the minute 
rather than the month is displayed. 

‘mmm’ Displays the month as an abbreviation (Jan-Dec) using the strings 
given by the ShortMonthNames Windows Control Panel variable. 

‘mmmm’ Displays the month as a full name (January-December) using the 
strings given by the LongMonthNames Windows Control Panel 
variable. 

‘yy’ Displays the year as a two-digit number (00-99). 

‘yyyy’ Displays the year as a four-digit number (0000-9999). 

‘h’ Displays the hour without a leading zero (0-23). 

‘hh’ Displays the hour with a leading zero (00-23). 

‘n’ Displays the minute without a leading zero (0-59). 

‘nn’ Displays the minute with a leading zero (00-59). 

‘s’ Displays the second without a leading zero (0-59). 

‘ss’ Displays the second with a leading zero (00-59). 

‘t’ Displays the time using the format given by the ShortTimeFormat 
Windows Control Panel variable. 

‘tt’ Displays the time using the format given by the LongTimeFormat 
Windows Control Panel variable. 
am/pm Uses the 12-hour clock for the preceding h or hh specifier, 
and displays 'am' for any hour before noon, and 'pm' for any hour 
after noon. The am/pm specifier can use lower, upper, or mixed 
case, and the result is displayed accordingly. 

‘a/p’ Uses the 12-hour clock for the preceding h or hh specifier, and 
displays 'a' for any hour before noon, and 'p' for any hour after noon. 
The a/p specifier can use lower, upper, or mixed case, and the 
result is displayed accordingly. 

‘am/pm’ Uses the 12-hour clock for the preceding h or hh specifier, and 
displays the contents of the TimeAMString global variable for any 
hour before noon, and the contents of the TimePMString global 
variable for any hour after noon. 

‘/’ Displays the date separator character given by the DateSeparator 
Windows Control Panel variable. 

‘:’ Displays the time separator character given by the TimeSeparator 
Windows Control Panel variable. 
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‘xx’/”xx” Characters enclosed in single or double quotes are displayed as-is, 
and do not affect formatting. 

• Table 23-4 Date and Time OutputFormats.  

Format specifiers may be written in upper case as well as in lower case letters--both 
produce the same result. 

Survey Data 

Figure 23-5 shows a sample output from reading a survey – in this case the event log. 

[LoadSurvey] 
LastRecord=0000000160 
 
Record No Time  Event    Record Status 
                (0x0000F080) (0x0000FC68) 
158  3/09/99 14:49:27 Local: Logoff: User request ......... 
159  3/09/99 14:49:40 Power Off   ...I..... 
160  3/09/99 14:51:40 Power On   ......... 

• Figure 23-5 Survey output format. 

The columns of data are delimited by tab characters for easy import into other programs.  
The first line is a tag that tells EziView there is a survey in the file, used when 
appending.  The second line tells EziView what the last entry in the file is so that it can 
read just the new entries when appending to the file.  This is updated when appending.  

The next line is a blank line, then the next line lists the column headings.  These are 
retrieved from the meter.  The next line shows the registers of each channel.  This is 
seldom used, but it can be useful when debugging problems or differentiating between 
channels. 

Up to this point has been the header of the file.  If any register read commands have 
been used previous to the PCLoadSurvey command their results will be placed here. 

The remaining lines are the contents of the survey, each line being a single entry.  The 
last column is always the status flags for the entry.  See Figure 17-6 for a list of the 
meanings of these flags. 

If any register commands followed the PCLoadSurvey entry their results will appear at 
the end of the survey entries.  When appending, the new readings are simply appended 
to the file.  While it is possible to use both a survey command and register commands in 
the same file, the result can be messy unless care is taken because of the way the results 
will be interleaved. 
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Examples 
Example 1 (Table 23-5) demonstrates the reading of a single register (the meter serial 
number) and the integration of text. 

Source This is my meter. 
Serial Number=[F002,s]. 

Output This is my meter. 
Serial Number=204123456. 

• Table 23-5 Reading File Example 1.  

Example 2 (Table 23-6) demonstrates reading a floating point value (Phase A voltage) 
and formatting it to display with 3 decimal places.  The file is overwritten every time it 
is read again. 

Source [PCOverwrite]Value is [E000,f,%6.3f] 

Output Value is 241.894 

• Table 23-6 Reading File Example 2.  

Example 3 (Table 23-7) demonstrates reading a load survey, displaying the numbers 
with 3 decimal places in kWh.  Note that the heading of the channels still shows Wh, 
not kWh as this heading comes from the meter.  Note that displaying a heading (using 
PCHeading) in a survey file displays the heading on the same line and to the left of the 
channel headings. 

Source [PCLoadSurvey.030][PCFloatFmt.%6.3f][PCFloatMult.Kilo] 

Output [LoadSurvey] 
LastRecord=0000001440 
 
Record No Date/Time Import Wh Total Export Wh Total Record Status 
  (0x03110000) (0x03110001)  
0 31/08/99 10:00:00  0.001  0.000 ...I..... 
1 31/08/99 10:30:00  0.002  0.000 ......... 
2 31/08/99 11:00:00  0.002  0.000 ...I..... 
3 31/08/99 11:30:00  0.002  0.000 ......... 
4 31/08/99 12:00:00  0.002  0.000 ......... 
… 
1433 30/09/99 06:30:00  0.007  0.000 ......... 
1434 30/09/99 07:00:00  0.007  0.000 ......... 
1435 30/09/99 07:30:00  0.035  0.000 ......... 
1436 30/09/99 08:00:00  0.081  0.000 ......... 
1437 30/09/99 08:30:00  0.083  0.000 ......... 
1438 30/09/99 09:00:00  0.087  0.000 ......... 
1439 30/09/99 09:30:00  0.089  0.000 ......... 

• Table 23-7 Reading File Example 3.  
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Example 4 (Table 23-8) demonstrates reading multiple values with an offset.  The 6 
floating point scaling factors for a waveform are read at an offset of 1212 bytes into the 
register.  

Source Waveform scaling factors are [F402,f6,%6.3f,1212] 

Output Waveform scaling factors are  0.011, 0.011, 0.001, 1.545, 1.539, 1.548 

• Table 23-8 Reading File Example 4.  

Example 5 demonstrates the use of rich text format.  The following source (Figure 23-6) 
was written in a word processor, then saved as rich text format.    

Instantaneous Results 

Meter [F002,s]. 

Collected [PCDateTime]. [PCOverwrite][PCExtension.tst] 

 

 Phase A Phase B Phase C 

Voltage [E000,f,%6.1f] [E001,f,%6.1f] [E002,f,%6.1f] 

Current [E010,f,%6.3f] [E011,f,%6.3f] [E012,f,%6.3f] 

Phase [E020,f,%6.1f] [E021,f,%6.1f] [E022,f,%6.1f] 

 

• Figure 23-6 Rich text source example. 
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The output file looks like Figure 23-7.  Notice that the formatting is maintained, even on 
register values. 

Instantaneous Results 

Meter 204123456. 

Collected 30/09/99 10:13:43.  

 

 Phase A Phase B Phase C 

Voltage  239.6  239.5  239.5 

Current  0.707  0.469  0.253 

Phase    0.2    5.4    0.8 

 

• Figure 23-7 Rich text processed example. 

If having problems with using rich text, read the source with a plain text editor to check 
if the command sequences are being broken up, and thus will not be recognised.  This 
may happen with some programs that produce rich text. 
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24
 

Chapter 24 EziView Script Files 
Since there are lots of other devices such as Datagates and special modems connected to 
Meters, EziView needed a way to automatically control these devices. As a result a 
scripting language was added to EziView. A script is a simple language allowing 
transmitting and receiving messages. Once the communications port is open the script is 
run. The script will control the special device by sending and receiving messages, and 
when finished EziView will continue the log on sequence as normal. 

This chapter assumes that the reader is familiar with basic programming techniques and 
is for advanced users.  The EziView Script language is different to EziScript Extensions. 

Structure 
The structure of a script is quite simple. A script is made up of a sequence of operations 
or instructions, with one instruction per line. Each instruction consists of the instruction 
name and parameters. These are case sensitive. See Figure 24-1. 

//Create a new variable named x1 of type integer 
Create(“x1”,Integer) 
//x1=2 
Assign(x1,2) 
//x1=x1+3 
Add(x1,3) 

• Figure 24-1 Simple example. 

Comments are denoted by “//” characters, and the rest of the line is ignored. 

Each instruction is a single simple instruction. Compound instructions are not allowed, 
ie x1=x1+x2+2 would be written as in Figure 24-2. 

Add(x1,x2) 
Add(x1,2) 

• Figure 24-2 Compound add example. 



  

   

A group of instructions that perform a certain task is called a function. Functions are 
defined as in Figure 24-3. 

//Function to Add three numbers and returns the result in x1 
//x1=x1+x2+x3 
Function(Add3,var x1:Integer,x2:Integer,x3:Integer) 
  Add(x1,x2) 
  Add(x1,x3) 
End 
… 
Call(“Add3”,x1,x2,2) 

• Figure 24-3 Function example. 

Numbers can also be in hexadecimal by preceding it with a dollar sign, eg $0F. Non 
printable characters are preceded by a hash, eg #13 is character 13 (carriage return). 
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Program Outline 
There are two special functions that are called when the script is run – “Global” and 
“Main”. Global is called to create global variables. A global variable is a variable that is 
accessible anywhere in the script. A local variable is accessible only in the function in 
which it was defined. It is not necessary to have a global function if no global variables 
are needed. Main is called to run the script. Main must be defined. Figure 24-4 shows a 
simple script that adds three numbers and returns true if the sum is 6. 

//Create global variables 
Function(Global) 
  //Create a global variable called tbool of type Boolean 
  Create(“tbool”,Boolean) 
End 
 
//Function to Add three numbers and returns the result in x1 
//x1=x1+x2+x3 
Function(Add3,var x1:Integer,x2:Integer,x3:Integer) 
  Add(x1,x2) 
  Add(x1,x3) 
End 
 
//Main function  
Function(Main) 
  //Create a local variable called x1 of type Integer 
  Create(“x1”,Integer) 
  //Create a local variable called x2 of type Integer 
  Create(“x2”,Integer) 
  //x1=1 
  Assign(x1,1) 
  //x2=2 
  Assign(x2,2) 
  //x1=x1+x2+2 
  Call(“Add3”,x1,x2,2) 
//Test to see if x1=6 
  Equal(tbool,x1,6) 
  //Set the result of the script, ScriptResult=tbool 
  Assign(ScriptResult,tbool) 
  //Set the result message if the ScriptResult is false 
If(tbool) 
    Goto(“MainSuccess”) 
  Assign(ScriptResultMsg, “x1 not 6”) 
:MainSuccess 
End 

• Figure 24-4 Variables example. 

This script will return false because x1 is not equal to 6. Connecting to the meter will 
fail with the message “Script Error: x1 not 6”. 
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Predefined Global Variables 

There are three predefined global variables: 

1. ScriptResult is a Boolean that indicates the success or failure of the script. This is set 
to true by default. If ScriptResult is true the script is successful and EziView 
continues the log on process. If ScriptResult is false the script failed and EziView 
closes the port and displayes an error message. 

2. ScriptResultMsg is a string that contains the error message to display to the user 
when the script fails. 

3. Result is a variable that contains the result of specific instructions, eg 
CommWaitFor(2000,"OK",”ERROR”) will wait for 2 seconds to receive an “OK” 
or “ERROR” message. Result is set to 0 if timed out, 1 if “OK” received, or 2 if 
“ERROR” received. 

Main Parameters 

The main function has three parameters passed to it: 

1. UserID:String 

2. Password:String 

3. Parameters:String 

These are entered in the Site Properties, Script page. These strings are not used by 
EziView, they are for script use only, so there is no restriction on their use. 

Program Flow 
There are two ways to control the program flow: 

1. Call(FunctionName,Parameters) runs the function and goes to the next instruction 
when the function is finished. In Figure 24-4, Call(“Add3”,x1,x2,2) jumps to the first 
instruction in the function Add3. When Add3 is finished, “End”, the next instruction 
after the “Call”, is run. 

2. Goto(LabelName) jumps to the label and runs from there. In Figure 24-4, 
Goto(“MainSuccess”) jumps to the first instruction after the label “:MainSuccess”. 
There is no return from this jump. When “End” is reached this is the end of the Main 
function and the script is finished. 

A label is defined as a colon, ‘:’, followed by its name. Labels are global, ie any label 
can be called from anywhere. Care should be taken not to jump to a label outside a 
function. A suggestion is to start the label with the name of the function, eg 
“MainSuccess” is “Success” in the main function. The label name may be in a string 
variable. This can be used to implement a case statement. 
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Types 
Table 24-1 gives a list of all available types. 

Type Name Description 
SmallInt 16 bit integer value (-32768 .. 32767) 

Integer 32 bit integer value (-2147483648 .. 2147483647) 

Float/Single 32 bit floating point value (1.5x10-45 .. 3.4x1038, 7-8 Significant Digits) 

Double 64 bit floating point value (5.0x10-324 .. 1.7x10308, 15-16 Significant Digits) 

Currency 64 bit number with 4 Significant decimal digits (-922,337,203,685,477.5808 .. 
922,337,203,685,477.5807) 

Date Double representing the date and time. The integral part represents the number 
of days that have passed since 12/30/1899, and the fractional part is the fraction 
of a 24 hour day that has elapsed 

Boolean 8 bit boolean (false .. true) 

Byte 8 bit integer value (0 .. 255) 

String Character string 

File File 

• Table 24-1 Available types. 

File is a special type and is not compatible with any other type. All the other types are 
compatible with each other, and are converted as needed. For example, an integer of 
value 1 can be used as a string, it is converted to the string “1”. The term Variant is used 
for these types. 
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Instructions 
The instructions are broken up into the groups of basic, string, file, and communications. 

Basic Instructions 

This covers mathematics, variables and flow control instructions (Table 24-2). 

Instruction Description 
Add(var Value1:Variant,Value2:Variant) Value1:=Value1+Value2 

Example 1: Value1:Integer=2 
Add(Value1,3) //Value1=5 
Example 2: Value1:String=“hello “ 
Add(Value1, ”world”) ..Value1=“hello world” 

And(var Value1:Variant,Value2:Variant) Value1:=Value1 and Value 2 
Example 1: Value1:Integer=17 
And(Value1,$F) //Value1=1 
Example 2:Value1:Boolean=True, Value2:Boolean=False 
And(Value1,Value2) //Value1=False 

Assign(var Value1:Variant,Value2:Variant) Value1:=Value2 
Example 1: Value1:Integer=0 
Assign(Value1,2) //Value1=2 

Call(FunctionName:String,[Parameters:String]) Calls the function and runs the next instruction when the 
function finishes. 
Example 1: Call(“MyFunc1”) 
Example 2: FuncPtr:String=“MyFunc2”, Parameter1:Integer=2 
Call(FuncPtr,Parameter1) //Calls MyFunc2 with Parameter1 

CastValue(var Value1:Variant 
,CastType:String) 

Value1:=CastType(Value1), converts Value1 to another type. 
Example 1:Value1:String=“1” 
CastValue(Value1,Integer) //Value1:Integer=1 

Create(VariableName:String,Type:String 
,[Option:Variant]) 

Creates a new variable with Name of Type 
Example 1: Create(“Value1”,Integer) //Value1:Integer=0 
Example 2: Create(“f”,File, “Text”) //f:File= unopened text file 

Display(Message:String) Displays the message in a popup box 

Divide(var Value1:Variant,Value2:Variant) Value1:=Value1 / Value2 
Example 1: Value1:Integer=8 
Divide(Value1,2) //Value1=4 
Example 2: Value1:Float=8.2 
Divide(Value1,2) //Value1=4.1 

Equal(var Result:Boolean,Compare1:Variant 
,Compare2:Variant) 

Result:=(Compare1=Compare2) 
Example 1: Compare1:Integer=7, tbool:Boolean=False 
Equal(tbool,Compare1,7) //tbool=True 

Goto(Label:String) Jumps to the Label 
Example 1: Goto(“MyLabel”) 
Example 2: LabelPtr:String=“MyLabel” 
Goto(LabelPtr) //Same as example 1 

Greater(var Result:Boolean,Compare1:Variant 
,Compare2:Variant) 

Result:=(Compare1>Compare2) 
Example 1: Compare1:Integer=7, tbool:Boolean=False 
Greater(tbool,Compare1,7) //tbool=False 

GreaterEq(var 
Result:Boolean,Compare1:Variant 

Result:=(Compare1>=Compare2) 
Example 1: Compare1:Integer=7, tbool:Boolean=False 
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,Compare2:Variant) Greater(tbool,Compare1,7) //tbool=True 

Halt(Result:Boolean) Set the Global ScriptResult to Result and ends the script 
Example 1: Halt(False) //Finishes the script 

If(Condition) If the condition is true the next instruction is run, if the 
condition is false the next instruction is skipped. 
Example 1: tbool:Boolean=True 
If(tbool) 
  Display(“tbool=true”) //Instruction is run 
Example 2: tbool:Boolean=False 
If(tbool) 
  Display(“tbool=true”) //Instruction is skipped 

Less(var Result:Boolean,Compare1:Variant 
,Compare2:Variant) 

Result:=(Compare1<Compare2) 
Example 1: Compare1:Integer=7, tbool:Boolean=False 
Less(tbool,Compare1,7) //tbool=False 

LessEq(var Result:Boolean,Compare1:Variant 
,Compare2:Variant) 

Result:=(Compare1<=Compare2) 
Example 1: Compare1:Integer=7, tbool:Boolean=False 
LessEq(tbool,Compare1,7) //tbool=True 

Mod(var Value1:Variant,Value2:Variant) Value1:=Value1 mod Value2 
Example 1: Value1:Integer=7 
Mod(Value1,4) //Value1=3 

Multiply(var Value1:Variant,Value2:Variant) Value1:=Value1 * Value2 
Example 1: Value1:Integer=7 
Multiply(Value1,4) //Value1=28 

Not(var Value1:Variant) Value1:=(Not Value1) 
Example 1: Value1:Byte=$0F 
Not(Value1) //Value1=$F0 
Example 2: Value1:Boolean=True 
Not(Value1) //Value1=False 

NotEqual(var Result:Boolean 
,Compare1:Variant,Compare2:Variant) 

Result:=(Compare1<>Compare2) 
Example 1: Compare1:Integer=7, tbool:Boolean=False 
NotEqual(tbool,Compare1,7) //tbool=False 

Or(var Value1:Variant,Value2:Varaint) Value1:=Value1 or Value2 
Example 1: Value1:Integer=6 
Or(Value1,1) //Value1=7 
Example 2: Value1:Boolean=False 
Or(Value1,True) //Value1=True 

Return(Result:Boolean) Sets the Global Result to Result and ends the function 
Example 1:Return(True) //Finishes the function 

Shl(var Value1:Integer,Value2:Integer) Value1:=Value1 shl Value2 
Example 1: Value1:Integer=2 
Shl(Value1,1) //Value1=4 

Shr(var Value1:Integer,Value2:Integer) Value1:=Value1 shr Value2 
Example 1: Value1:Integer=2 
Shr(Value1,1) //Value1=1 

Sleep(MilliSeconds:Integer) Suspend execution for MilliSeconds amount of time 
Example 1: Sleep(200) //Wait 200 milliseconds 

Subtract(var Value1:Variant,Value2:Varaint) Value1:=Value1-Value2 
Example 1: Value1:Integer=7 
Subtract(Value1,1) //Value1=6 

Xor(var Value1:Variant,Value2:Varaint) Value1:=Value1 xor Value2 
Example 1: Value1:Integer=6 
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Xor(Value1,3) //Value1=5 
Example 2: Value1:Boolean=True 
Xor(Value1,True) //Value1=False 

• Table 24-2 Basic instructions. 

String Instructions 

String instructions are those that work with strings (Table 24-3). 

Instruction Description 
StrCompare(var 
Result:Integer,S1:String,S2:String) 

Compare Strings ignoring case. Equal can be used to 
compare strings that are case sensitive. 
Result:=0 if S1=S2, >0 if S1>S2, <0 if S1<S2 
Example 1: tint:Integer=0 
StrCompare(tint,“hello”, “HellO”) //tint=0 

StrCopy(var 
S1:String,S2:String,Index:Integer,Count:Intege
r) 

S1:=Copy(S2,Index,Count) 
Copies Count characters starting from Index. The first 
character in the string is 1. 
Example 1: S1:String=“” 
StrCopy(S1, “hello world”,2,4) //S1=“ello” 

StrDelete(var 
S:String,Index:Integer,Count:Integer) 

Deletes Count characters starting from Index 
Example 1: S:String=“hello world” 
StrDelete(S,6,6) //S=“hello” 

StrLength(var Length:Integer,S:String) Length is set to the number of characters in the string 
Example 1: Length:Integer=0 
StrLength(Length, “hello”) //Length=5 

StrLowerCase(var S:String) Converts all characters in the string to lower case 
Example 1: S:String=“Hello” 
StrLowerCase(S) //S=“hello” 

StrPos(var 
Index:Integer,SubStr:String,S:String) 

Index is set to the position of SubStr in S. If SubStr is not 
found in S Index is 0. 
Example 1: Index:Integer=0 
StrPos(Index, “world”, “hello world”) //Index=7 
Example 2: Index:Integer=0 
StrPos(Index, “good evening”, “hello world”) //Index=0 

StrTrim(var S:String) Removes white space from the start and end of the string 
Example 1: S:String=“ hello “ 
StrTrim(S) //S=“hello” 

StrUpperCase(var S:String) Converts all characters in the string to upper case 
Example 1: S:String=“Hello” 
StrUpperCase(S) //S=“HELLO” 

• Table 24-3 String instructions. 

File Instructions 

When creating a file variable the optional parameter specifies the type of file to create. 
The options are: 

• “Text” standard text file. This is the default. This type doesn’t support several 
functions, FilePos, FileSeek, FileSize, and FileTruncate. 

• “Untyped” standard binary file. 
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• “Handle” standard Windows binary file. 

• “HandleRead” read only Windows binary file. 

All file instructions set the Global Result variable to True if the operation is successful 
and False if the operation failed and the Global ScriptResultMsg to the reason for the 
failure. 

Table 24-4 lists all of the file instructions. 
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Instruction Description 
FileClose(var f:File) Closes the opened file 

Example 1: f:File=opened file 
FileClose(f) //f is closed 

FileEof(var Result:Boolean,var f:File) Sets Result to true if at the end of the opened file, else false 
Example 1: tbool:Boolean=false, f:File=opened file 
FileEof(tbool,f) //tbool=true/false 

FileOpen(var f:File) Opens the file 
Example 1: f:File=unopened file 
FileOpen(f) //f is open 

FilePos(var Result:Integer,var f:File) Sets result to the current position in the file 
Example 1: tint:Integer=0, f:File=opened file 
FilePos(tint,f) //tint=position in file 

FileRead(var f:File,var S:String,Size:Integer) Reads Size characters from the opened file into S 
Example 1: S:String=””, f:File=opened file 
FileRead(f,S,10) //S=10 characters from the file 

FileReadln(var f:File,var S:String) Reads characters to the next carriage return from the file into 
S 
Example 1: S:String=””, f:File=opened file 
FileReadln(f,S) //S=next line from the file 

FileSeek(var 
f:File,Position:Integer,Origin:String) 

Sets the file position to the Position from the Origin. 
Origin can be 
“Begin” from the beginning of the file. Default. 
“Current” from the current position in the file. 
“End” from the end of the file. 
Example 1: f:File=opened file 
FileSeek(f,0,“End”) //f is at the end of the file 
FileSeek(f,0,“Begin”) //f is at the start of the file 
FileSeek(f,5,“Current”) //f is 5 characters further on 

FileSetName(var f:File,FileName:String) Sets the filename for the file to open. Global Result is not set. 
Example 1: f:File=unopened file 
FileSetName(f, “myfile.txt”) //f filename set to “myfile.txt” 

FileSetOpenMode(var 
f:File,OpenModes:String) 

Sets the mode to open the file as. Global Result is not set. 
“Read” Read only. Default 
“Write” Write only 
“Read/Write” Reading and writing 
Example 1: f:File=unopened file 
FileSetOpenMode(f, “Write”) //f openmode set to write only 

FileSetShareMode(var 
f:File,ShareModes:String) 

Sets the share mode to open the file as. Global Result is not 
set. 
“ShareRead” share for reading. 
“ShareWrite” share for writing. 
“ShareRead,ShareWrite” share for reading and writing. 
Example 1: f:File=unopened file 
FileSetShareMode(f, “ShareRead”) //f sharemode set to share 
reading. 

FileSetWriteMode(var f:File,WriteMode:String) Sets the write mode to open the file as. Global Result is not 
set. 
Only valid for text files. 
“Rewrite” deletes the existing file and creates a new empty 
file. 
“Append” opens a file and sets the position to the end of the 
file. 
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Example 1: f:File=unopened file 
FileSetWriteMode(f, “Append”) //f writemode set to append to 
the end of an existing file. 

FileSize(var Result:Integer,var f:File) Sets the result to the length of the file. 
Example 1: tint:Integer=0, f:File=opened file 
FileSize(tint,f) //tint is the size of the file 

FileTruncate(var f:File) Makes the current position of the file the end of the file. Only 
for a file opened for writing, and not a text file. 
Example 1: f:File=opened file 
FileTruncate(f) //Current position now the end of the file 

FileWrite(var f:File,S:String) Writes the string to the file. 
Example 1: f:File=opened file 
FileWrite(f, “Hello World”) //“Hello World” written to the file. 

FileWriteln(var f:File,S:String) Writes the string to the file and add Carriage Return/Line Feed 
characters. 
Example 1: f:File=opened file 
FileWriteln(f, “Hello World”) //“Hello World”CRLF written to the 
file. 

• Table 24-4 File instructions. 

Communications Instructions 

Table 24-5 lists all of the communications instructions. 

The script is automatically exited if the communications port is lost, and the 
ScriptResultMsg is set to the failure message. 

Instruction Description 
CommReceive(MilliSeconds:Integer,var 
S:String,[WaitStrings:String]) 

Waits MilliSeconds or until WaitStrings is received and places 
the string in S. If timed out S is empty. 
Example 1: S:String=“” 
CommReceive(2000,S,#13) //Waits 2 seconds or until a 
Carriage Return character is received. The received 
characters are in S. 

CommTransmit(Transmit:Variant) Transmits the String or Bytes on the communications port. 
Example 1: CommTransmit(“hello”) //Transmits “hello” 
Example 2: CommTransmit(13) //Transmits #13 carriage 
return. 

CommWaitFor(MilliSeconds:Integer,WaitString
:String,[WaitStrings:String]) 

Waits for one of the wait strings to be received or until 
MilliSeconds time has elapsed. Global variable Result is set to 
the parameter that caused the completion of the operation, 
starting from 0. 
Example 1: CommWaitFor(2000, “OK”, “ERROR”) //will wait 
for 2 seconds to receive an “OK” or “ERROR” message. 
Global Result is set to 0 if timed out, 1 if “OK” received, or 2 if 
“ERROR” received. 

• Table 24-5 Communications instructions. 
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Variables 

All variables, function names, and labels are referenced by their name as a string, i.e., 
Goto and Call take a string parameter. This means that function pointers and label 
pointers are simple strings. Variables can also be referenced by their name. This is done 
by adding a ‘^’ character after the variable name, see Figure 24-5. 

//Create variable x1 of type String 
Create(“x1”,String) 
//x1=“temp” 
Assign(x1, “temp”) 
 
//Create variable temp of type Integer 
Create(x1,Integer) 
//temp=4 
Assign(x1^,4) 

• Figure 24-5 Pointer example. 

Debugger 

When the Debug option is checked in Site Properties → Script page, the debugger is 
run with the script loaded. The debugger allows the script to be examined to give the 
programmer information about its state. 

From the debugger the available options are: 

• Step - This runs one instruction at a time. The variable values may be inspected. 

• Run - Once finished stepping through the script, pressing Run will complete the 
script without any user interaction. 

• Close - Will cancel the script. EziView will display the message “Script Error: User 
Terminated”. 

These options are available only when the debugger is idle. When the debugger is idle 
the next instruction to be run is blue. When the debugger is busy, the currently running 
instruction is grey. 

If the debugger is busy and you want to cancel without the currently running instruction 
to complete, press cancel on the main connect window. 

Example 1: Datagate 
This is an example script for connecting with a Datagate modem gateway device. 

//This script connects through a Datagate. 
//The User Name comes from the UserID option in the Site Properties, Script page 

24-12  EDMI Genius/Mk6E User Manual 



 

  Example 1: Datagate 

//The Password comes from the Password option in the Site Properties, Script page 
//The Port Number comes from the Parameters option in the Site Properties, Script page 
 
//Global Variables 
Function(Global) 
  //Temporary Boolean to use with If statement 
  Create("tbool",Boolean) 
End 
 
//Writes a string to the communications port and adds a CR character. 
//Halts the script if the port is lost 
Function(Writeln,s:String) 
  //Transmit s 
  CommTransmit(s) 
  //Transmit the carriage return 
  CommTransmit(13) 
End 
 
//Main execution of the script 
Function(Main) 
  //Create local variables 
  Create("RetryCount",Integer) 
  Create("s1",String) 
 
  //Set the RetryCount to 2, when it reaches 0 quit with a timed out message 
  Assign(RetryCount,2) 
 
:MainWaitInput 
 
  //Wait for the datagate response 
  //Result is the 0 for timeout, 1 - login:, 2 - password, 3 - Enter Option, 4 - Enter User ID, 5 - Access 
Denied. 
  CommWaitFor(3000,"login:","password:","Enter Option","Enter User ID","Access Denied.") 
 
  Assign(s1,"MainCase") 
  //Convert the Result Integer to a String because can't add a String and an Integer 
  CastValue(Result,String) 
  Add(s1,Result) 
  Goto(s1) 
:MainCase0    //Timed out 
  Subtract(RetryCount,1) 
  Equal(tbool,RetryCount,0) 
  If(tbool) 
    Goto("MainTimedOut") 
  CommTransmit(#27) 
  Goto("MainWaitInput") 
:MainCase1    //login: 
  Call("Writeln",UserID) 
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  Goto("MainWaitInput") 
:MainCase2    //password: 
  Call("Writeln",Password) 
  Goto("MainWaitInput") 
:MainCase3    //Enter Option 
  Call("Writeln",Parameters) 
  Goto("MainWaitInput") 
:MainCase4    //Enter User ID 
  Return(True) 
:MainCase5    //Access Denied. 
  Assign(ScriptResultMsg,"Incorrect User Name or Password") 
  Return(False) 
:MainTimedOut 
  Assign(ScriptResultMsg,"Datagate Not Responding") 
  Return(False) 
End 

Example 2: Special Modem 
This is an example that dials the modem directly, using AT commands. “AT” is sent 
and “OK” is expected in 2 seconds. If this fails twice the script returns false with the 
message “Response Failed (OK)”. If successful “ATDT phone number” is sent and 
“CONNECT” or fail string is expected in 2 minutes. If “CONNECT” is found the script 
returns successful, else an error string is returned. 

//This script dials up with using a special modem that is not supported 
//from Windows 
 
//Global Variables 
Function(Global) 
  //Temporary Boolean to use with If statement 
  Create("tbool",Boolean) 
End 
 
//Writes a string to the communications port and adds a CR character. 
//Halts the script if the port is lost 
Function(Writeln,s:String) 
  //Transmit s 
  CommTransmit(s) 
  //Transmit the carriage return 
  CommTransmit(13) 
End 
 
//Sends the Command and waits for the response to be received on the communications port. 
//Halts the script if the port is lost or the Response is not found after retrying 
Function(SendCommand,Command:String,Response:String,Timeout:Integer,RetryCount:Integer) 
:SendCommandRetry 
  Call("Writeln",Command) 
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  CommWaitFor(Timeout,Response) 
  If(Result) 
    Goto("SendCommandSuccess") 
  Subtract(RetryCount,1) 
  GreaterEq(tbool,RetryCount,0) 
  If(tbool) 
    Goto("SendCommandRetry") 
  //Failed in the number of retrys 
  Assign(ScriptResultMsg,"Response Failed '") 
  Add(ScriptResultMsg,Response) 
  Add(ScriptResultMsg,"'") 
  Halt(False) 
:SendCommandSuccess 
End 
 
//Main execution of the script 
Function(Main) 
  //Create local variables 
  Create("s1",String) 
  Create("DialString",String) 
 
  //Send AT 
  Call("SendCommand","AT","OK",2000,1) 
  //Modem needs a pause time otherwise it will miss characters 
  Sleep(100) 
 
  //Send ATD number 
  Assign(DialString,"ATDT ") 
  Add(DialString,Parameters) 
  Call("Writeln",DialString) 
  //Wait for the response from the modem 
  CommWaitFor(120000,"CONNECT","BUSY","NO CARRIER","NO DIALTONE","NO ANSWER") 
//Result is the 0 for timeout, 1 - Connect, 2 - Busy... 
  Assign(s1,"MainCase") 
  //Convert the Result Integer to a String because can't add a String and an Integer 
  CastValue(Result,String) 
  Add(s1,Result) 
  Goto(s1) 
:MainCase0     //Timed out 
  Assign(ScriptResultMsg,"Modem Timed Out") 
  Goto("MainEnd") 
:MainCase1     //Connect 
  Return(True) //Successfully connected 
:MainCase2     //Busy 
  Assign(ScriptResultMsg,"Modem Busy") 
  Goto("MainEnd") 
:MainCase3     //No Carrier 
  Assign(ScriptResultMsg,"Modem Failed with No Carrier") 
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  Goto("MainEnd") 
:MainCase4    //No Dialtone 
  Assign(ScriptResultMsg,"Modem Not Connected") 
  Goto("MainEnd") 
:MainCase5    //No Answer 
  Assign(ScriptResultMsg,"Modem Not Answering") 
:MainEnd 
  Return(False) 
End 

Summary 
EziView scripts provide a way to perform almost any function in a customisable way 
while connecting to a site.
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Chapter 25 Summation 
EziView has a simple summation feature that may be used to combine load surveys 
from different meters into a single survey.  This is useful where a site has a number of 
metering points and a site wide load survey is required. 

Using Summation 

The summation function may be run by selecting File → Summation from the main 
menu.  Summation is actually provided by a separate program that is integrated into 
EziView.  Figure 25-1 shows the main summation screen. 

 
• Figure 25-1 Summation main screen. 



  

   

Selecting File → New Set from the menu creates a new summation set (Figure 25-2).   
A summation set contains a list of summated surveys and their sources. 

 
• Figure 25-2 Summation with a new set. 

The other options on the File menu are used to save the set, save it under a different 
name, close the set, and open an existing set.  The three icons on the toolbar allow for 
opening a set, saving a set, and closing a set. 

Multiple sets may be open at once.  The Window menu offers a standard set of 
windowing operations for arranging the set windows. 
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To add a summed survey to the set, right-click in the set window and select New Sum.  
You will be prompted for the filename of the new sum (default extension of LSS).  The 
new sum will now be shown in the set window (Figure 25-3). 

 
• Figure 25-3 Summation with a new sum. 

Load survey files can now be added to the sum by right-clicking on it and selecting New 
File.  These load survey files will generally be created by reading files.  Each file is 
added to the list of source files for the sum.  Figure 25-4 shows two files added to the 
sum. 

 
• Figure 25-4 Summation with files added to the sum. 
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The plus sign in front of a file indicates that the file will be added to the sum.  Right-
clicking on the file and selecting Invert will change the sign to a minus sign.  This 
means that the file will be subtracted from the total.   

Files can be moved around between sums using the Cut, Copy, Paste, and Delete 
commands. 

Right-clicking in the window and selecting Sum will cause all the summated load 
surveys to be generated from their source files.  The program will take channels with the 
same register number and add them together to create a channel in the sum.  This 
generally means for surveys created with toolbox that the surveys in the meters will 
have the corresponding channel numbers added up.  It is recommended that all the 
meters have the same survey loaded to ensure correct results. 

Quick Data Display 
The summation program also has a simple viewing function.  This is accessed by right-
clicking on a survey and selecting Display (Figure 25-5). 

 
• Figure 25-5 Display example. 
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The top part of the display shows the data in a tabular format.  The bottom part shows 
the data for one channel graphically.  The date is shown along the bottom, and the left-
hand side shows the scale.  Selecting data from a particular channel in the table shows 
that channel on the graph. 

The graph can be zoomed in by using the left mouse button to select a zoom box. 

Notes 
Summation also works with surveys from other EDMI meters.  It can not generally be 
used to sum surveys from different types of meters together because of differences in 
the channel naming conventions. 

Summation is designed only for simple summation duties.  For more complex 
operations a spreadsheet or billing package should be used. 
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Appendix AUse with MV-90 

This chapter describes how to configure the EDMI Genius Energy Meter for use with 
the MV90 software package from UTS, in conjunction with the EDM TIM.  A Genius 
specific TIM is now available called EDM6 – call EDMI for more information. 

Setting up the meter 
There are a number of scripts that need to be loaded into the meter for MV90 access to 
work.  MV90 does not support the full range of features of the meter, so special load 
surveys must be used which are compatible with MV90.  The required setups are: 

1. The event log extension (005) must be loaded for MV90 to work correctly. 

2. Both MV90 load survey scripts generated by Toolbox must be loaded (003 and 
004).  The load survey must be of MV90 type. 

3. The first four Time of Use (TOU) registers must be set up as follows:  
 
 Channel 0 : Energy - Import W - Total (register 1E393) 
 Channel 1 : Energy - Export W - Total (register 1E397) 
 Channel 2 : Energy - Import var - Total (register 1E39B) 
 Channel 3 : Energy - Export var – Total (register 1E39F) 
 
It appears MV90 will function without the TOU registers setup but it uses them to 
cross check against the recorded data. 

4. The Modem script needs to be installed if the unit is to be accessed remotely. 

Notes 
MV90 will list a number of unrecognised event codes.  These refer to features not 
supported by MV90.  Retrieving the event log using EziView will give the complete 
event description. 

In MV90 Phone Password 1 should be set to the username to log into the meter with.  
Phone Password 2 should be set to the password for that username. 

In MV90 Device S/N should be set to the serial number of the meter. 
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Appendix BSystem Specifications 

This appendix covers the basic specifications of the meter.  The Class 1 and Class 2 
meters comply to IEC1036.  Class 0.5 meters comply with IEC687.  The meters also 
comply with the relevant parts of AS1284.  

Measured Quantities and Methods 
The meter can measure the quantities listed in Table 25-1.  Note that some 
measurements are optional features. 

Quantity Units Description 
Watt hours Wh The total Wh (fundamental and harmonic components). 

var hours varh The fundamental Varh. 

VA hours VAh The total VAh, calculated from Vrms * Irms. 

Watts W The total W (fundamental and harmonic components). 

vars var The fundamental var. 

VA VA The total VA, calculated from Vrms * Irms. 

Voltage V True RMS voltage. 

Current I True RMS current. 

Frequency Hz Fundamental system frequency. 

Phase Angle Degrees Angle between Fundamental Voltage and Fundamental Current. 

Phase to 
Phase Angle 

Degrees Angle between Fundamental Voltages. 

Power 
Factor 

Ratio Watts divided by VA.  Lead or lag determines the sign. 

• Table 25-1 Measurements. 

Notes 

The sign of VAh is based on the sign of the Wh, as VA itself has no sign. 

When measuring in 2 element mode, a VA reading is computed for the three phases as 
if the meter was connected in three element mode. The direction of the phase by phase 
gate registers is determined by the direction of the total power. 
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